Table of Contents

HVAC PRO User’s Guide

Chapter 1  Getting Started with HVAC PRO Software ..........................1-1

Introduction ............................................................................................................. 1-1

Key Concepts ......................................................................................................... 1-2
  HVAC PRO Software ............................................................................................... 1-2
  Main Window .......................................................................................................... 1-3
  Display Buttons ...................................................................................................... 1-3
  List Boxes ............................................................................................................... 1-4
  Online Help .......................................................................................................... 1-4

Detailed Procedures ............................................................................................... 1-5
  Starting HVAC PRO Software .............................................................................. 1-5
  Exiting HVAC PRO Software .............................................................................. 1-5

Chapter 1  Getting Started with HVAC PRO Software ..........................1-1

Introduction ............................................................................................................. 1-1

Key Concepts ......................................................................................................... 1-2
  HVAC PRO Software ............................................................................................... 1-2
  Main Window .......................................................................................................... 1-3
  Display Buttons ...................................................................................................... 1-3
  List Boxes ............................................................................................................... 1-4
  Online Help .......................................................................................................... 1-4

Detailed Procedures ............................................................................................... 1-5
Chapter 2  Creating, Saving, and Printing Configurations .......... 2-1

Introduction.............................................................................................................. 2-1

Key Concepts.............................................................................................................. 2-2

Question/Answer Session ........................................................................................... 2-2

Automatic File Upgrade ............................................................................................... 2-2

Configuration File Types ............................................................................................. 2-4

Saving a Configuration ............................................................................................... 2-5

Save As Option ............................................................................................................. 2-5

Target Device ................................................................................................................ 2-5

Print Format .................................................................................................................. 2-5

Procedure Overview.................................................................................................... 2-6

Detailed Procedures.................................................................................................... 2-7

Creating a New Configuration .................................................................................... 2-7

Opening a Configuration ............................................................................................. 2-8

Closing a Configuration ............................................................................................... 2-8

Saving a Configuration ............................................................................................... 2-9

Using the Save As Option ........................................................................................... 2-9

Printing a Configuration .............................................................................................. 2-12

Changing the Print Format .......................................................................................... 2-12

Troubleshooting ......................................................................................................... 2-13

Saving a Configuration ............................................................................................... 2-13

Chapter 3  Downloading Configurations and VMA Code .......... 3-1

Introduction................................................................................................................... 3-1

Key Concepts................................................................................................................ 3-2

Configuration Download ............................................................................................. 3-2

VMA Code Download .................................................................................................. 3-2

Procedure Overview..................................................................................................... 3-3

Detailed Procedures.................................................................................................... 3-4
Chapter 6  Viewing and Modifying Configurations................. 6-1

Introduction........................................................................................................ 6-1

Key Concepts....................................................................................................... 6-2

Question/Answer (Q/A) List Box ......................................................................... 6-2

Procedure Overview............................................................................................ 6-3

Detailed Procedures............................................................................................ 6-4

Viewing a Configuration ...................................................................................... 6-4

Modifying a Configuration .................................................................................... 6-4

Chapter 7  Viewing and Modifying Configuration Inputs.............. 7-1

Introduction........................................................................................................ 7-1

Key Concepts....................................................................................................... 7-2

Inputs List Box..................................................................................................... 7-2

Pressure Sensor Analog Input Ranges for ASC Devices...................................... 7-2

User-defined Ranges for VMA Inputs .................................................................. 7-3

Procedure Overview............................................................................................ 7-5

Detailed Procedures............................................................................................ 7-6

Viewing and Modifying Analog Inputs and Binary Inputs ................................... 7-6

Modifying ASC Analog Inputs ............................................................................ 7-6

Modifying ASC Binary Inputs ............................................................................. 7-10

Modifying ASC Analog Inputs in Commission Mode .......................................... 7-11

Modifying ASC Binary Inputs in Commission Mode .......................................... 7-13

Modifying TC-9100 Controller Analog Inputs .................................................... 7-14

Modifying TC-9100 Controller Binary Inputs ..................................................... 7-15

Modifying TC-9100 Controller Analog Inputs and Binary Inputs in Commission Mode 7-16

Modifying VMA Analog and Binary Inputs ......................................................... 7-17
Chapter 8  Viewing and Modifying Configuration Outputs .............8-1

Introduction...................................................................................................... 8-1

Key Concepts................................................................................................... 8-2

Outputs List Box............................................................................................ 8-2
ASC Binary Output Min-On/Min-Off Value Conversion.................................................. 8-2
ASC Staged Binary Output Cycles/Hour Value Conversion........................................... 8-3

Procedure Overview........................................................................................ 8-4

Detailed Procedures........................................................................................ 8-5
Viewing and Modifying Analog Outputs (AOs) and Binary Outputs (BOs)....................8-5
Modifying ASC Analog Outputs...................................................................................... 8-5
Modifying ASC Binary Outputs....................................................................................... 8-7
Modifying ASC Staged Binary Outputs .......................................................................... 8-9
Modifying ASC Analog Outputs in Commission Mode ................................................. 8-10
Modifying ASC Binary Outputs in Commission Mode .................................................. 8-12
Modifying TC-9100 Controller Analog Outputs ............................................................ 8-14
Modifying TC-9100 Controller Binary Outputs ............................................................. 8-15
Modifying TC-9100 Controller Analog Outputs in Commission Mode ......................... 8-16
Modifying TC-9100 Controller Binary Outputs in Commission Mode.......................... 8-18
Modifying VMA Analog and Binary Outputs.................................................................. 8-19
Modifying VMA Additional Outputs............................................................................... 8-21
Modifying VMA Outputs in Commission Mode............................................................. 8-25

Troubleshooting ............................................................................................ 8-30

Chapter 9  Viewing and Modifying Configuration Parameters .........9-1

Introduction...................................................................................................... 9-1

Key Concepts................................................................................................... 9-2

Parameters List Box.......................................................................................... 9-2
Commission Mode Overrides.................................................................................. 9-2
**Procedure Overview** ................................................................. 9-3

**Detailed Procedures** ............................................................... 9-4

Expanding and Collapsing Parameter Groups ........................................ 9-4
Modifying Analog Parameters for ASC and TC Controllers .................. 9-4
Modifying Binary Parameters for ASC and TC Controllers .................... 9-5
Modifying Time Parameters for ASC and TC Controllers ..................... 9-6
Modifying Analog Parameters for VMA Devices .................................. 9-7
Modifying Binary Parameters for VMA Devices ................................... 9-8
Modifying Multistate Parameters for VMA Devices .............................. 9-9
Modifying Parameters in Commission Mode for ASC and TC Controllers .. 9-10
Modifying Parameters in Commission Mode for VMA Devices .............. 9-13

**Chapter 10**  Setting HVAC PRO Options ................................. 10-1

**Introduction** ........................................................................... 10-1

**Key Concepts** ......................................................................... 10-2

FILES Path .................................................................................. 10-2
Job Information ............................................................................ 10-2
Generate DDL on Save ................................................................... 10-2
Generate PRN on Save ................................................................... 10-2
Parameter Prompting ...................................................................... 10-2
Window Style ............................................................................... 10-3
Viewing Available VMA Screens ................................................... 10-5

**Procedure Overview** ............................................................... 10-6

**Detailed Procedures** ............................................................... 10-7

Setting the FILES Path .................................................................. 10-7
Setting Job Information .................................................................. 10-8
Generating a DDL on Save ............................................................. 10-9
Generating a PRN on Save ............................................................. 10-9
Activating Parameter Prompting ..................................................... 10-9
Changing Window Style ............................................................... 10-10
Changing VMA Screens ............................................................... 10-10

**Chapter 11**  Using Sideloops ..................................................... 11-1
### Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction</strong></td>
<td>11-1</td>
</tr>
<tr>
<td><strong>Key Concepts</strong></td>
<td>11-2</td>
</tr>
<tr>
<td>Sideloop List Box</td>
<td>11-2</td>
</tr>
<tr>
<td>Sideloop View and Modify Dialog Box</td>
<td>11-3</td>
</tr>
<tr>
<td><strong>Procedure Overview</strong></td>
<td>11-4</td>
</tr>
<tr>
<td><strong>Detailed Procedures</strong></td>
<td>11-5</td>
</tr>
<tr>
<td>Defining a New Sideloop</td>
<td>11-5</td>
</tr>
<tr>
<td>Selecting a Predefined Hardware Point</td>
<td>11-6</td>
</tr>
<tr>
<td>Defining an Unused Point or Modifying a Predefined Point</td>
<td>11-7</td>
</tr>
<tr>
<td>Defining or Modifying Multiple AIs</td>
<td>11-7</td>
</tr>
<tr>
<td>Changing the Sideloop Name</td>
<td>11-8</td>
</tr>
<tr>
<td>Changing Sideloop Inputs, Outputs, or Parameters</td>
<td>11-8</td>
</tr>
<tr>
<td>Changing Answers in the Sideloop Question/Answer Path</td>
<td>11-8</td>
</tr>
<tr>
<td><strong>Chapter 12 Using a Template File for Commissioning</strong></td>
<td>12-1</td>
</tr>
<tr>
<td><strong>Introduction</strong></td>
<td>12-1</td>
</tr>
<tr>
<td><strong>Key Concepts</strong></td>
<td>12-2</td>
</tr>
<tr>
<td>Template Files</td>
<td>12-2</td>
</tr>
<tr>
<td>Similarities between Configuration and Template Files</td>
<td>12-2</td>
</tr>
<tr>
<td>Differences between Using a Configuration File and a Template File</td>
<td>12-3</td>
</tr>
<tr>
<td>Template Point Information</td>
<td>12-3</td>
</tr>
<tr>
<td>Controller Commissioning Using a Template</td>
<td>12-3</td>
</tr>
<tr>
<td>Decimal Precision and Updating Point Values</td>
<td>12-5</td>
</tr>
<tr>
<td>Monitoring and Graphing Controller Data Using a Template File</td>
<td>12-5</td>
</tr>
<tr>
<td>Creating and Customizing a Template File</td>
<td>12-7</td>
</tr>
<tr>
<td><strong>Procedure Overview</strong></td>
<td>12-9</td>
</tr>
<tr>
<td><strong>Detailed Procedures</strong></td>
<td>12-10</td>
</tr>
<tr>
<td>Opening a Template File</td>
<td>12-10</td>
</tr>
<tr>
<td>Displaying the Template Point Dialog Box</td>
<td>12-11</td>
</tr>
<tr>
<td>Commissioning a Controller Using a Template File</td>
<td>12-11</td>
</tr>
<tr>
<td>Using Data Graphing</td>
<td>12-13</td>
</tr>
<tr>
<td><strong>Template File Syntax, Layout, and Examples</strong></td>
<td>12-15</td>
</tr>
</tbody>
</table>
Chapter 13  Using Loop Tuning for ASC Devices 13-1

Introduction 13-1

Key Concepts 13-2

Loop Tuning 13-2
Considerations Before Loop Tuning 13-2
Monitoring a Loop or Data Points 13-4
Tuning a Loop Using PRAC 13-4
PRAC Misapplications 13-5
Time Required for PRAC Tuning 13-5
Graphing Data File Format 13-5

Procedure Overview 13-7

Detailed Procedures 13-8

Accessing the Loop Tuning Feature 13-8
Overriding the PI Setpoint 13-15
Modifying the Vertical Axis 13-15
Modifying the Time Axis 13-17
Starting Pattern Recognition Adaptive Control (PRAC) 13-18
Verifying Process Performance 13-19
Tuning a Sample Loop with PRAC 13-20
Adjusting Loop Tune Parameters 13-21

Troubleshooting 13-23

Chapter 14  Using Data Graphing 14-1

Introduction 14-1

Key Concepts 14-2
Data Graphing 14-2
Procedure Overview .............................................................................................. 14-3

Detailed Procedures ...................................................................................... 14-4

Creating a Graph .......................................................................................... 14-4
Modifying the Vertical Axis .......................................................................... 14-6
Modifying the Time Axis ............................................................................... 14-7

Troubleshooting ......................................................................................... 14-8

Chapter 15 Testing and Receiving Data from Controllers .................. 15-1

Introduction .................................................................................................. 15-1

Key Concepts ............................................................................................... 15-2

Action Menu ................................................................................................. 15-2
Controller Information ................................................................................ 15-2
VAV Box Flow Test ..................................................................................... 15-3
VAV Diagnostics ......................................................................................... 15-3
VMA Balancer Tool ..................................................................................... 15-3
VAV Flow Deadband .................................................................................. 15-3
Recalculate Flow Tuning Parameters ......................................................... 15-4
Import AHU DOS Config ........................................................................... 15-5
Reset Controllers ....................................................................................... 15-5
ASC Zone Bus Communication ................................................................. 15-5
VMA Controller Software Addressing ...................................................... 15-6

Procedure Overview .................................................................................. 15-7

Detailed Procedures .................................................................................. 15-9

Receiving Controller Information on a Single Device ................................ 15-9
Receiving Controller Information on All Devices on the N2 Bus .......... 15-11
Setting VMA Controller N2 Software Addresses .................................... 15-14
Testing a Single VAV Box ......................................................................... 15-14
Testing Multiple VAV Boxes .................................................................... 15-17
Collecting VAV Diagnostics ..................................................................... 15-20
Using the VMA Balancer Tool ................................................................. 15-21
Setting the VAV Flow Deadband .............................................................. 15-24
Recalculating Flow Tuning Parameters .................................................. 15-24
Chapter 16  Using HVAC PRO Software from the OWS ............ 16-1

Introduction ........................................................................................................... 16-1

Key Concepts ....................................................................................................... 16-2

Installation .............................................................................................................. 16-2
Options for Accessing HVAC PRO Software from the OWS ........................................ 16-2
Differences when Using HVAC PRO Software from the OWS ..................................... 16-3
VMA Download ....................................................................................................... 16-4
Download VMA Code ........................................................................................... 16-4
Commissioning ...................................................................................................... 16-5

Procedure Overview .............................................................................................. 16-6

Detailed Procedures ............................................................................................ 16-8

Downloading the Current Configuration ................................................................. 16-8
Uploading the Configuration in the Controller ...................................................... 16-9
Upgrading a Single Controller .............................................................................. 16-10
Upgrading Multiple Controllers ........................................................................... 16-12
Commissioning the Current Configuration ............................................................ 16-14
Commissioning the Configuration in the Controller ............................................ 16-15
Viewing Controller Information for a Single Device ........................................... 16-16
Viewing Controller Information for All Devices on the Selected Network Controller (NC) 16-17
Testing a Single VAV Box ................................................................................... 16-19
Testing Multiple VAV Boxes ............................................................................... 16-21
Collecting VAV Diagnostics .............................................................................. 16-23

Troubleshooting .................................................................................................. 16-25

Chapter 17  Using HVAC PRO Software in Pass Through Mode ... 17-1

Introduction ........................................................................................................... 17-1

Key Concepts ....................................................................................................... 17-2

HVAC PRO Software in Pass Through Mode ....................................................... 17-2
Site Book ............................................................................................................... 17-2
Pass Through vs. Standard Mode ......................................................................... 17-2
Differences when Using Pass Through Mode .............................................................. 17-2
VMA Download ............................................................................................................ 17-4
Download VMA Code ............................................................................................... 17-4

**Procedure Overview** .............................................................................................. 17-5

**Detailed Procedures** .............................................................................................. 17-7
Starting HVAC PRO Software in Pass Through Mode ................................................. 17-7
Starting HVAC PRO Software in Standard Mode ......................................................... 17-7
Downloading the Current Configuration ........................................................................ 17-8
Uploading the Configuration in the Controller .............................................................. 17-9
Upgrading a Single Controller ..................................................................................... 17-10
Upgrading Multiple Controllers .................................................................................. 17-12
Commissioning the Current Configuration ................................................................. 17-15
Commissioning the Configuration in the Controller .................................................... 17-16
Viewing Controller Information for a Single Device ................................................... 17-17
Viewing Controller Information for All Devices on the Selected Supervisory Controller 17-18
Testing a Single VAV Box ............................................................................................ 17-20
Testing Multiple VAV Boxes ....................................................................................... 17-22
Collecting VAV Diagnostics ....................................................................................... 17-25

Chapter 18 **Networking Controllers** ..................................................................... 18-1

**Introduction** .......................................................................................................... 18-1

**Key Concepts** ........................................................................................................ 18-2
Chapter 1

Getting Started with HVAC PRO Software

Introduction

HVAC PRO™ software is an application used to configure control strategies and to upload, upgrade, download, and commission controllers. Use this application with controllers connected to Metasys® Companion™/Facilitator™ controllers integrated with the Metasys Network through a Network Control Module (NCM), or controllers connected to the N30 Supervisory Controller.

This chapter describes how to:

- start HVAC PRO software
- exit HVAC PRO software
Key Concepts

HVAC PRO Software

Use HVAC PRO software to configure control strategies, which contain software points and processes. A software point represents and characterizes a field device (such as an Analog Input) or a data point (such as a Binary Data point). A process is a set of logical evaluations that determine when to perform an action, such as when to turn on a supply fan or enable a chiller. HVAC PRO software translates each process into a process object, which is downloaded to and executed by the controller.

In addition to configuration utilities, HVAC PRO software provides features to upload, upgrade, download, and commission controllers. For Variable Air Volume Modular Assembly (VMA) 1400 Series devices, use the download feature to upgrade the controller firmware code. These utilities are described in detail later in this document. HVAC PRO software is easy to use and quickly learned. Once you know the basics, you’ll quickly move from window to window, efficiently programming your controller.
Main Window

Figure 1-1 shows the basic HVAC PRO main window.

![HVAC PRO Main Window Diagram]

Display Buttons

The display buttons Q/A (Question and Answer), Inputs, Outputs, Params (Parameters), and Sideloop control the information displayed in the list boxes. When you select a display button, the information specific to that button fills the next available list box. The next available box alternates between the left and right sides of the screen. If the information for a display button is already displayed, its list box moves to the opposite side of the screen.
List Boxes

There are two list boxes in HVAC PRO software. These boxes display a list of the questions and answers, hardware inputs, outputs, parameters, or sideloops. Select the information to display by using the Display buttons. Move between the list boxes by using the Tab key or by clicking the mouse in the list box.

Note: You must have an open configuration in HVAC PRO software to display information in the list boxes.

Online Help

HVAC PRO software includes Online Help that describes the basic procedures for performing functions within the HVAC PRO application. Table 1-1 lists descriptions of help menu features. HVAC PRO software also contains context sensitive help. Press F1 at any time while using HVAC PRO software to display a Help screen on the topic most closely related to what you are currently working on.

<table>
<thead>
<tr>
<th>Table 1-1: Online Help Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature</td>
</tr>
<tr>
<td>Contents</td>
</tr>
<tr>
<td>Search for Help on...</td>
</tr>
<tr>
<td>How to Use Help</td>
</tr>
<tr>
<td>About HVAC PRO...</td>
</tr>
</tbody>
</table>
**Detailed Procedures**

**Starting HVAC PRO Software**

To start HVAC PRO software:

1. On the Windows Start menu, click Programs > Configuration Tools > HVAC PRO. The HVAC PRO Copyright screen appears for approximately 10 seconds.

2. Press the Enter or Escape (Esc) key, or click with the mouse anywhere on the Copyright screen to move past the display and into HVAC PRO software.

Note: To permanently disable the Copyright screen from displaying, click on the square box next to the Do not show this Copyright statement.

**Exiting HVAC PRO Software**

To exit HVAC PRO software, on the File menu, click Exit.

Note: If you select Exit while a configuration is in process, HVAC PRO software prompts you to save changes.
Chapter 2

Creating, Saving, and Printing Configurations

Introduction

HVAC PRO software provides a Question/Answer session to set up specific configurations for the mechanical system.

This chapter describes how to:

• create a new configuration
• open a configuration
• close a configuration
• save a configuration
• use the Save As option
• print a configuration
• change the print format
Key Concepts

Question/Answer Session

HVAC PRO software displays a series of questions for the selected application. Use the Question/Answer session to set up specific control sequences for the mechanical system. Figure 2-1 is an example of a question in the Question/Answer session.

The system identifies the input and output hardware points and updates the parameter list box as you work through the configuration process. If you change an answer to a previous question, all questions after the changed selection must be re-answered. The previous answers become the default selections for this Question/Answer session.

![Question/Answer Session](VAVQA)

Figure 2-1: Question/Answer Session

Automatic File Upgrade

When opening an existing configuration, HVAC PRO software compares the application and sideloop path revision numbers stored in the configuration file with the revision numbers in the database. If the configuration file used an earlier version of the application or sideloop paths, HVAC PRO software prompts you to upgrade the file.
If the upgrade is optional, HVAC PRO software prompts the user to continue without upgrade. If the user decides to continue without upgrade, all Save and Save As commands produce download files of the same application revision as is currently present in the controller. This allows the controller to continue to be compatible with earlier revisions of HVAC PRO software.

Note: The format of the configuration file (.cfg) saved on the Personal Computer’s (PC’s) hard drive may not be compatible with the earlier versions of HVAC PRO software. If the user decides not to continue without upgrade (by answering No to the question), the application is upgraded to application revision in HVAC PRO software.

The application or sideloop question and answer paths may change during the upgrade. HVAC PRO software matches the questions and answers in the configuration file to those in the database, and opens the Question/Answer session if necessary.

Verify the point definitions and parameter values for the displayed configuration after the file upgrade. There may be instances where a new point is loaded with default values you should verify.
## Configuration File Types

HVAC PRO software automatically generates several file types when you save a configuration. Table 2-1 lists the HVAC PRO software generated file types and their functions.

### Table 2-1: HVAC PRO Software Generated Files

<table>
<thead>
<tr>
<th>Controller</th>
<th>Extension</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Controllers</td>
<td>.cfg</td>
<td>The configuration file. HVAC PRO software creates this file when you save the configuration.</td>
</tr>
<tr>
<td></td>
<td>.dat</td>
<td>The graphing file. HVAC PRO software creates this file while you are monitoring control loops or data points. You can rename this file.</td>
</tr>
<tr>
<td></td>
<td>.ddl</td>
<td>The optional DDL incremental source file for the Control System (CS) Model. HVAC PRO software creates this file after saving a configuration if you select Generate DDL on Save in the Options menu. Refer to the Setting HVAC PRO Options (LIT-63750411) chapter in this guide.</td>
</tr>
<tr>
<td></td>
<td>.err</td>
<td>The error file. HVAC PRO software creates this file if there are errors when you save the configuration or if errors occur when you open a template file.</td>
</tr>
<tr>
<td></td>
<td>.prn</td>
<td>The optional print file. HVAC PRO software creates this file after saving a configuration if you select Generate PRN on Save in the Options menu.</td>
</tr>
<tr>
<td>ASC</td>
<td>.asc</td>
<td>The downloadable object file for an ASC. Not created if you select No Target Device when saving a configuration (see Save As Option in this section).</td>
</tr>
<tr>
<td>TC</td>
<td>.tcd</td>
<td>The TC-9100 download file created during the File &gt; Save/Save As process for a TC-9100 configuration at Metasys Release 9.01 or later. The TC-9100 download file is not created if you select No Target Device when saving a configuration.</td>
</tr>
<tr>
<td>VMA</td>
<td>.mab</td>
<td>The Metasys Application BASIC file created by HVAC PRO software. This file defines the VMA1400 Series application that results from the Question/Answer session.</td>
</tr>
<tr>
<td></td>
<td>.mao</td>
<td>The Metasys Application Object file created during the File &gt; Save/Save As process. This file is downloaded into the VMA1400 Series device.</td>
</tr>
<tr>
<td></td>
<td>.mau</td>
<td>The Metasys Application User Information file used during download process. This file contains user information that enables a later upload.</td>
</tr>
</tbody>
</table>
Saving a Configuration

If you add, delete, or change any information in a window, save changes using the current name and target device.

However, in rare cases, the amount of information stored in an Application Specific Controller (ASC) device to recreate the original configuration may exceed the available space. If this occurs during the Save process, a message warns you that it will not be able to upload the configuration.

Save As Option

Use the Save As option to save new configurations or any changes in an existing configuration and assign a new device type, name, and/or directory for storage. This menu item appears dimmed when the configuration is incomplete.

Target Device

The target device is the type of controller for the configuration download. Controllers capable of running the configured application appear in the Devices list box. Controllers not capable of running the configured application appear in the Devices Not Allowed list box.

Print Format

Print a formatted version of the controller’s Configuration file when you finish configuring an application. The Print selection is unavailable when a configuration is not complete.

When printing a configuration, select either short or long format for the printed configuration file.

The short format consists of project information, the Question/Answer session, general information on inputs and outputs, and parameter information.

The long format consists of project information, the Question/Answer session, detailed information on inputs and outputs, and parameter information.
**Procedure Overview**

Table 2-2: Creating, Saving, and Printing Configurations

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a New Configuration</td>
<td>On the File menu, click New. Select an application group. Select an application. Click OK. In the Question/Answer Session, double-click on the desired answer to each question.</td>
</tr>
<tr>
<td>Open a Configuration</td>
<td>On the File menu, click Open. Select the configuration file and click OK.</td>
</tr>
<tr>
<td>Close a Configuration</td>
<td>On the File menu, click Close.</td>
</tr>
<tr>
<td>Save a Configuration</td>
<td>On the File menu, click Save.</td>
</tr>
<tr>
<td>Use the Save As Option</td>
<td>On the File menu, click Save As. In the Target Device Selection dialog box, select a device type. Select a device from the Devices list box. In the Save As dialog box, type the desired path and/or file name. Click OK.</td>
</tr>
<tr>
<td>Print a Configuration</td>
<td>On the File menu, click Print.</td>
</tr>
<tr>
<td>Change the Print Format</td>
<td>On the File menu, click Print Format and either Short or Long.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Creating a New Configuration

To create a new configuration:

1. On the File menu, click New. The File New/Application Selection dialog box appears (Figure 2-2).

![Figure 2-2: File New/Application Selection Dialog Box](image)

The File New/Application Selection dialog box displays all application groups and applications for the selected application group.

2. Select an application group (for example, VAV Applications). The list of available applications for the selected group appears.

3. Select an application (for example, Dual Duct).

4. Click OK. The Question/Answer session begins.

5. Double-click on the desired answer to each question. Note: Press the Esc key to back up and change previous answers. If you change an answer to a previous question, all questions after the changed selection must be re-answered. The previous answers become the default selections for this Question/Answer session. Press Enter to select these selections or select new answers to complete the Question/Answer Session.

6. Click on the Close Window box of the Question/Answer session to exit the Question/Answer session. The following dialog box appears.
This Q/A Session is not complete. Exiting now will reset all answers. Are you sure you want to Exit?

Yes  No

Figure 2-3: Exiting the Question/Answer Session

Note: If you answer yes, all information displayed on the screen is reset. Any new information is lost.

Opening a Configuration

To open a configuration:

1. On the File menu, click Open. The Open dialog box appears (Figure 2-4).

Note: If a configuration is in progress, HVAC PRO software prompts you to save the current configuration.

IMPORTANT: If you open a Release 7.00 or later configuration file from Windows® Explorer or AIM Tools Project File Manager, sideloop is erased. Use the method described in this section to open a configuration file.

Figure 2-4: Open File Dialog Box

2. Select the configuration file and click OK.

Closing a Configuration

To close a configuration, on the File menu, click Close to clear the current configuration or template file from the screen.
Saving a Configuration

To save a configuration, on the File menu, click Save. HVAC PRO software saves changes to the configuration file. The File Save window displays showing you the progress of the save process.

Note: When saving a Variable Air Volume (VAV) application for a VAV target device, and changes to the box area or actuator stroke time affect the flow tuning parameters, an additional dialog box displays with recalculated values for the tuning parameters. See Save As Option in the Key Concepts section of this chapter for more information.

Using the Save As Option

To use the Save As option:

1. On the File menu, click Save As. The Target Device Selection dialog box appears (Figure 2-5).
2. Select a device type (for example, Unitary Controller [UNT]). The Devices list box displays the available devices for the selected device type.

Note: If you would like to save a configuration without generating a download file, choose No Target Device from the Device Type list.

Figure 2-5: Target Device Selection Dialog Box
3. Select a device from the Devices list box (for example, UNT121-0).

When you highlight a device, a description of the device appears in the Device Description box. If you select a device from the Devices Not Allowed list, a dialog box similar to Figure 2-6 displays:

![Target Device Selection](attachment:image.png)

**Figure 2-6: Target Device Not Allowed**

4. Click OK with a valid device highlighted. The Save As dialog box appears (Figure 2-7).
Figure 2-7: Save As Dialog Box

5. Type the desired path and/or file name. Click OK.

Note: If you are saving a VAV application, and changes to the box area, actuator stroke time, or target device affect the flow tuning parameters, the Flow Tuning Parameters dialog box appears (Figure 2-8). (This does not apply to the VMA.) This dialog box displays the current value of the flow loop tuning parameters (Prop Band, Integration Time, and Deadband) and the calculated tuning parameter values for stable control.
Flow Tuning Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Current Value</th>
<th>Calculated Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cold DK PropBand</td>
<td>-1600.00</td>
<td>-1582.00</td>
</tr>
<tr>
<td>Cold DK Integ Time</td>
<td>16.00</td>
<td>16.40</td>
</tr>
<tr>
<td>Cold DK Deadband</td>
<td>50.00</td>
<td>42.00</td>
</tr>
<tr>
<td>Hot DK Prop Band</td>
<td>-1600.00</td>
<td>-3616.00</td>
</tr>
<tr>
<td>Hot DK Integ Time</td>
<td>16.00</td>
<td>16.40</td>
</tr>
<tr>
<td>Hot DK Deadband</td>
<td>50.00</td>
<td>96.00</td>
</tr>
</tbody>
</table>

Calculated tuning parameters do not match current parameters. Do you want to use the calculated values for these parameters?

[YES] [NO]

Figure 2-8: Flow Tuning Parameters Dialog Box

6. Select either YES or NO.
   - YES saves the calculated tuning parameter values to the configuration file (Figure 2-8).
   - NO retains the previous tuning values. The decision as to which box tuning parameters to use is critical prior to box download.

Notes: Selecting size of deadband is discussed in the Testing and Receiving Data from Controllers (LIT-63750416) chapter in this guide.

Two sets of tuning parameters appear for Dual Duct applications.

For information on the VMA1400 Series, refer to the Variable Air Volume Modular Assembly (VMA) 1400 Series Application Note (LIT-6375125).

Printing a Configuration

To print a configuration, on the File menu, click Print.

Changing the Print Format

To change the print format, on the File menu, click Print Format and either Short or Long.
Troubleshooting

Saving a Configuration

If the changes made to the configuration invalidate the currently selected device, HVAC PRO software prompts you to make a new device selection (Figure 2-9). For example, this occurs if more than six Binary Outputs (BOs) are defined for a controller model that only supports six BOs.

![Figure 2-9: Invalid Device Selection Message Box](image)

Click OK to select a new target device or Cancel to return to the configuration process.

If the changes to the configuration use more controller memory than available space, HVAC PRO software displays the following error message:

![Figure 2-10: Configuration Overflow Error Message](image)

Click OK to view the error log (an example appears in Figure 2-11). HVAC PRO software saves this error log in a file called configuration name.err.
Configuration Overflow
ERROR -- Configuration Data Overflow.
Configuration overflow by 13 bytes.
Reconfigure and eliminate features to reduce the configuration size or select a controller with more configuration space.

Figure 2-11: Configuration Overflow Error Log Example
Chapter 3

Downloading Configurations and VMA Code

Introduction

The download configuration feature allows the user to download the current, saved configuration to a controller or to multiple controllers. Similarly, the download VMA code feature allows the user to download updated controller firmware code into single or multiple VMA1400 Series devices.

This chapter describes how to:

- download the current configuration
- download VMA code
Key Concepts

Configuration Download

The Current Configuration option on the Download menu downloads the current, saved configuration to a controller or to multiple controllers. This menu selection appears dimmed if the current configuration is not complete or has not been saved.

VMA Code Download

The VMA code option on the Download menu allows you to download updated controller firmware code into single or multiple VMA1400 Series devices.

Note: Code downloads only over the N2 Bus, not from a workstation. Downloading code deletes the current control application in the VMA. See the Uploading and Upgrading Configurations (LIT-63750405) chapter in this guide for information on updating the VMA firmware code and application in the same process.

Updated versions of the firmware are made available to the field when appropriate. Older firmware versions cannot be downloaded once the firmware has been updated.
Procedure Overview

Table 3-1: Downloading Configurations and VMA Code

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download the Current</td>
<td>On the Download menu, click Current Configuration. Fill in the fields for a controller on the N2 Bus. Verify the communication selections and press Enter. Confirm the selected device addresses. Select Cancel if you need to change or add an address. Click OK to download to the devices.</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>Download VMA Code</td>
<td>On the Download menu, click VMA Code. Enter more than one N2 address in the N2 Device Addresses field to download the VMA code to multiple controllers. Verify the communication selections and press Enter. Confirm the selected device addresses. Select Cancel if you need to change or add an address. Click OK to download the VMA code to the devices.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download the Current</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
</tbody>
</table>
**Detailed Procedures**

**Downloading the Current Configuration**

To download the current configuration:

1. On the Download menu, click Current Configuration. The Download Controller dialog box for controllers on the N2 Bus appears (Figure 3-1).

![Download Controller Dialog Box for the N2 Bus](image)

**Figure 3-1: Download Controller Dialog Box for the N2 Bus**

2. Fill in the fields for a controller on the N2 Bus using Table 3-2.
Table 3-2: Download Controller Fields for the N2 Bus

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Communication Port and Bus Type | Select the appropriate Communication Port and Bus Type. The Communication Port and Bus Type default to the last entered value. The N2 Device Addresses field defaults to the last entered single controller address. HVAC PRO software does not save multiple N2 Device Addresses as defaults.  
Note: The TC-9100 class controllers do not support Zone Bus communications. If you select a TC-9100 controller as the target device, the Zone Bus option appears dimmed. |
| Clear AI Offsets              | Select or deselect the Clear AI Offsets option to clear Analog Input (AI) point offsets for any Application Specific Controller (ASC), except the N2 Dialer Module (NDM), when downloading over the Zone Bus. If you download controllers over the N2 Bus or from a workstation, you cannot clear AI offsets for UNTs or VAVs with firmware revisions earlier than D00 (2K controllers).  
Note: Clear AI offsets? appears dimmed when it is not available, and it does not appear for TC-9100s, NDMs, or VMA1400 Series devices. |
| N2 Device Addresses           | Enter more than one N2 address in the N2 Device Addresses field to download multiple controllers. All N2 addresses must be within the range of 1 to 255. Use spaces between individual addresses and after commas, but spaces cause errors if placed within a series specification. HVAC PRO software uses the following formats:  
• Individual Addresses 1, 3, 7 1, 3, and 7  
• Range of Addresses 1..3 1 through 3  
• Combination of Addresses 1..3,6..8 1 through 3 and 6 through 8  
For TC-9100 controllers, refer to the TC-9102 Terminal Controller Technical Bulletin (LIT-6363050) for instructions on how to set the controller address switches. |

If you select Zone Bus, the following Download Controller dialog box appears (Figure 3-2).

Figure 3-2: Download Controller Dialog Box for the Zone Bus
3. Fill in the fields for a controller on the Zone Bus using Table 3-3.

**Table 3-3: Download Controller Options for the Zone Bus**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switches Used to Set Device Addresses</td>
<td>This option is only available when you download an Air Handling Unit (AHU) controller over the Zone Bus (Figure 3-2). Some early versions of AHU controllers have no hardware switches. Their controller address is stored in memory. Later versions of AHU controllers have hardware switches, but retain the software address feature (you can address the controller using hardware switches or software). HVAC PRO software checks the addressing method of each AHU controller prior to performing a download. HVAC PRO software uses the current addressing method for the AHU controllers if you are using the N2 Bus. However if using the Zone Bus, change the addressing method of any AHU controller with a firmware revision later than BO1 by selecting or deselecting Switches Used to Set Device Addresses. Note: AHU controllers with firmware BO1 always must use a software address. You cannot change the addressing method for these controllers.</td>
</tr>
<tr>
<td>Using a Software Address for AHUs</td>
<td>Deselect the Switches Used to Set Device Addresses to set the N2 address in software. Enter the device address in the N2 addresses edit field.</td>
</tr>
<tr>
<td>Using the Address Switches for AHUs</td>
<td>Select the Switches Used to Set Device Addresses selection when you set the N2 address using hardware switches. Set the device address using the hardware switches on the controller. Refer to the Air Handling Unit (AHU) Controller Technical Bulletin (LIT-6363010) for complete details on addressing the controller. Note: HVAC PRO software displays a warning message if you select a different addressing method than what the controller is currently using. You may continue or return to the Download dialog box to reset the addressing method.</td>
</tr>
</tbody>
</table>

Note: Software addressing is also available for VMA1400 Series devices. See the Testing and Receiving Data from Controllers chapter in this guide for details.

4. Verify the communication selections and press Enter.

When you enter multiple N2 Device addresses, a dialog box similar to Figure 3-3 appears.

**Figure 3-3: Verify Address List Dialog Box**
5. Confirm the selected device addresses. Select Cancel if you need to change or add an address. Click OK to download to the devices.

Notes: For ASCs, HVAC PRO software shows you the progress through the download process, waits for the controllers to reset, and checks the controllers’ status. This ensures that each controller is running a valid configuration.

For TC-9100 controllers, download skips the reset and status check. For VMA1400 Series devices, download skips the reset, but does check the status.

For HVAC PRO Release 7.02 and later, additional time is added to the end of the VMA download process. This extra time allows the controller to finish its internal archiving process. This also applies to the VMA download that occurs during the upgrade process.

If you are downloading the configuration to multiple devices, a dialog box similar to Figure 3-4 appears when the download is complete:

![Download Complete Dialog Box](DOWNERR)

**Figure 3-4: Download Complete Dialog Box**

This message prompts you to view the status log file regardless of whether there were any download errors. Selecting Yes opens the file in Windows Notepad. The status log lists device addresses and information pertaining to the download process (for example, if the download attempt was successful or if it failed). It also lists the reason for download failure if it occurred. You can print the file from Notepad. It is automatically saved as download.log.

Note: Each time HVAC PRO software starts a multiple controller download, it renames the existing download.log file to download.nnn, where nnn is a number from 0 to 999.
Downloading VMA Code

**CAUTION:** All Analog Outputs (AOs) are zero during and following a VMA code download until an application is loaded into the controller. Be sure to consider the impact this will have on your system prior to performing a code download.

Note: You must be directly connected to the N2 Bus to download VMA code.

To download the VMA code:

   A dialog box similar to Figure 3-5 appears:

   ![Download Controller Dialog Box for VMA](image)

   **Figure 3-5: Download Controller Dialog Box for VMA**

2. Enter more than one N2 address in the N2 Device Addresses field to download the VMA code to multiple controllers. All N2 addresses must be within the range of 1 to 253 (Addresses 254 and 255 are reserved for the VMA). Use spaces between individual addresses and after commas, but do not use spaces within a series specification. HVAC PRO software uses the formats shown in Table 3-4.

**Table 3-4: Download Controller Address Formats**

<table>
<thead>
<tr>
<th>When Downloading To</th>
<th>This Format</th>
<th>Downloads To These Addresses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual Addresses</td>
<td>1,3,7</td>
<td>1, 3, and 7</td>
</tr>
<tr>
<td>Range of Addresses</td>
<td>1..3</td>
<td>1 through 3</td>
</tr>
<tr>
<td>Combination of Addresses</td>
<td>1..3,6..8</td>
<td>1 through 3 and 6 through 8</td>
</tr>
</tbody>
</table>
3. Verify the communication selections and press Enter. When you enter multiple N2 Device addresses, a dialog box similar to Figure 3-6 appears.

![Verify Address List Dialog Box](image)

**Figure 3-6: Verify Address List Dialog Box**

4. Confirm the selected device addresses. Select Cancel if you need to change or add an address. Click OK to download the VMA code to the devices. HVAC PRO software shows you the progress through the code download process.

At the completion of code download for multiple devices, a dialog box similar to Figure 3-7 appears. Select Yes to validate the correct completion of multiple downloads. We recommend the operator view the code download log file to ensure that all controller code downloads were successful.

![Download Controller Dialog Box](image)

**Figure 3-7: VMA Code Download Complete Dialog Box**

**Note:** Once VMA code download is completed successfully, no application exists in the controllers. Download the application after the VMA code to perform the control application.
Figure 3-8 is an example of the content of the Download log file.

Figure 3-8: Download Log

**Important:** If a controller has failed in the download, further code downloads should be attempted to ensure the device operates properly. An unsuccessful code download leaves the VMA in an inoperable state.
## Troubleshooting

The following are descriptions of known problems and their solutions.

### Table 3-5: Troubleshooting Downloading Configurations and VMA Code

<table>
<thead>
<tr>
<th>Error/Condition</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Communication Error When Downloading    | During the download process, HVAC PRO software checks the configuration or VMA code to determine whether the selected device type matches the controller to which it is attempting to download. If HVAC PRO software cannot download the configuration due to communication errors, an error message similar to Figure 3-9 appears. | 1. Click the OK button to acknowledge the message.  
2. Check your connections and retry the download or cancel the download process.                                                                                                                                 |
| Device Type Mismatch when Downloading a Configuration | If there is a device type mismatch when downloading to a single device, a dialog box similar to Figure 3-10 appears. | 1. Click the OK button to acknowledge the message.  
2. Use File > Save As... to save the configuration for the correct device type, or enter a different device address.  
Note: For VMA code downloads, HVAC PRO software skips the code downloads for any non-VMA device.                                                                                                                                 |
| VMA Download Failures over Dial-Up Networks | HVAC PRO Release 7.02 fails to download VMAs over a dial-up network. HVAC PRO software gets to 8% before a message box appears indicating the download failed. This may be caused by timing problems. | Avoid attempting to download a VMA over a dial-up network. Download directly through the N2 trunk.                                                                                                                                 |

![Figure 3-9: Communications Error Dialog Box](downcom.png)
Download Controller

Download object was generated for an incompatible device type.

OK

Figure 3-10: Device Type Mismatch Dialog Box
Chapter 4

Uploading and Upgrading Configurations

Introduction

Commands in the Upload menu allow the user to upload a configuration in a controller or upgrade single or multiple controllers. This chapter describes how to:

• upload a configuration
• upgrade a single controller
• upgrade multiple controllers
Key Concepts

Automatic File Upgrade

When uploading a configuration in a controller, HVAC PRO software compares the application and sideloop path revision numbers stored in the controller with the revision numbers in the database. If the configuration file used an earlier version of the application or sideloop paths, HVAC PRO software prompts you to upgrade the file.

If the upgrade is optional, HVAC PRO software prompts the user to continue without upgrade. If the user decides to continue without upgrade, all Save and Save As commands produce download files of the same application revision as are currently present in the controller. If the user decides not to continue without upgrade by answering No to the question, the application is upgraded to application revision in HVAC PRO software. This allows the controller to continue to be compatible with earlier revisions of HVAC PRO software. Note, however, the format of the configuration file (.cfg) saved on the PC’s hard drive may not be compatible with the earlier versions of HVAC PRO software.

HVAC PRO software does not store changed point and parameter names in the controller. When you upload a configuration, name changes are lost. However, you can determine the configuration and commission any controller downloaded with HVAC PRO software without being required to know the configuration file name.

All controllers downloaded through HVAC PRO software support the upload feature. The amount of information stored in an ASC device to recreate the original configuration may, in rare cases, exceed the available space (this does not apply to the TC-9100 controller or the VMA1400 Series device).

Upgrade Controllers Command

On the Upload menu, use the Upgrade Controllers command to upgrade the configuration in a controller to the current release of HVAC PRO software. The Upgrade Controllers dialog box appears (Figure 4-1). You can upgrade most controllers on the N2 Bus from any revision of HVAC PRO software.
WARNING: Upgrades cannot be guaranteed to work properly unless the user runs the normal HVAC PRO icon and performs a File > Open. Improper upgrades can occur when the user associates a .cfg file with hvacpro.exe and double-clicks on the .cfg file icon. Improper upgrades can also occur if the .cfg file is opened through the AIM Tool Project File Manager.

Notes: This feature is not available during Commission mode, and it is not supported for TC-9100.

If the configuration in the controller currently uses an earlier version of the application or sideloop paths, HVAC PRO software displays a message telling you that a newer version of the application exists and asks if you would like to continue without an upgrade. Continuing without the upgrade allows the upload process to continue as normal. If, however, you decide to **not** continue with the upgrade, the upload process is aborted. At this point, you will need to manually upgrade the application and continue an upload following a successful upgrade.

**Figure 4-1: Upgrade Multiple Controllers Dialog Box**

Select Single Controller to upgrade one specific device or select Multiple Controllers to upgrade more than one device on the N2 Bus. These options are described in more detail in the following section called *Upgrade Controller Options*. 
Upgrade Controller Options

Table 4-1 explains the different options in the Upgrade Controllers dialog box (Figure 4-1).

### Table 4-1: Upgrade Controller Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save Uploaded Object</strong></td>
<td>When you select Save Uploaded Object, HVAC PRO software saves the uploaded object file from an ASC device to the currently selected directory. The file names are listed in Table 4-2.</td>
</tr>
<tr>
<td><strong>Log Parameter Values</strong></td>
<td>When you select Log Parameter Values, HVAC PRO software logs all parameter values to a file located in the directory specified by the FILES path. The values are logged before the upgrade updates them. The parameter log file name varies with the control application. For example, the parameters for a Single Duct VAV application are logged to the file sdparms.log. HVAC PRO software appends this file each time you upgrade a controller with this option selected. This is a tab separated file with the parameter names, parameter values, and controller N2 address (or ZB if the upgrade is done on the Zone Bus). You can import this file directly into Excel or any other third-party package that accepts tab-delimited files. This can be very valuable for record keeping and documentation purposes.</td>
</tr>
<tr>
<td><strong>Only Check Config Size (No Download)</strong></td>
<td>When you select Only Check Config Size (No Download), HVAC PRO software performs the complete upgrade except for the last step of downloading the controller. This is a quick way to get configuration information and parameter values without affecting the controller.</td>
</tr>
<tr>
<td><strong>Remove Power Fail Restart on Overflow</strong></td>
<td>When you select Remove Power Fail Restart on Overflow, HVAC PRO software can remove the Power Fail Restart feature from an ASC configuration if the configuration conversion results in the overflow of available controller configuration space. HVAC PRO software may require more configuration space due to enhanced strategies. Refer to Upgrading a Single Controller in the Detailed Procedures section for further information on Power Fail Restart.</td>
</tr>
<tr>
<td><strong>Update VAV Tuning Parameters</strong></td>
<td>When you select Update VAV Tuning Parameters, HVAC PRO software recalculates and updates the VAV tuning parameters for applications loaded in a VAV controller. Deselect this option to retain the current tuning parameter values.</td>
</tr>
<tr>
<td><strong>Download VMA Code</strong></td>
<td>When you select Download VMA Code, HVAC PRO software updates the VMA firmware by downloading the firmware code to the device as part of the upgrade process. If you select this option, HVAC PRO software uploads the VMA’s configuration data, creates the upgraded configuration and download files, upgrades the firmware code in the device, and downloads the upgraded application. Notes: When performing a multiple controller upgrade with code download on VMA1400 Series controllers, it is important to consider the amount of time the VMAs will be inoperable. This time can be estimated using the following formula: Inoperative Time = (2 minutes * number of controllers) + 10 minutes We recommend upgrading multiple VMAs in quantities that will not allow the zone served by the VMAs to drift away from setpoint by more than what is acceptable to the customer.</td>
</tr>
<tr>
<td><strong>Replace CFG Files on Disk</strong></td>
<td>During multiple controller uploads, you do not want to constantly interrupt the upgrade process to supply configuration file names. Replace CFG Files on Disk gives you control of either replacing any matching names or not writing a configuration file if one already exists with the same name. Note: The Replace CFG Files on Disk selection is only available when Multiple Controllers is selected.</td>
</tr>
</tbody>
</table>

Notes: When performing a multiple controller upgrade with code download on VMA1400 Series controllers, it is important to consider the amount of time the VMAs will be inoperable. This time can be estimated using the following formula:

\[
\text{Inoperable Time} = (2 \times \text{number of controllers}) + 10 \text{ minutes}
\]

We recommend upgrading multiple VMAs in quantities that will not allow the zone served by the VMAs to drift away from setpoint by more than what is acceptable to the customer.
Table 4-2: HVAC PRO Object File Names

<table>
<thead>
<tr>
<th>HVAC PRO Versions</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOS-based Versions</td>
<td>AHUnnn.AHO*</td>
</tr>
<tr>
<td></td>
<td>UNTnnn.UCO*</td>
</tr>
<tr>
<td></td>
<td>VAVnnn.VAO*</td>
</tr>
<tr>
<td>Windows-based Versions</td>
<td>XXXnnn.ASC*</td>
</tr>
</tbody>
</table>

* XXX is the controller type (AHU, NDM, VAV, UNT, or PHX) and nnn is the controller’s N2 address or Zone Bus (ZB).

Note: HVAC PRO software does not support an upgrade of the TC-9100.
**Procedure Overview**

Table 4-3: Uploading and Upgrading Configurations

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload a Configuration</td>
<td>On the Upload menu, click Configuration in Controller. Verify the communication selections and click OK.</td>
</tr>
<tr>
<td>Upgrade a Single Controller</td>
<td>On the Upload menu, click Upgrade Controllers. In the Upgrade Controllers dialog box, select Single Controller. Select/deselect the options. Click OK. In the Upgrade Controller communication parameter verification window, verify the communication parameters for the controller. Click OK.</td>
</tr>
<tr>
<td>Upgrade Multiple Controllers</td>
<td>On the Upload menu, click Upgrade Controllers. Select Multiple Controller. Select/deselect the options. Click OK. In the Upgrade Controller communication parameter verification window, choose the N2 Comm. Port and type in a starting address. In the Device Options section, choose Process All Device Types to scan for all supported device types. To specify certain device types, choose Process Selected Device Types. Select the types. Click OK.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Uploading a Configuration

To upload a configuration:

1. On the Upload menu, click Configuration in Controller. The Upload Controller dialog box appears (Figure 4-2). The Communication Port, Bus Type, and N2 Device Address all default to the last entered value.

![Upload Controller Dialog Box](image)

Figure 4-2: Upload Controller Dialog Box

2. Verify the communication selections and click OK. HVAC PRO software uploads the object file from the controller and rebuilds the configuration. HVAC PRO software shows the progress through the upload process.
Upgrading a Single Controller

To upgrade a single controller:

1. On the Upload menu, click Upgrade Controllers. The Upgrade Controllers dialog box appears (Figure 4-3).

   ![Upgrade Controllers Dialog Box](image)

   **Figure 4-3: Upgrade Controllers Dialog Box**

2. Select Single Controller.

3. Select/deselect the options. The options are described in Table 4-1.

4. Click OK. The Upgrade Controller communication parameter verification window appears (Figure 4-4).

   ![Communication Parameter Verification Window](image)

   **Figure 4-4: Communication Parameter Verification Window**
5. Verify the communication parameters for the controller. Click OK.

If a configuration file already exists with the name retrieved from the controller, HVAC PRO software prompts you either to replace the file or enter a new file name.

![Upgrade Controllers dialog box](image)

**Figure 4-5: Change File Name Dialog Box**

When you verify the communication parameters and file name, HVAC PRO software uploads the configuration from a controller, converts the configuration, and then downloads the new configuration to the controller. The features present in the new configuration are the same as the features in the version being upgraded.

If there is a configuration overflow in an ASC device using a configuration that allows diagnostics, HVAC PRO software removes features in the following order in an attempt to remove the overflow error: Power Fail Restart, damper duty cycling diagnostics, flow diagnostics, and zone temperature diagnostics. If removal of all these features does not clear the overflow error, HVAC PRO software displays an error message and you must decide which features to remove or upgrade to a controller with more configuration space.

**Note:** HVAC PRO software only removes Power Fail Restart if you selected that option in the Upgrade Controllers dialog box (refer to Figure 4-3). An X displays in the box next to Remove Power Fail Restart on Overflow when it is selected.
Upgrading Multiple Controllers

To upgrade multiple controllers:

1. On the Upload menu, click Upgrade Controllers. The Upgrade Controllers dialog box appears (Figure 4-6).

![Upgrade Controllers Dialog Box]

Figure 4-6: Upgrade Multiple Controllers Dialog Box

2. Select Multiple Controllers.
3. Select/deselect the options. The options are described in Table 4-1.
4. Click OK. The Upgrade Controller communication parameter verification window appears.

![Upgrade Controllers dialog box]

5. Choose the N2 Comm. Port and type in a starting address. Devices at addresses less than the specified starting address are ignored in the scan.

6. In the Device Options section, choose Process All Device Types to scan for all supported device types. To specify certain device types, choose Process Selected Device Types. Select the desired device types.

7. Click OK. HVAC PRO software scans the N2 Bus connected through the selected port for all N2 devices, starting with the selected starting address. You can cancel the search at any time by selecting Cancel or hitting the space bar.

Note: During this scan (prior to upgrades) HVAC PRO software collects controller information for each device it detects on the N2 Bus. This information is written to the file devices.log. For more information on the type of information collected, see the Testing and Receiving Data from Controllers (LIT-63750416) chapter in this guide.

When HVAC PRO software completes the scan, it displays all the devices found. Figure 4-8 illustrates the Device list.
The devices shown below were found on the N2 Bus. All devices marked ">" will be processed.

<table>
<thead>
<tr>
<th>Addr</th>
<th>Device</th>
<th>Rev.</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;2</td>
<td>VAV</td>
<td>4.00</td>
<td>Single Duct</td>
</tr>
<tr>
<td>#3</td>
<td>AHU</td>
<td>3.04</td>
<td>Mixed Air Single Path</td>
</tr>
<tr>
<td>&gt;18</td>
<td>VAV</td>
<td>4.00</td>
<td>Single Duct</td>
</tr>
<tr>
<td>&gt;25</td>
<td>VMA</td>
<td>7.00</td>
<td>Single Duct</td>
</tr>
<tr>
<td>&gt;235</td>
<td>VAV</td>
<td>5.10</td>
<td>Single Duct</td>
</tr>
</tbody>
</table>

Non-upgradable devices (marked "#") will be ignored. Scan Completed - Select OK to begin Upgrades

100%

OK
Cancel

Figure 4-8: Upgrade Controllers - N2 Device List

Notes: Only devices marked with the > sign are upgraded. To toggle the > sign on or off, select a device and click the Mark/Unmark Controller button.

Devices marked with a # cannot be upgraded. You cannot mark/unmark these devices, and they will be ignored in the upgrade process. If you want to know why the controller cannot be upgraded, perform a Single Controller Upgrade for that device. HVAC PRO software displays the reason why the controller cannot be upgraded.

8. Click OK. HVAC PRO software upgrades the marked devices included in the N2 Device List. When HVAC PRO software completes the upgrade process it displays the message box shown in Figure 4-9.

Figure 4-9: Upgrade Complete Message Box
HVAC PRO software writes a detailed upgrade summary for each device. This summary, called upgrade.log, is stored in the current directory. This upgrade log includes information such as whether there were errors in the upgrade process. It also indicates where files are stored. If a recovery action is required for a failed upgrade, the log file lists the necessary steps involved. Select Yes to view the upgrade log.

Note: When HVAC PRO software writes an upgrade summary, it renames the existing upgrade.log file to upgrade.nnn, where nnn is a number from 0 to 999.
Troubleshooting

Uploading a Configuration

If the available space is exceeded during the File > Save process, HVAC PRO software warns it cannot upload the configuration.

If HVAC PRO software cannot upload the configuration because of communications errors, an error message similar to the Figure 4-10 appears. (A different message appears if the controller cannot be uploaded.) Click the OK button to acknowledge the message.

![Figure 4-10: Upload Error Dialog Box](image)

Check the port and bus type, check the N2 address if you are using an N2 Bus, and restart the upload process. Click OK to continue when the upload process completes. Save the uploaded configuration by selecting Save or Save As through the File menu.
Chapter 5
Commissioning a Controller

Introduction

Commissioning a controller takes place in Commission mode, a mode allowing online, operating communications with the controller.

This chapter describes how to:

- commission a controller using the current configuration
- commission using the configuration in the controller
- calibrate sensors using the AI Offset Table for ASC devices
- release all overrides
- exit Commission mode for ASC devices
- exit Commission mode for TC-9100 controllers
- exit Commission mode for VMA1400 Series devices
- reset a controller
Key Concepts

Commission Mode

The Commission mode allows online, operating communications with the controller.

Commission Using the Configuration in the Controller

ASC Devices

When commissioning using the configuration in the controller for ASC devices, HVAC PRO software compares the application and sideloop path revision numbers stored in the controller with the revision numbers in the database.

If the configuration in the controller used an earlier version of the application or sideloop paths, HVAC PRO software displays a message telling you that a newer version of the application exists and asks if you would like to continue without an upgrade.

If you do not continue, the commissioning process is aborted. You must manually upgrade the application and continue to commission after the successful upgrade.

If you choose to continue without an upgrade, HVAC PRO software checks the file name of the configuration in the controller and looks for a matching name in the current directory set by HVAC PRO software. It also checks for matching device types, application names, and application/sideloop data versions. When a matching file exists, a dialog box asks to use it for commissioning (Figure 5-1).

Figure 5-1: Read Configuration from File Dialog Box

If you select No, HVAC PRO software uploads the configuration from the controller and starts the Commission mode. If you select Cancel, the process is aborted. If you select Yes, HVAC PRO software reads the configuration from the file and starts commissioning.
**TC-9100 Controllers and VMA Devices**

When commissioning using the configuration in the controller for both TC-9100 controllers and VMA1400 Series devices, HVAC PRO software performs a single controller upload as described in the *Uploading and Upgrading Configurations (LIT-63750405)* chapter in this guide.

**Exiting Commission Mode in TC-9100 Controllers and VMA1400 Series Devices**

The Commission Exit dialog box for TC-9100 controllers lists all parameters that have differences between the configuration value, the EEPROM value at the start of the commissioning session, and/or the current EEPROM value. Overridden points are not listed, and all overrides will be released when HVAC PRO software returns to the Configuration mode.

The Commission Exit dialog box for VMA1400 Series devices lists all application components that have configurable attributes or parameters with differences between their configuration value, their controller value at the start of the commissioning session, and/or their current controller value.

**Sensor Calibration in Using the AI Offset Table for ASC Devices**

This function is available for ASC devices only. This function allows you to calibrate sensors by adding or subtracting from the present sensor reading to eliminate any error due to wire length or sensor drift. It is only available when you are in Commission mode. In other modes, this menu item is unavailable.

*Note:* If you are commissioning a 2K controller or AHU over the N2 Bus, you can only view the AI offsets. You will not be able to calibrate them. A warning message in the AI Offset Table alerts you of this condition. (You can adjust offsets over the N2 Bus for 8K controllers over the Zone Bus for any application specific controller.)

You can only adjust the offset of an AI point when you are online with the controller during commissioning. The offset value is maintained in the EEPROM of the controller. Auto Zero mode, if enabled, automatically calculates and adjusts the offset value for the velocity pressure transducer used in VAV terminal unit controllers.

**Override Release in Commission Mode**

This Commission menu option activates when you override any points while in Commission mode. Select this menu option to release all overridden points.
Controller Resetting

The Reset Controller feature allows you to reset a single ASC or VMA1400 Series device without entering the Commission mode. TC-9100 controllers do not process the reset command.
### Procedure Overview

#### Table 5-1: Commissioning a Controller

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commission a Controller Using the Current Configuration</td>
<td>On the Commission menu, click Current Configuration. Verify the communications settings and click OK. HVAC PRO software enters the Commission mode. HVAC PRO software displays the current states of the inputs, outputs, and parameters.</td>
</tr>
<tr>
<td>Commission Using the Configuration in the Controller</td>
<td>On the Commission menu, click Configuration in Controller. Verify the communication parameters and click OK.</td>
</tr>
<tr>
<td>Calibrate Sensors Using the AI Offset Table for ASC Devices</td>
<td>On the Commission menu, click AI Offset Table. View, or if allowed, modify and save the AI offsets to the controller. To modify the AI Offset values, select the AI point you want to change. Click in the Edit field. Type in the desired offset value. Repeat steps to adjust other offsets. When you are finished, click OK.</td>
</tr>
<tr>
<td>Release All Overrides</td>
<td>On the Commission menu, click Release All Overrides.</td>
</tr>
<tr>
<td>Exit Commission Mode for ASC Devices</td>
<td>On the Commission menu, click Exit Commissioning Mode. Select the appropriate options.</td>
</tr>
<tr>
<td>Exit Commission Mode for TC-9100 Controllers</td>
<td>On the Commission menu, click Exit Commissioning Mode. Select the appropriate options.</td>
</tr>
<tr>
<td>Exit Commission Mode for VMA1400 Series Devices</td>
<td>On the Commission menu, click Exit Commissioning Mode. Select the appropriate options.</td>
</tr>
<tr>
<td>Reset a Controller</td>
<td>On the Action menu, click Reset Controller. Select the proper communication settings for the controller to be reset. Click OK to reset the controller or Cancel to abort the operation.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Commissioning a Controller Using the Current Configuration

To commission a controller using the current configuration:

1. On the Commission menu, click Current Configuration. HVAC PRO software displays a prompt to verify communications settings (Figure 5-2).

Note: The configuration must be complete and saved to enable this menu selection.

2. Verify the communications settings and click OK.

HVAC PRO software verifies the configuration in the controller matches the displayed configuration. If the file name, application, target device, or hardware point definitions are different, HVAC PRO software displays an error message and returns to Configuration mode. For VMA1400 Series devices, HVAC PRO software also checks that the device is in an operational state. If no errors are found, HVAC PRO software displays a box indicating it is reading values from the controller (Figure 5-3).
Commissioning

Currently accessing data.
Please Wait...

Figure 5-3: Accessing Data Dialog Box

HVAC PRO software enters the Commission mode. You can view all values after HVAC PRO software obtains them.

Figure 5-4: Commissioning Window

HVAC PRO software displays the current states of the inputs, outputs, and parameters. An asterisk displays next to points or parameters that are currently overridden. For ASC devices, an alarm indicator (!) displays next to AIs or Binary Inputs (BIs) in alarm.

Note: For ASC devices, the override indicator (*) has a higher precedence than the alarm indicator (!). If the point is overridden into alarm, then the override indicator (*) displays. Once the point’s override is released while still in alarm, the alarm indicator (!) displays.

Commissioning Using the Configuration in the Controller

To commission using the configuration in the controller:

1. On the Commission menu, click Configuration in Controller. The Upload/Commission Controller dialog box appears requesting the communication parameters (Figure 5-5).

Note: The upload feature supports only devices downloaded with HVAC PRO software.
2. Verify the communication parameters and click OK.

Note: The TC-9100 class controller does not support Zone Bus communications.

Calibrating Sensors Using the AI Offset Table for ASC Devices

To enter the AI Offset mode:

1. On the Commission menu, click AI Offset Table. The AI Offset Table window appears (Figure 5-6).

2. View, or if allowed, modify and save the AI offsets to the controller. To modify the AI Offset values, select the AI point you want to change, click in the Edit field, and type in the desired offset value.

3. Click OK.
Releasing All Overrides

To release all overridden points while in Commission mode:
On the Commission menu, click Release All Overrides.
Note: An asterisk (*) displayed preceding a point name indicates the point is in override.

Exiting Commission Mode for ASC Devices

To exit the Commission mode:
On the Commission menu, click Exit Commission mode. For ASC devices, HVAC PRO software displays a dialog box similar to Figure 5-7.

![Figure 5-7: Exit Window for ASC Devices](COMEXIT3)

Table 5-2 explains the Exit Window options for ASC devices.
### Table 5-2: Exit Window Options for ASC Devices

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit/No Change</td>
<td>Does not save overrides to the controller or controller values to the configuration file.</td>
</tr>
<tr>
<td>Exit/Save Changes</td>
<td>Saves overrides and controller values according to the selected options. Only available when there have been changes to the configuration.</td>
</tr>
<tr>
<td>Remove Override</td>
<td>Removes individual overrides from the Configuration Changes list.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Commission Exit window and returns to the Commission mode.</td>
</tr>
<tr>
<td>View Details</td>
<td>Expands the Commission Exit window and views details of configuration changes. Refer to Figure 5-8 for an example.</td>
</tr>
<tr>
<td>Save Overrides to Controller</td>
<td>Saves the override values to the controller. You do not need to download the controller again. These new values become the current controller values.</td>
</tr>
<tr>
<td>Note:</td>
<td>When you select both Save Controller Values to File and Save Overrides to Controller, HVAC PRO software saves the overrides first then the controller values (now the override values) to the Configuration file.</td>
</tr>
<tr>
<td>Save Controller Values to File</td>
<td>Saves current controller values to the Configuration file when you press the Exit/Save Changes button.</td>
</tr>
<tr>
<td>Reset Controller</td>
<td>Sends a reset command to the controller as it exits Commission mode. Most controllers come back online to the N2 Bus after a 10-minute delay following Zone Bus communications. However, the controllers listed below do not have this feature and require a controller reset after Zone Bus communications to enable N2 Bus communications. If you do not reset these controllers, they will not come back online to the N2 Bus. HVAC PRO software displays a reminder with an option to reset the controller after it communicates over the Zone Bus with any of the following: AHU (Firmware Version B01), UNT (Firmware Version A01), VAV (Firmware Version A01). Refer to the Testing and Receiving Data from Controllers (LIT-63750416) chapter in this guide for information on obtaining the controller type and its firmware revision. When you exit commissioning, all overrides not saved to the controller are released, and HVAC PRO software returns to the main display.</td>
</tr>
</tbody>
</table>
Figure 5-8: Expanded Exit Window for ASC Devices
Exiting Commission Mode for TC-9100 Controllers

To exit Commission mode:

On the Commission menu, click Exit Commissioning mode. For TC-9100 controllers, HVAC PRO software displays a dialog box similar to Figure 5-9:

![Exit Window](COMEXIT4.png)

**Figure 5-9: Exit Window for TC-9100 Controllers**

Table 5-3 explains the Exit Window options for TC-9100 controllers.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit/No Change</td>
<td>Restores all controller EEPROM values changed during the current commissioning session. Does <strong>not</strong> save any changes to the Configuration file.</td>
</tr>
<tr>
<td>Exit/Save Changes</td>
<td>Restores any controller EEPROM values selected to restore. Then, if Save Current EE2 is selected, the current controller EEPROM values are saved to the configuration file. All EEPROM changes not selected to restore remain changed in the controller.</td>
</tr>
<tr>
<td>Restore EE2 Value</td>
<td>Restores the controller’s EEPROM value for a parameter to the value it held at the start of the commissioning session. Only enabled when you highlight a changed parameter in the Configuration Changes list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The EEPROM value is not restored if you select Cancel to return to Commission mode.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Commission Exit window and returns to the Commission mode.</td>
</tr>
<tr>
<td>View Details</td>
<td>Expands the Commission Exit window and shows details of configuration changes. If the window is already expanded, selecting View Details returns the window to the regular Commission Exit screen. Refer to Figure 5-10 for an example.</td>
</tr>
<tr>
<td>Save Current EE2 Values to File</td>
<td>Saves current controller values to the Configuration file when you press the Exit/Save Changes button.</td>
</tr>
</tbody>
</table>
Exiting Commission Mode for VMA1400 Series Devices

To exit Commission mode:

On the Commission menu, click Exit Commissioning mode. For VMA1400 Series devices, the Commission Exit screen appears Figure 5-11.

Figure 5-10: Expanded Exit Window for TC-9100 Controllers

Figure 5-11: Exit Window for VMA Devices
Table 5-4 explains the Exit Window options for VMA1400 Series devices.

Note: For Exit/Save Changes, the hourglass icon displays while VMA archive is in progress (less than 60 seconds).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit/No Change</td>
<td>Restores all controller changes made during the current commissioning session. This option does <strong>not</strong> save any changes to the configuration file.</td>
</tr>
<tr>
<td>Exit/Save Changes</td>
<td>Saves overrides and controller values according to the options you have selected. (Refer to Save Changes to Controller and Save Controller Values to File in this table.) This option is only enabled when there have been changes to the configuration.</td>
</tr>
<tr>
<td>Remove Change</td>
<td>Removes individual changes for attributes or parameters of an application component. This option is only enabled when a changed item is selected on the expanded Exit Commission window.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Commission Exit window and returns to the Commission mode.</td>
</tr>
<tr>
<td>View Details</td>
<td>Expands the Commission Exit window and shows details of configuration changes. If the window is already expanded, selecting View Details returns the window to the regular Commission Exit screen. The details show all configurable attributes and parameters that have differences between the configuration and controller values. Refer to Figure 5-12.</td>
</tr>
<tr>
<td>Save Changes to Controller*</td>
<td>Saves all the changed values displayed in an application component’s details list to the controller when you press the Exit/Save Changes button. You do not need to download the controller again. These new values become the current controller values.</td>
</tr>
<tr>
<td><strong>Notes:</strong></td>
<td>When you select both Save Controller Values to File and Save Changes to Controller, HVAC PRO software saves the changes first, then the controller values (now the changed values) to the Configuration file. The Proportional Band and Integral Time for the Zone Temperature control loops (cooling and proportional heating) are automatically updated by the VMA’s internal Pattern Recognition Adaptive Control (PRAC) algorithm. If these values have not been permanently saved to the configuration file, they show up as changes in the Commission Exit dialog box. If you wish to ensure that the tuned values are used in future application downloads to the VMA, select the option to Save Controller Values to File, and use the Exit/Save Changes button to exit.</td>
</tr>
<tr>
<td>Save Controller Values to File**</td>
<td>Saves current controller values to the Configuration file when you press the Exit/Save Changes button.</td>
</tr>
<tr>
<td>Reset Controller</td>
<td>Sends a reset command to the controller as it exits Commission mode.</td>
</tr>
</tbody>
</table>

* Save Changes to Controller keeps the application version the same and changes the HVAC PRO version.

** When you exit commissioning with the option to save controller values to file, HVAC PRO software produces a download file of the same application version currently present in the controller. This allows the controller to continue to be compatible with earlier versions of HVAC PRO software. However the format of the configuration files (.cfg) generated by these saves may not be compatible with earlier versions of HVAC PRO software.
Figure 5-12: Expanded Exit Window for VMA Devices

Resetting a Controller

To reset a controller:

1. On the Action menu, click Reset Controller. The Reset Controller dialog box displays (Figure 5-13).

Figure 5-13: Reset Controller Dialog Box

2. Select the proper communication settings for the controller to be reset.
3. Click OK to reset the controller or Cancel to abort the operation.
Chapter 6

Viewing and Modifying Configurations

Introduction

The Question/Answer session, accessed by clicking the Q/A button, provides the means to modify an existing configuration.

This chapter describes how to:

- view a configuration
- modify a configuration
Key Concepts

Question/Answer (Q/A) List Box

The Q/A list box contains a list of the questions and answers that form the basis of the configuration. Changing answers to questions in the Q/A session modifies the configuration.

When you change a response to a question, all questions after the changed selection become invalid. The invalid questions and any hardware points or parameters loaded by them are cleared from the HVAC PRO screen. The program then steps you through the remaining questions so you may reconfirm or change your answers. Hardware points and parameters required by the new that existed prior to the path change are re-added when you modify the path, and retain their previous definitions. New hardware points and parameters that are loaded use default definitions.

If you exit the Question/Answer session before re-answering all of the remaining questions, HVAC PRO software clears the screen without changing any answers in the last saved configuration.
**Procedure Overview**

**Table 6-1: Viewing and Modifying Configurations**

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>View a Configuration</td>
<td>Click on the Q/A button.</td>
</tr>
<tr>
<td>Modify a Configuration</td>
<td>Double-click on the question or answer of a question. If you change an answer, HVAC PRO software displays a prompt to verify that you want to change the configuration. Click OK to confirm or Cancel to cancel the change. Answer the remaining questions in the Question/Answer session as prompted.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Viewing a Configuration

To view a configuration:

Click on Q/A.

HVAC PRO software displays the configuration question/answer path and moves the focus to the Question/Answer list box.

Modifying a Configuration

To modify a configuration:

1. Double-click on the question or answer of a question. HVAC PRO software enters the Question/Answer session at the point you select.

Note: If you change an answer, HVAC PRO software displays a prompt to verify that you want to change the configuration (Figure 6-1).

2. Click OK to confirm or Cancel to cancel the change.

3. Answer the remaining questions in the Question/Answer session as prompted.

Figure 6-1: Changing the Configuration Prompt
Chapter 7

Viewing and Modifying Configuration Inputs

Introduction

The Inputs list box, accessed by clicking the Inputs button, provides the means to view and modify configuration inputs.

This chapter describes how to:

- view and modify Analog Inputs and Binary Inputs
- modify ASC analog inputs
- modify ASC binary inputs
- modify ASC analog inputs in Commission mode
- modify ASC binary inputs in Commission mode
- modify TC-9100 Controller analog inputs
- modify TC-9100 Controller binary inputs
- modify TC-9100 Controller analog inputs and binary inputs in Commission mode
- modify VMA analog and binary inputs
- define a range for VMA inputs
- modify VMA analog and binary inputs in Commission mode
Key Concepts

Inputs List Box

Use the Inputs list box to view and modify Analog Inputs (AIs) and Binary Inputs (BIs).

Note: The Override/Release box displays when you are in Commission mode. The commissioning section for each input or output type follows the modification sections.

Pressure Sensor Analog Input Ranges for ASC Devices

When an ASC download object is generated, HVAC PRO software determines the full range and the reliability range of each AI sensor based on its sensor type and the range values specified on the Analog Input Modify screen.

For most AIs, the reliability range of the sensor is defined by the low and high output range values entered by the operator. However, for AIs defined as pressure sensors by the Question/Answer session, the usable range of the DP sensor (for example, 0 to 1.5 in. WG, 0.5 to 4.5 volts) must be extrapolated to the full range of the A/D converter (for example, -0.2 to 10.2 volts).
The extrapolated values then represent both the full range and the reliability range of the sensor. When the controller is downloaded, the high and low limit values of the full range are stored in the controller along with the high and low limit values of the reliability range.

For pressure sensors, the reliability range equals the full range. The range values entered by the operator (for example, 0 to 1.5 in. WG, 0.5 to 4.5 volts) are not stored in the controller and cannot be retrieved by the upload or commissioning utilities. This may result in value differences between the range values stored in a configuration file and the values obtained from the controller during upload, upgrade, or commissioning.

Note: The differences between the values do not affect the operation of the controller.

Use the full range values retrieved from the controller rather than the specific range values shown in the original configuration file. The full range values yield the same result. The calibration remains the same, and the AI offset is unaffected.

**User-defined Ranges for VMA Inputs**

Note: User-defined AI ranges for VMA1400 Series controllers are only available with VMA code B12 or later and HVAC PRO Release 7.02 or later.

Table 7-1 indicates which VMA AIs support user-defined ranges.

<table>
<thead>
<tr>
<th>Analog Input</th>
<th>Input Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI1</td>
<td>Ohms</td>
<td>Zone temperature</td>
</tr>
<tr>
<td>AI2</td>
<td>Ohms</td>
<td>Remote setpoint</td>
</tr>
<tr>
<td>AI3</td>
<td>Volts</td>
<td>Humidity sensor or external pressure sensor</td>
</tr>
<tr>
<td>AI4</td>
<td>Ohms</td>
<td>Additional temperature measurement</td>
</tr>
<tr>
<td>AI5</td>
<td>Volts</td>
<td>Internal pressure sensor</td>
</tr>
</tbody>
</table>

Note: We currently do not recommend changing AI5. The sensor is an integral piece of the VMA and cannot be removed or changed in the field.

Figure 7-2 is an example of Component Modify for an AI for a VMA1400 Series controller.
Figure 7-2: Component Modify for User-defined AI
### Procedure Overview

#### Table 7-2: Viewing and Modifying Configuration Inputs

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>View and Modify Analog Inputs and Binary Inputs</td>
<td>Click on Inputs. Double-click on a point. Modify the definition of each point.</td>
</tr>
<tr>
<td>Modify ASC Analog Inputs</td>
<td>Double-click on a point. Modify entries in the Analog Input Modify dialog box.</td>
</tr>
<tr>
<td>Modify ASC Binary Inputs</td>
<td>Double-click on a point. Modify entries in the Binary Input Modify dialog box.</td>
</tr>
<tr>
<td>Modify ASC Analog Inputs in Commission Mode</td>
<td>Double-click on a point. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
<tr>
<td>Modify ASC Binary Inputs in Commission Mode</td>
<td>Double-click on a point. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
<tr>
<td>Modify TC-9100 Controller Analog Inputs</td>
<td>Double-click on a point. Modify entries in the Analog Input Modify dialog box.</td>
</tr>
<tr>
<td>Modify TC-9100 Controller Binary Inputs</td>
<td>Double-click on a point. Modify entries in the Binary Input Modify dialog box.</td>
</tr>
<tr>
<td>Modify TC-9100 Controller Analog Inputs and Binary Inputs in Commission Mode</td>
<td>Double-click on a point. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
<tr>
<td>Define a Range for VMA Inputs</td>
<td>In the Component Modify dialog box, double-click Setup in the Attribute List. Enter a value for the attribute to be modified and click OK.</td>
</tr>
<tr>
<td>Modify VMA Analog and Binary Inputs in Commission Mode</td>
<td>Double-click on a point. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Viewing and Modifying Analog Inputs and Binary Inputs

To view and modify Analog Inputs (AIs) and Binary Inputs (BIs):

1. Click on Inputs.
   HVAC PRO software displays the configuration inputs and moves the focus to the Inputs list box.

2. Double-click on a point. The Modify screen displays the selected point. Modify the definition of each point.

Modifying ASC Analog Inputs

To modify an ASC analog input:

1. Double-click on a point. The Analog Input Modify screen appears (Figure 7-3).

![Analog Input Modify](image)

2. Modify the entries in the dialog box using the information in Table 7-3 as a guide.

Figure 7-3: Modify ASC Analog Inputs Window

2. Modify the entries in the dialog box using the information in Table 7-3 as a guide.
### Table 7-3: Modify ASC Analog Inputs Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AI Point Number</strong></td>
<td>Move the point by changing the point number. If the point cannot be moved, this field is disabled.</td>
</tr>
<tr>
<td><strong>Original Name</strong></td>
<td>HVAC PRO software assigns the original name to the AI point during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td><strong>Long Name</strong></td>
<td>Assign a 24-character name to the AI for the Print utility and screen displays.</td>
</tr>
<tr>
<td><strong>Short Name</strong></td>
<td>Assign an 8-character name to the AI point when you use CS Model DDL code for a Metasys job. If you leave this field blank, the first eight characters of the long name are used.</td>
</tr>
<tr>
<td><strong>Sensor Type</strong></td>
<td>Select the type of AI signal. Table 7-4 lists the available sensors and their description.</td>
</tr>
<tr>
<td></td>
<td>The controller flags the input as unreliable if the input value deviates out of range.</td>
</tr>
<tr>
<td></td>
<td>Note: When controllers share a sensor, both controllers must be set to the same sensor type as shown in Table 7-3. Refer to the following technical bulletins for wiring details:</td>
</tr>
<tr>
<td></td>
<td>- Air Handling Unit (AHU) Controller Technical Bulletin (LIT-6363010)</td>
</tr>
<tr>
<td></td>
<td>- Unitary Controller (UNT) Technical Bulletin (LIT-6363081)</td>
</tr>
<tr>
<td></td>
<td>- Mounting and Wiring Variable Air Volume Modular Assembly (VMA) 1400 Series Controllers Technical Bulletin (LIT-6363125)</td>
</tr>
<tr>
<td></td>
<td>Table 7-5 and Table 7-6 show the different AI types supported and the parameter default values for each input type.</td>
</tr>
<tr>
<td></td>
<td>Note: After downloading active AI points, the controller may appear to change the input and output range. The controller only retains the slope of the sensor range over its full input range. The calibration remains the same and the AI offset is unaffected. Do not change these values since the controller needs them to make the input function properly.</td>
</tr>
<tr>
<td><strong>Decimal Precision</strong></td>
<td>Select the number of digits (three digit maximum) to the right of the decimal point to display during commissioning.</td>
</tr>
<tr>
<td><strong>Units</strong></td>
<td>Select the units from the drop-down box, or highlight the current units and type in new ones.</td>
</tr>
<tr>
<td><strong>Filter Value</strong></td>
<td>The filter adjustment allows a smoothing effect on AIs that are transient in operation such as static pressure sensors. HVAC PRO software uses the following calculation. A filter value of 1 effectively turns the filtering action off. Adjust the filter value up to 99. This value has an extremely large filtering effect. Static pressure applications may require a filter value of 8, while temperature applications usually require a filter value of 1 or 2. Any number considerably larger than this could cause excessive control delay. Notes: The filter value multiplied by 1.5 is approximately equal to the time constant of the filter in seconds. HVAC PRO software truncates the entered filter value to the nearest lower power of 2. For example, if you enter a value of 4 through 7 as a filter value, the filter algorithm uses a filter value of 4.</td>
</tr>
<tr>
<td><strong>Input Range</strong></td>
<td>Enter a voltage, potentiometer resistance, or current device input range such as 0 to 5 VDC or 0 to 20 mA. You cannot adjust the values of the resistive nickel, silicon, or platinum selections because they are fixed inside the controller.</td>
</tr>
</tbody>
</table>

Continued on next page . . .
Output Range

Adjust the output range to correspond to the sensor input range. It allows you to describe the sensor’s output in the desired indication units to the logic of the controller. Nickel sensors automatically scale to -46 to 121°C (-50 to 250°F), silicon sensors to -40 to 102°C (-40 to 216°F), and platinum sensors to -46 to 121°C (-50 to 250°F).

Adjust the voltage, current, and potentiometer output ranges according to the span of the device used, such as 0 to 5 inch WG or 10 to 29°C (50 to 85°F). These values indicate the needed reliability range, causing the logic to default to selected values upon a sensor outside of these values. They do not scale the end points of the resistive sensor. The values are the endpoints of the sensor range when associated with voltage, current, and potentiometer outputs.

An example of a potentiometer output is the TE-6700 Series temperature sensor with a remote warmer/cooler setpoint. The values you enter into the output low and high ranges adds or subtracts from the heating and cooling setpoints.

Enable Alarm for ASCs

Enable Alarm enables or disables alarm reporting. The Enable Alarm box defaults to unchecked. To activate Enable Alarm:

Click on the box next to Enable Alarm.

Important: You must set the Enable Alarm feature of the controller during the configuration process for the Zone Terminal to use its alarm feature.

Table 7-7 lists the alarm parameters and their definitions.

Delete Button

Select the Delete button to remove a user-defined AI from the Inputs list. You cannot delete AIs defined through the Question/Answer session or used by sideloops. In that case, the Delete button is disabled.

Table 7-4: ASC Sensors

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resistive Nickel</td>
<td>R-NI</td>
<td>1000 ohms at 21°C/70°F</td>
</tr>
<tr>
<td>Resistive Silicon</td>
<td>R-SI</td>
<td>1035 ohms at 25°C/77°F</td>
</tr>
<tr>
<td>Resistive Platinum</td>
<td>R-PT</td>
<td>1000 ohms at 1°C/30°F</td>
</tr>
<tr>
<td>Resistive 2 K Potentiometer</td>
<td>R-POT</td>
<td>Input between 0 and 2000 ohms (defaults between 0 and 1660 ohms and is adjustable).</td>
</tr>
<tr>
<td>Voltage</td>
<td>V</td>
<td>Input between 0 and 10 VDC, any range</td>
</tr>
<tr>
<td>Current</td>
<td>C</td>
<td>Input between 0 and 20 mA</td>
</tr>
<tr>
<td>Honeywell®</td>
<td>HW</td>
<td>C7170A Discharge Water Sensor (applications targeted for UNT330-1 controllers only).</td>
</tr>
<tr>
<td>Expander Voltage</td>
<td>V-EXP</td>
<td>Expander voltage impacts Phoenix Controls devices.</td>
</tr>
<tr>
<td>York® 2.2 K NTC</td>
<td>R-NTC 2.2 K</td>
<td>Negative temperature coefficient</td>
</tr>
<tr>
<td>York 10 K NTC</td>
<td>R-NTC 10 K</td>
<td>Negative temperature coefficient</td>
</tr>
</tbody>
</table>
Table 7-5: ASC Analog Input Parameter English Defaults

<table>
<thead>
<tr>
<th>Sensor Type</th>
<th>Input Type</th>
<th>Input Low</th>
<th>Input High</th>
<th>Output Low</th>
<th>Output High</th>
<th>Filter Value</th>
<th>Alarm Low</th>
<th>Alarm High</th>
<th>Alarm Enable</th>
<th>Alarm Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>R-NI</td>
<td>N/A</td>
<td>-50</td>
<td>250</td>
<td>1</td>
<td>-50</td>
<td>250</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R-SI</td>
<td>N/A</td>
<td>-40</td>
<td>216</td>
<td>1</td>
<td>-40</td>
<td>216</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R-PT</td>
<td>N/A</td>
<td>-50</td>
<td>250</td>
<td>1</td>
<td>-50</td>
<td>250</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R-Pot*</td>
<td>0</td>
<td>1660</td>
<td>0</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>V (Temperature)</td>
<td></td>
<td>0</td>
<td>10</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Resistive 2 K Potentiometer (R-POT) input types HVAC PRO Release 5.00 and earlier used a default high input of 1500. This allowed the possibility of erroneous over range conditions. An automatic upgrade does not change this setting, so the user must change it manually or rebuild the file.

Table 7-6: ASC Analog Input Parameter Metric Defaults

<table>
<thead>
<tr>
<th>Sensor Type</th>
<th>Input Type</th>
<th>Input Low</th>
<th>Input High</th>
<th>Output Low</th>
<th>Output High</th>
<th>Filter Value</th>
<th>Alarm Low</th>
<th>Alarm High</th>
<th>Alarm Enable</th>
<th>Alarm Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>R-NI</td>
<td>N/A</td>
<td>-45</td>
<td>121</td>
<td>1</td>
<td>-45</td>
<td>121</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R-SI</td>
<td>N/A</td>
<td>-40</td>
<td>102</td>
<td>1</td>
<td>-40</td>
<td>102</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R-PT</td>
<td>N/A</td>
<td>-45</td>
<td>121</td>
<td>1</td>
<td>-45</td>
<td>121</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R-Pot*</td>
<td>0</td>
<td>1660</td>
<td>-17</td>
<td>38</td>
<td>1</td>
<td>-17</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>V</td>
<td>0</td>
<td>10</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>20</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HW</td>
<td>N/A</td>
<td>-45</td>
<td>121</td>
<td>1</td>
<td>-45</td>
<td>121</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>V-EXP</td>
<td>0</td>
<td>11</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>York 2.2 K NTC</td>
<td></td>
<td>N/A</td>
<td>-45</td>
<td>121</td>
<td>1</td>
<td>-45</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>York 10 K NTC</td>
<td></td>
<td>N/A</td>
<td>-45</td>
<td>121</td>
<td>1</td>
<td>-45</td>
<td>No</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Resistive 2 K Potentiometer (R-POT) input types HVAC PRO Release 5.00 and earlier used a default high input of 1500. This allowed the possibility of erroneous over range conditions. An automatic upgrade does not change this setting, so the user must change it manually or rebuild the file.
Table 7-7: ASC Alarm Parameters

<table>
<thead>
<tr>
<th>Alarm Parameters</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Alarm</td>
<td>When enabled, an X displays in the box next to Enable Alarm and the alarm parameters activate. You can toggle the alarm enable field from disabled to enabled by using the spacebar.</td>
</tr>
<tr>
<td>Low Alarm</td>
<td>When the AI value decreases below the alarm low limit, the point enters an alarm state.</td>
</tr>
<tr>
<td>Low Warning</td>
<td>When the AI value trends toward the low warning limit, the point enters an alarm state.</td>
</tr>
<tr>
<td>High Warning</td>
<td>When the AI value trends toward the high warning limit, the point enters an alarm state.</td>
</tr>
<tr>
<td>High Alarm</td>
<td>When the AI value exceeds the alarm high limit, the point enters an alarm state.</td>
</tr>
<tr>
<td>Differential</td>
<td>The alarm differential controls when an AI point returns to a normal state. The point is normal when it returns to a value equal to the alarm low limit plus the differential, or the alarm high limit minus the differential.</td>
</tr>
</tbody>
</table>

Note: Warnings apply only to 8 K controllers. The 2 K controllers ignore them.

Note: Using an alarm indicator character (!) indicates AIs and BIs for ASC devices in alarm during commissioning.

Modifying ASC Binary Inputs

To modify an ASC binary input:

1. Double-click on a point. The Binary Input Modify screen appears (Figure 7-4).

2. Modify the entries in the dialog box using the information in Table 7-8 as a guide.
Table 7-8: Modify ASC Binary Inputs Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Point Number</td>
<td>Move the point by changing the point number. If the point cannot be moved, this field is disabled.</td>
</tr>
<tr>
<td>Original Name</td>
<td>HVAC PRO software assigns the original name to the BI point during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td>Long Name</td>
<td>Assign a 24-character name to the BI. HVAC PRO software uses the long name for the Print utility and screen displays.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to the BI point when you use CS Model DDL code for a Metasys job. If you leave this field blank, the first eight characters of the long name are used.</td>
</tr>
<tr>
<td>Enable COS</td>
<td>Select Yes to enable Change-of-State (COS) reporting. When answered Yes, the state of the BI reports through the N2 Bus when its changes-of-state differs from the normal condition.</td>
</tr>
<tr>
<td>Normal Condition</td>
<td>Click on the radio buttons to toggle the normal condition between the two states. When the BI changes to a state opposite of the normal condition, the change reports through the N2 Bus, providing you entered Yes in the Enable COS field.</td>
</tr>
<tr>
<td>Units (State 0 and State 1)</td>
<td>Assign a 6-character descriptive label that associates with the State 0 and State 1 condition of the BI. Highlight the current units and type in new ones, or select new units from the drop-down menu. For example, enter Off and On, Start and Stop, or whatever properly represents that BI. Note: Changing the displayed units does not change the way the state is interpreted by the configuration logic.</td>
</tr>
<tr>
<td>Delete Button</td>
<td>Select the Delete button to remove a user-defined BI from the Inputs list. You cannot delete BIs defined through the Question/Answer session or points used by sideloops. In these cases, the Delete button is disabled.</td>
</tr>
</tbody>
</table>

Modifying ASC Analog Inputs in Commission Mode

Refer to the Commissioning a Controller (LIT-63750406) chapter of this guide for information on entering and exiting Commission mode.

To modify ASC analog inputs in Commission mode:

1. Double-click on the point you want to change. The Commissioning Override/Release box appears (Figure 7-5).

![Figure 7-5: ASC AI Override/Release Dialog Box](ovrdao)
2. Modify the entries in the dialog box using the information in Table 7-9 as a guide.

**Table 7-9: ASC AI Override/Release Dialog Box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Value        | Enter the AI point value.  
Note: An asterisk (*) appears next to points in override.                                      |
| Point Attributes | Select Point Attributes to view the Point Attributes window and verify your configuration. A window similar to Figure 7-3 appears. Modify any of the following options: decimal precision value, filter value, units, and alarm parameters. To change other attributes, exit Commission mode and use the Analog Input Modify window, resave, and download the controller. |
| Point Status | Select Point Status to view the AIs’ status. Figure 7-6 appears. Only the status indicators pertaining to the current point appear dark and with a check mark. There may be more than one status indicator for any specific point. All other indicators are unavailable. |
| Override     | Select Override to override the point with the new value entered.  
Note: If a point is not eligible for overriding, the Override button is unavailable and the message This Point Cannot be Overridden displays. |
| Release      | Select Release to release the point override.                                                     |
| Exit         | Select Exit to exit the Override box and return to the main commissioning screen.                |

![Commissioning Point Status Window](image)

**Figure 7-6: ASC Commissioning Point Status Window**
Modifying ASC Binary Inputs in Commission Mode

Refer to the *Commissioning a Controller (LIT-63750406)* chapter of this guide for information on entering and exiting Commission mode.

To modify ASC binary inputs in Commission mode:

1. Double-click on the point you want to change. The Commissioning Override/Release dialog box appears (Figure 7-7).

![Commissioning Override/Release Dialog Box](image)

**Figure 7-7: ASC BI Override/Release Dialog Box**

2. Modify the entries in the dialog box using the information in Table 7-10 as a guide.

**Table 7-10: ASC BI Override/Release Dialog Box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby</td>
<td>Select either Off or On.</td>
</tr>
<tr>
<td>Point Attributes</td>
<td>Select Point Attributes to view the Point Attributes window to verify your configuration. Figure 7-4 appears. This window is similar to the Binary Input Modify window, except in Commission mode you cannot change the long name, short name, or point number. To change these attributes you must exit Commission mode and use the Binary Input Modify window, resave, and download the controller.</td>
</tr>
<tr>
<td>Point Status</td>
<td>Select Point Status to view the status of the BI. Only the status indicators that pertain to the current point appear dark and with a check mark. There may be more than one status indicator for any specific point. All other indicators appear dimmed.</td>
</tr>
<tr>
<td>Override</td>
<td>Select Override to override the point with the new value you have selected.</td>
</tr>
<tr>
<td>Note:</td>
<td>If a point is not eligible for overriding, the Override button is unavailable and the message This Point Cannot be Overridden displays.</td>
</tr>
<tr>
<td>Release</td>
<td>Select Release to release the point override.</td>
</tr>
<tr>
<td>Exit</td>
<td>Select Exit to exit the Override box and return to the main commissioning screen.</td>
</tr>
</tbody>
</table>
Modifying TC-9100 Controller Analog Inputs

To modify a TC-9100 Controller analog input:

1. Double-click on a point. The Analog Input Modify screen appears (Figure 7-8).

![Figure 7-8: Modify TC-9100 Controller Analog Inputs Window](AIMODTC)

2. Modify the entries in the dialog box using the information in Table 7-11 as a guide.

Table 7-11: Modify TC-9100 Controller Analog Inputs Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI Point Number</td>
<td>The AI point number location is fixed and cannot be moved.</td>
</tr>
<tr>
<td>Original Name</td>
<td>Assigned during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td>Long Name</td>
<td>Assign a 24-character name to the AI. HVAC PRO software uses the long name for the Print utility and screen displays.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to the AI point when you use CS Model DDL code for a Metasys job. If you leave this field blank, the first eight characters of the long name are used.</td>
</tr>
<tr>
<td>Decimal Precision</td>
<td>Select the number of digits (three digit maximum) to the right of the decimal point to display during commissioning.</td>
</tr>
<tr>
<td>Units</td>
<td>Select the units from the drop-down box, or highlight the current units and type in new ones.</td>
</tr>
</tbody>
</table>
Modifying TC-9100 Controller Binary Inputs

To modify a TC-9100 Controller binary input:

1. Double-click on a point. The Binary Input Modify screen appears (Figure 7-9).

   ![Binary Input Modify Screen](image)

   **Figure 7-9: Modify TC-9100 Controller Binary Inputs Window**

2. Modify the entries in the dialog box using the information in Table 7-12 as a guide.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Point Number</td>
<td>Fixed and cannot be moved.</td>
</tr>
<tr>
<td>Original Name</td>
<td>Assigned during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td>Long Name</td>
<td>Assign a 24-character name to the BI. HVAC PRO software uses the long name for the Print utility and screen displays.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to the BI to use CS Model DDL code for a Metasys job.</td>
</tr>
<tr>
<td>Units (State 0 and State 1)</td>
<td>Assign a 6-character descriptive label associated with the State 0 and State 1 condition of the BI. Highlight the current units and type in new ones, or select new units from the menu. For example, enter Off and On, Start and Stop, or whatever properly represents that BI.</td>
</tr>
</tbody>
</table>
Modifying TC-9100 Controller Analog Inputs and Binary Inputs in Commission Mode

Refer to the Commissioning a Controller (LIT-63750406) chapter of this guide for information on entering and exiting Commission mode.

To modify TC-9100 Controller AIs and BIs in Commission mode:

1. Double-click on the point you want to change. The Commissioning Override/Release dialog box appears (Figure 7-10).

2. Modify the entries in the dialog box using the information in Table 7-13 as a guide.

![Figure 7-10: TC-9100 AI Override/Release Dialog Box](image)

Table 7-13: TC-9100 AI and BI Override/Release Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point Attributes</td>
<td>Select Point Attributes to view the Point Attributes window to verify the configuration. The window is similar to Figure 7-9. In Commission mode, modify either the decimal precision value or units. To change the short or long name, exit Commission mode and use the Analog Input Modify window.</td>
</tr>
<tr>
<td>Point Status</td>
<td>Select Point Status to view the status of the AI and BI. Figure 7-11 appears. Only the status indicators that pertain to the current point appear dark and with a check mark. There may be more than one status indicator for any specific point. All other indicators appear dimmed.</td>
</tr>
<tr>
<td>Override</td>
<td>TC-9100 AIs cannot be overridden.</td>
</tr>
<tr>
<td>Release</td>
<td>Select Release to release the point override.</td>
</tr>
<tr>
<td>Exit</td>
<td>Select Exit to exit the Commissioning Override/Release box and return to the main commissioning screen.</td>
</tr>
</tbody>
</table>
Modifying VMA Analog and Binary Inputs

To modify a VMA analog or binary input:

1. Double-click on the point you want to change. The Component Modify dialog box appears (Figure 7-12).

2. Modify the entries in the dialog box using the information in Table 7-14 as a guide.

Figure 7-11: TC-9100 Commissioning Point Status Window

Figure 7-12: Modify VMA Analog Inputs Window
### Table 7-14: Modify VMA Inputs Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input Point Number</strong></td>
<td>Move the point by changing the point number. If the point cannot be moved, this field is disabled.</td>
</tr>
<tr>
<td><strong>Original Name</strong></td>
<td>Assigned during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td><strong>Long Name</strong></td>
<td>Assign a 20-character name to the point. HVAC PRO software uses the long name for the Print utility and screen displays.</td>
</tr>
<tr>
<td><strong>Short Name</strong></td>
<td>Assign an 8-character name to the point for generating the CS Model DDL file.</td>
</tr>
<tr>
<td><strong>Attribute List</strong></td>
<td>Lists attributes for the component (AI or BI). If the attribute is not configurable, displays. If the attribute is configurable, the value displays. To view and modify AI and BI attributes, double-click on the attribute. The Attribute Modify dialog box appears. Modify the value of each configurable attribute. Note: The Override box displays when you are in Commission mode. The commissioning section for each input or output type follows the modification sections. The Attribute Modify dialog box is one of the following three types of screens: Multistate (Figure 7-13), Boolean (Figure 7-14), and all others (Figure 7-15).</td>
</tr>
</tbody>
</table>

| Delete Button       | Use the Delete button to remove a user-defined point from the Inputs list. |

#### Figure 7-13: Multistate Attribute Modify Dialog Box

**Attribute Modify**

Name: Setup

Value: Delta P in wc

[![Attribute Modify](attrmod1)](attrmod1)

#### Figure 7-14: Boolean Attribute Modify Dialog Box

**Attribute Modify**

Name: Anti Spike

Value: False

[![Attribute Modify](attrmod4)](attrmod4)
Defining a Range for VMA Inputs

To define a range for a VMA inputs:

1. In the Component Modify dialog box (Figure 7-12), double-click Setup in the Attribute List. The Attribute Modify dialog box appears (Figure 7-16).

2. Use the Attribute Modify dialog box to choose the most popular standard ranges. It also includes User Range Ohms for AI1, AI2, and AI4, and User Range Volts for AI3 and AI5.

Four AI attributes for user-defined ranges are accessible from Figure 7-12:

- Input Range Low
- Input Range High
- Output Range Low
- Output Range High

Note: The VMA only uses these attributes if either User Range Volts or User Range Ohms is selected.
These attributes establish the slope and intercept for the user-defined range. Using these user-defined ranges requires that the associated sensor must be linear. AI1 and AI4 ignore these values. Table 7-15 shows default values for the user-defined analog ranges in Figure 7-12.

### Table 7-15: User-Defined Analog Ranges - Default Values

<table>
<thead>
<tr>
<th>Type</th>
<th>Input Range Low</th>
<th>Input Range High</th>
<th>Output Range Low</th>
<th>Output Range High</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Range Volts</td>
<td>0</td>
<td>10</td>
<td>0</td>
<td>100</td>
<td>%</td>
</tr>
<tr>
<td>User Range Ohms</td>
<td>0</td>
<td>1660</td>
<td>-3</td>
<td>3</td>
<td>°F*</td>
</tr>
</tbody>
</table>

* English defaults are in °F; metric defaults are the same values in °C.

Note: Input Range High must be greater than Input Range Low and both must be greater than 0.

Every time a different setup is selected, the four user-modifiable ranges reset to the defaults in Table 7-15. The users can adjust these values (Figure 7-17) by selecting the appropriate attribute from the list box shown in Figure 7-2.

3. Click OK. The user-defined analog input feature can only be changed during the application configuration operation. As a result, the new range definition only takes effect after a VMA download.
Modifying VMA Analog and Binary Inputs in Commission Mode

Refer to the Commissioning a Controller (LIT-63750406) chapter of this guide for information on entering and exiting Commission mode.

To modify VMA AIs and BIs in Commission mode:

1. Double-click on the point you want to change. The Commissioning Override/Release dialog box displays for the input’s Present Value attribute. Figure 7-18 and Figure 7-19 show the Commissioning Override/Release dialog boxes for AI and BI points.

Notes: VMA1400 Series attributes with multiple values at different controlling priorities are called prioritized attributes. When you modify a prioritized attribute during commissioning, its value is written using the Operator Override priority.

VMA attributes that do not support prioritized values are called nonprioritized attributes.

![Figure 7-18: Analog Input Override/Release Dialog Box](image)

![Figure 7-19: Binary Input Override/Release Dialog Box Value](image)
2. Modify the entries in the dialog box using the information in Table 7-16 as a guide.

**Table 7-16: Override/Release Dialog Box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Value         | Displays AIs or BIs Present Value attribute.  
                 Note: If the input's Present Value attribute is controlled by an Operator Override, an asterisk (*) appears next to the point on the commissioning screen.                                                                                                                             |
| Point Attributes | The Point Attributes button displays the Component Modify dialog box for the input. Select Point Attributes... to view and modify the attributes of the input point. Figure 7-12 appears.  
                 Note: Attributes controlled by an Operator Override are indicated by an asterisk (*) in the Attributes List. Unreliable attributes are indicated by a series of question marks (????).  
                 To modify an attribute value: Double-click on the item in the Attributes list. The Commissioning Override/Release dialog box displays (Figure 7-18 or Figure 7-19).                                                                                           |
| Point Status  | Select the Point Status button to view the status for the attribute. Depending on the type of attribute, the following status indicators display: Overridden (prioritized attributes), Modified (nonprioritized attributes), Controlling Priority (prioritized attributes), Unreliable, Normal.  
                 If multiple controlling priorities are allowed, the dialog box shows the current controlling priority. If an attribute’s reliability is associated with the input’s Reliability attribute, a message displays reminding you to see the associated attribute. Figure 7-20 through Figure 7-22 show examples of the various Point Status dialog boxes. |
| Override      | Select Override to override the point with the new value entered.  
                 Note: Overrides are not allowed for attributes that are not writable. If an override is not allowed, the Override button is disabled and a message displays indicating that the point cannot be overridden.                                  |
| Release       | Select Release to release the point override.  
                 Note: Only values at the Operator Override priority may be released. If an attribute is not prioritized, or its current controlling priority is not Operator Override, the release button is disabled.                                                             |
| Exit          | Select Exit to exit the Commissioning Override/Release box and return to the main commissioning screen.                                                                                                                                                                                                                     |
Figure 7-21: Point Status for Nonprioritized Attribute Dialog Box

Figure 7-22: Point Status for Attribute with Associated Reliability Dialog Box
## Troubleshooting

The following are descriptions of known problems and their solutions.

### Table 7-17: Troubleshooting Viewing and Modifying Configuration Inputs

<table>
<thead>
<tr>
<th>Error/Condition</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Commercial Zoning Application Metric Values Incorrect in HVAC PRO Release 7.02 | The allowable minimum and maximum analog input values for the metric version of the Commercial Zoning application are incorrectly set to zero in HVAC PRO Release 7.02. | **Workaround:**  
  1. Manually adjust the values from 0 to appropriate values. The correct default values are -45°C minimum and 121°C maximum.  
  2. Save the application.  
  3. Download the affected controllers.  
   **Permanent Solution:**  
  1. Install HVAC PRO Release 7.03 or later.  
  2. Rebuild the application (do not upgrade).  
  3. Save the application.  
  4. Download the affected controllers. |
Chapter 8

Viewing and Modifying Configuration Outputs

Introduction

The Outputs list box, accessed by clicking the Outputs button, provides the means to view and modify configuration outputs.

This chapter describes how to:

- view and modify Analog Outputs (AOs) and Binary Outputs (BOs)
- modify ASC analog outputs
- modify ASC binary outputs
- modify ASC staged binary outputs
- modify ASC analog outputs in Commission mode
- modify ASC binary outputs in Commission mode
- modify TC-9100 controller analog outputs
- modify TC-9100 controller binary outputs
- modify TC-9100 controller analog outputs in Commission mode
- modify TC-9100 controller binary outputs in Commission mode
- modify VMA analog and binary outputs
- modify VMA additional outputs
- modify VMA outputs in Commission mode
**Key Concepts**

**Outputs List Box**

![Outputs List Box](image)

**Figure 8-1: Outputs List Box**

Use the Outputs List Box to view and modify Analog Outputs (AOs) and Binary Outputs (BOs).

**Note:** The Override/Release dialog box displays when you are in Commission mode.

**ASC Binary Output Min-On/Min-Off Value Conversion**

When the download object is generated, HVAC PRO software converts the values entered on the screen to the format required by the controller.

Min-On/Min-Off and interstage delays are stored in the controller as the integer number of 30-second intervals in each time period. The value is converted by multiplying the entered time by two and discarding the fractional portion of the result. For example, a time of 1.5 minutes \((2 \times 1.5 = 3.0)\) is stored in the controller as three 30-second intervals, a time of 2.8 minutes \((2 \times 2.8 = 5.6)\) is stored as five 30-second intervals, and a time of 0.4 minutes \((2 \times 0.4 = 0.8)\) is stored as zero 30-second intervals.
When HVAC PRO software reads the Min-On/Min-Off times from the controller during uploads, upgrades, and commissioning, the values are converted to minutes. Because the original values entered may not have been an integer number of 30-second intervals, the converted values may be different from the original values. This does **not** affect the operation of the controller. A conversion of the new value will still yield the same result as a conversion of the original value.

**ASC Staged Binary Output Cycles/Hour Value Conversion**

When the download object is generated, HVAC PRO software converts the values entered on the screen to the format required by the controller.

The number of cycles per hour is stored in the controller as the integer number of 30-second intervals between cycles. Since there are 120 30-second intervals per hour, the value stored in the controller is calculated by dividing 120 by the entered value. Any fractional portion of the result is discarded. For example, if you enter 9 cycles/hour, the value stored in the controller will be 13 (120/9 = 13.33).

When HVAC PRO software reads the number of 30-second intervals between cycles from the controller during uploads, upgrades, and commissioning, the value is converted to cycles per hour.

If a large value was originally entered for the cycles per hour, there may be a substantial difference between the original value and the value converted using the information in the controller. For example, if the original cycles per hour was entered as 45, the value in the controller will be 2 (120/45 = 2.67) and the converted value will be 60.

Also, the maximum value allowed in the cycles/hour field is 99. Any value entered in the cycles/hour field greater than 60 will be interpreted by the controller as one 30-second interval between cycles, and will be converted back to 99 when read from the controller.

The differences between the values do **not** affect the operation of the controller. A conversion of the new value will still yield the same result as a conversion of the original value.
## Procedure Overview

### Table 8-1: Viewing and Modifying Configuration Outputs

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>View and Modify Analog Outputs (AOs) and Binary Outputs (BOs)</td>
<td>Click on Outputs. Double-click on a point. Modify the definition of the point.</td>
</tr>
<tr>
<td>Modify ASC Analog Outputs</td>
<td>Double-click on a point. Modify entries in the Analog Output Modify dialog box.</td>
</tr>
<tr>
<td>Modify ASC Binary Outputs</td>
<td>Double-click on a point. Modify entries in the Binary Output Modify dialog box.</td>
</tr>
<tr>
<td>Modify ASC Staged Binary Outputs</td>
<td>Double-click on a point. Modify entries in the Binary Output Modify dialog box.</td>
</tr>
<tr>
<td>Modify ASC Analog Outputs in Commission Mode</td>
<td>Double-click on a point. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
<tr>
<td>Modify ASC Binary Outputs in Commission Mode</td>
<td>Double-click on a point. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
<tr>
<td>Modify TC-9100 Controller Analog Outputs</td>
<td>Double-click on a point. Modify entries in the Analog Output Modify dialog box.</td>
</tr>
<tr>
<td>Modify TC-9100 Controller Binary Outputs</td>
<td>Double-click on a point. Modify entries in the Binary Output Modify dialog box.</td>
</tr>
<tr>
<td>Modify TC-9100 Controller Analog Outputs in Commission Mode</td>
<td>Double-click on a point. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
<tr>
<td>Modify TC-9100 Controller Binary Outputs in Commission Mode</td>
<td>Double-click on a point. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
<tr>
<td>Modify VMA Analog and Binary Outputs</td>
<td>Double-click on the item in the attribute list you want to change. Modify entries in the Attribute Modify dialog box.</td>
</tr>
<tr>
<td>Modify VMA Additional Outputs</td>
<td>Double-click on the item in the attribute list you want to change. Modify entries in the Attribute Modify dialog box.</td>
</tr>
<tr>
<td>Modify VMA Outputs in Commission Mode</td>
<td>Double-click on the point you want to change. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Viewing and Modifying Analog Outputs (AOs) and Binary Outputs (BOs)

To view and modify analog outputs and binary outputs:

1. Click on Outputs.
   HVAC PRO software displays the configuration outputs and moves the focus to the Outputs list box.
2. Double-click on a point to view and modify AOs and BOs.
   The Modify screen displays the selected point.
3. Modify the definition of each point.

Modifying ASC Analog Outputs

To modify an ASC analog output:
1. Double-click on a point. The Analog Output Modify screen appears (Figure 8-2).
2. Modify the entries in the dialog box using the information in Table 8-2 as a guide.

Figure 8-2: ASC Analog Outputs Dialog Box

2. Modify the entries in the dialog box using the information in Table 8-2 as a guide.
### Table 8-2: ASC Analog Outputs Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO Point Number</td>
<td>Move the point by changing the point number. If the point cannot be moved, this option is disabled.</td>
</tr>
<tr>
<td>Original Name</td>
<td>Assigned during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td>Long Name</td>
<td>Assign a 24-character name to the AO for the Print utility. This allows the point to be monitored or controlled through network communications.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to the AO point when generating the CS Model DDL file. If this field is blank, HVAC PRO software uses the first 8 characters of the long name.</td>
</tr>
<tr>
<td>Decimal Precision</td>
<td>Select the decimal place value (3-digit maximum) to display during commissioning.</td>
</tr>
<tr>
<td>Units</td>
<td>Assign a 6-character descriptive label that associates with the condition of the AO. Highlight the current units and type in new ones, or select new units from the drop-down menu.</td>
</tr>
<tr>
<td>Type</td>
<td>Shows a reference of the controlled device type integrated to the controller. Use the up/down arrow key to select a Voltage, Current, Pneumatic, or Zone Bus type output. The default values for the various AO types are:</td>
</tr>
<tr>
<td></td>
<td>Type</td>
</tr>
<tr>
<td>Voltage</td>
<td>0.00</td>
</tr>
<tr>
<td>Current</td>
<td>0.00</td>
</tr>
<tr>
<td>Pneumatic</td>
<td>0.00</td>
</tr>
<tr>
<td>Zone Bus</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>When you select Zone Bus as the AO type, the 0 to 100% range is fixed and reflects the command range sent through the Zone Bus cable to a specific M100 motor. The necessary address of the M100 motor that enables communication through the AO channel displays. The address switches on the M100 motor must be set to the same number indicated under the M100 Address field.</td>
</tr>
<tr>
<td>Delete Button</td>
<td>Select the Delete button to remove a user-defined AO from the Outputs list. You cannot delete AOs defined by HVAC PRO software through the Question/Answer session or points used by sideloops.</td>
</tr>
</tbody>
</table>
Modifying ASC Binary Outputs

To modify an ASC binary output:

1. Double-click on a point. The Binary Output Modify screen appears (Figure 8-3).

![Binary Output Modify dialog box]

Figure 8-3: ASC Binary Outputs Dialog Box

2. Modify the entries in the dialog box using the information in Table 8-3 as a guide.
### Table 8-3: ASC Binary Outputs Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BO Point Number</strong></td>
<td>Move the point by changing the point number. If the point cannot be moved, this field will be disabled.</td>
</tr>
<tr>
<td><strong>Original name</strong></td>
<td>Assigned during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td><strong>Long Name</strong></td>
<td>Assign a 24-character name for the Print utility and screen displays.</td>
</tr>
<tr>
<td><strong>Short Name</strong></td>
<td>Assign an 8-character name for generating the CS Model DDL file. If you leave this field unused, the first 8 characters of the long name are used.</td>
</tr>
<tr>
<td><strong>Control Type</strong></td>
<td>This field automatically fills in with Valve, Individual, or Staged labels. The individual BO points (for example, pump start/stop) are separate control outputs and do not associate with staged BO points. Staged BO points are identified by the Question/Answer session (for either the main application or for sideloops) and are grouped in order as Stage 1 through n (total number of stages). Staged BOs can only be created through the application or sideloop Question/Answer session. Individual BO points can be identified through the Question/Answer session or user defined if the point is unused.</td>
</tr>
<tr>
<td><strong>Pulse Type</strong></td>
<td>Automatically fills in with Incremental, Momentary, or Maintained dependent upon selections through the application or sideloop Question/Answer session. If the point is user defined, change the pulse type to Maintained or Momentary only.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Individual/Incremental</strong></td>
</tr>
<tr>
<td></td>
<td>The controller uses the Individual/Incremental output command for an incremental control process to position damper or valve actuators. Like the staged output, the controller dedicates an analog command point found in the parameter table to the damper or valve actuator to override the pair of triacs assigned to an incremental output type.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Individual/Momentary</strong></td>
</tr>
<tr>
<td></td>
<td>Individual/Momentary output commands are useful in applications that use lighting control. For example, to override the status of the lights, command the first BO of the lighting pair. The signal duration for the lighting output is 50 ms; all other momentary BOs are 1.5 seconds.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Valve/Maintained</strong></td>
</tr>
<tr>
<td></td>
<td>The controller uses the Valve/Maintained output for 2-position valve actuators typically found in fan coils or unit vents. These valves are normally open or normally closed. For example, a normally open action energizes the triac output to keep the valve closed when heating is not required.</td>
</tr>
<tr>
<td><strong>Minimum On/Minimum Off</strong></td>
<td>The controller uses the Minimum On/Minimum Off (Min-On/Min-Off) timers for all BOs except incremental outputs. The timers are scaled in minutes. The Min-On timer keeps the output on for at least the selected amount of time regardless of the command to the binary point. (Except during shutdown, when the timers are bypassed.) The Min-Off timer works the same way by keeping the BO off regardless of the command being issued. Note: All timers reset if the Controller commands the shutdown box closed or open, and operation of timers is firmware dependent.</td>
</tr>
<tr>
<td><strong>Units (State 0 and State 1)</strong></td>
<td>Type a descriptive label that associates with the State 0 or State 1 condition of the BO, or choose one from the drop-down list box. For example, you can use units of Off and On, Start and Stop, or whatever properly represents that BO. State 0 is true when the BO is open. State 1 is true if the BO is closed.</td>
</tr>
<tr>
<td><strong>Delete Button</strong></td>
<td>Select the Delete button to remove a user-defined BO from the Outputs list. You cannot delete BOs defined by HVAC PRO software through the Question/Answer session or points used by sideloops. In these cases, the Delete button is disabled.</td>
</tr>
</tbody>
</table>
Modifying ASC Staged Binary Outputs

To modify an ASC staged binary output:

1. Double-click on a point. The Binary Output Modify screen appears (Figure 8-4).

Figure 8-4: Modifying ASC Staged Binary Outputs Window

2. Modify the entries in the dialog box. In addition to the fields described in Table 8-3, the features described in Table 8-4 also appear.
Table 8-4: Additional Options for ASC Staged Binary Outputs

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interstage Delays On/Off</td>
<td>The controller uses the Interstage Delays On/Off timer for multiple staged applications. You can adjust the values of the Interstage Delay On/Off timers. Note: The Interstage Delays On/Off and Min On/Min Off timers are affected by value conversion. For a complete description, read the ASC Binary Output Min-On/Min-Off Value Conversion section in the Key Concepts section of this chapter.</td>
</tr>
<tr>
<td>Number of Stages</td>
<td>HVAC PRO software enters the number of stages through the Question/Answer session. The number of stages can limit the control device available for definition at the end of the configuration process.</td>
</tr>
<tr>
<td>Cycles/Hour</td>
<td>The controller uses the cycles per hour (cph) feature for staged output configurations only. This value determines the maximum number of cycles per hour that can occur even if you set the Min-On/Min-Off timers for very short durations. We suggest you use a value in the range of 2 to 9 cph. For example, if you select 6 cph, HVAC PRO software calculates the time base as six 10-minute intervals. A stage can turn on and off once during an interval. If you set the Min-On and Min-Off timers to zero and you override the BO from Off to On, the stage will not energize until the 10-minute interval expires. Similarly, if you select 12 cph, HVAC PRO software calculates the time base as twelve 5-minute intervals. The cph value you select results in a calculated time base the controller uses to limit the maximum number of cycles possible per hour of that particular BO.</td>
</tr>
<tr>
<td>Assign Parameters to All Stages</td>
<td>This field only appears in staged BOs with more than one stage. When you enable this feature, the controller uses the values you enter for cph, Min-On/Min-Off timers, and Interstage Delay timers for all of the stages in the sequence. You can toggle the Assign parameters to all stages field from disabled to enabled by using the spacebar.</td>
</tr>
</tbody>
</table>

Modifying ASC Analog Outputs in Commission Mode

Refer to the Commissioning a Controller (LIT-63750406) chapter of this guide for information on entering and exiting Commission mode.

To modify ASC analog outputs in Commission mode:

1. Double-click on the point you want to change. The Commissioning Override/Release dialog box displays (Figure 8-5).

![Figure 8-5: ASC AO Override/Release Dialog Box](OVRDAO1)
2. Modify the entries in the dialog box using the information in Table 8-5 as a guide.

**Table 8-5: ASC Binary Outputs Override/Release Dialog Box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value</strong></td>
<td>This is the AO point value. Type in the new value for the displayed point.</td>
</tr>
<tr>
<td></td>
<td>Note: An asterisk (*) appears next to points in override.</td>
</tr>
<tr>
<td><strong>Override</strong></td>
<td>Select Override to override the point with the new value you have typed in.</td>
</tr>
<tr>
<td></td>
<td>Note: If a point is not eligible for overriding, the override button is unavailable and the message <em>This Point Cannot be Overridden</em> displays.</td>
</tr>
<tr>
<td><strong>Release</strong></td>
<td>Select Release to release the point override.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Select Exit to exit the Override box and return to the main commissioning screen.</td>
</tr>
<tr>
<td><strong>Point Attributes</strong></td>
<td>Select Point Attributes to view the Point Attributes window. View all the point attributes to verify your configuration. Figure 8-6 illustrates the Point Attributes window. This window is similar to the Analog Output Modify window. However, in Commission mode, you may only change the Decimal Precision value, Units, 0% command, and 100% command. To change other attributes, you must exit Commission mode and use the Analog Output Modify window, resave, and download the controller.</td>
</tr>
<tr>
<td><strong>Point Status</strong></td>
<td>Select Point Status to view the status of the AO. Figure 8-7 illustrates the Point Status window. Only the status indicators that pertain to the current point appear dark and with a check mark. There may be more than one status indicator for any specific point. All other indicators are unavailable.</td>
</tr>
</tbody>
</table>

**Figure 8-6: ASC Analog Output Point Attributes Window**
Modifying ASC Binary Outputs in Commission Mode

Refer to the Commissioning a Controller (LIT-63750406) chapter of this guide for information on entering and exiting Commission mode.

To modify ASC binary outputs in Commission mode:

1. Double-click on the point you want to change. The Commissioning Override/Release dialog box displays (Figure 8-8).

Figure 8-7: ASC Commissioning Point Status Window

Figure 8-8: Commissioning Override/Release Dialog Box
2. Modify the entries in the dialog box using the information in Table 8-6 as a guide.

**Table 8-6: ASC Binary Outputs Override/Release Dialog Box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value</strong></td>
<td>The BO point value. You can select the new value for the displayed point.</td>
</tr>
<tr>
<td>Note:</td>
<td>An asterisk (*) appears next to points in override.</td>
</tr>
<tr>
<td><strong>Override</strong></td>
<td>Select Override to override the point with the new value you have entered.</td>
</tr>
<tr>
<td>Note:</td>
<td>If a point is not eligible for overriding, the override button is unavailable and the message <strong>This Point Cannot be Overridden</strong> displays.</td>
</tr>
<tr>
<td><strong>Release</strong></td>
<td>Select Release to release the point override.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Select Exit to exit the Commissioning Override/Release box and return to the main commissioning screen.</td>
</tr>
<tr>
<td><strong>Point Attributes</strong></td>
<td>Select Point Attributes to view the Point Attributes window. You can view all the point attributes to verify your configuration. Figure 8-9 illustrates the Point Attributes window.</td>
</tr>
<tr>
<td>Note:</td>
<td>This window is similar to the Binary Output Modify window (Figure 8-3). However, in Commission mode you may only change Min-On/Min-Off times and units. If the point is a staged BO, you will also be able to change the cph and the interstage delays. To change other attributes, you must exit Commission mode and use the Binary Output Modify window, resave, and download the controller.</td>
</tr>
<tr>
<td><strong>Point Status</strong></td>
<td>Only the status indicators that pertain to the current point appear dark and with a check mark. There may be more than one status indicator for any specific point. All other indicators are unavailable. Select Point Status to view status of the BO. Figure 8-10 illustrates the Point Status window.</td>
</tr>
</tbody>
</table>

![Binary Output Modify](BOCOMOD)

**Figure 8-9: ASC Binary Output Point Attributes Window**
Figure 8-10: ASC Commissioning Point Status Window

Modifying TC-9100 Controller Analog Outputs

To view and modify TC-9100 controller analog outputs:

1. Double-click on the point you want to change. The Analog Output Modify dialog box displays (Figure 8-11).

   Figure 8-11: TC-9100 Controller Analog Outputs Window

   2. Modify the entries in the dialog box using the information in Table 8-7 as a guide.
Table 8-7: TC-9100 Controller Analog Outputs Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO Point Number</td>
<td>AO point location is fixed. It cannot be moved.</td>
</tr>
<tr>
<td>Original Name</td>
<td>Assigned to the AO point during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td>Long Name</td>
<td>Assign a 24-character name to the AO for the Print utility and screen displays.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to the AO point for generating the CS Model DDL file.</td>
</tr>
<tr>
<td>Type</td>
<td>Shows a description of the AO type.</td>
</tr>
<tr>
<td>Decimal Precision</td>
<td>Select the decimal place value (3-digit maximum) to display during commissioning.</td>
</tr>
<tr>
<td>Units</td>
<td>Assign a 6-character descriptive label that associates with the condition of the AO. Highlight the current units and type in new ones, or select new units from the drop-down menu.</td>
</tr>
</tbody>
</table>

Modifying TC-9100 Controller Binary Outputs

To view and modify TC-9100 binary outputs:

1. Double-click on the point you want to change. The Binary Output Modify dialog box displays (Figure 8-12).

![Figure 8-12: TC-9100 Controller Binary Outputs Window](BOMO00TC)
2. Modify the entries in the dialog box using the information in Table 8-8 as a guide.

**Table 8-8: TC-9100 Controller Binary Outputs Window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BO Point Number</td>
<td>The BO point location is fixed.</td>
</tr>
<tr>
<td>Original Name</td>
<td>Assigned during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td>Long Name</td>
<td>Assign a 24-character name to the BO for the Print utility and screen displays.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to the BO point for generating the CS Model DDL file.</td>
</tr>
<tr>
<td>Type</td>
<td>The BO type specified by the Question/Answer session.</td>
</tr>
<tr>
<td>Units (State 0 and</td>
<td>Type a descriptive label that associates with the State 0 or State 1 condition of the BO, or you can choose one from the drop-down list box.</td>
</tr>
<tr>
<td>State 1)</td>
<td>For example, use units of Off and On, Start and Stop, or whatever properly represents that BO. State 0 is true when the BO is open. State 1 is true if the BO is closed.</td>
</tr>
</tbody>
</table>

**Modifying TC-9100 Controller Analog Outputs in Commission Mode**

To view and modify TC-9100 controller AOs in Commission mode:

1. Double-click on the point you want to change. The Commissioning Override/Release dialog box displays (Figure 8-13).

![Figure 8-13: TC-9100 Commissioning Override/Release Dialog Box]
2. Modify the entries in the dialog box using the information in Table 8-9 as a guide.

**Table 8-9: TC-9100 Controller AO Override/Release Dialog Box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override</td>
<td>TC-9100 AOs can be overridden.</td>
</tr>
<tr>
<td><strong>Point Attributes</strong></td>
<td>Select Point Attributes to view the Point Attributes window. View all the point attributes to verify your configuration. Figure 8-14 illustrates the Point Attributes window. This window is similar to the Analog Output Modify window. However, in Commission mode, you cannot change the long name and short name. To change these attributes, you must exit Commission mode and use the Analog Output Modify window.</td>
</tr>
<tr>
<td><strong>Point Status</strong></td>
<td>Select Point Status to view the status of the AO. Figure 8-15 illustrates the Point Status window. Only the status indicators that pertain to the current point appear dark and with a check mark. There may be more than one status indicator for any specific point. All other indicators are unavailable.</td>
</tr>
</tbody>
</table>

**Figure 8-14: TC-9100 Controller Analog Output Point Attributes Window**

AO 1

Original Name: Control Output Heating

Long Name: Htg/Clg Output
Short Name: HTG-VLV
Type: Voltage (0-10V)
Decimal Precision (Commissioning): 1
Units: %
Modifying TC-9100 Controller Binary Outputs in Commission Mode

To view and modify TC-9100 controller BOs in Commission mode:

1. Double-click on the point you want to change. The Binary Output Override/Release dialog box displays.
2. Modify the entries in the dialog box using the information in Table 8-10 as a guide.

Table 8-10: TC-9100 Controller Binary Outputs Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Point Attributes</strong></td>
<td>Select Point Attributes to view the Point Attributes window. You can view all the point attributes to verify your configuration. Figure 8-16 illustrates the Point Attributes window. This window is similar to the Binary Output Modify window. However, in Commission mode, you cannot modify the long name and short name. To change the names, you must exit Commission mode and use the Binary Output Modify window.</td>
</tr>
<tr>
<td><strong>Point Status</strong></td>
<td>Select Point Status to view status of the AO and BO. Figure 8-17 illustrates the Point Status window. Only the status indicators that pertain to the current point appear dark and with a check mark. There may be more than one status indicator for any specific point. All other indicators are unavailable.</td>
</tr>
</tbody>
</table>
Modifying VMA Analog and Binary Outputs

Refer to the *Variable Air Volume Modular Assembly (VMA) 1400 Series Application Note (LIT-6375125)* for a description of input/output attributes.

To modify VMA analog and binary outputs:

1. Double-click on the item in the attribute list you want to change. The Component Modify dialog box displays for the attribute you have selected (Figure 8-18). You can modify the value of each point.

   Note: The Override/Release box displays when you are in Commission mode.
2. Modify the entries in the dialog box using the information in Table 8-11 as a guide.

**Table 8-11: Modifying VMA Outputs Window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Point Number</td>
<td>Move the point by changing the point number. If the point cannot be moved, this field is disabled.</td>
</tr>
<tr>
<td>Original Name</td>
<td>Assigned during the Question/Answer session.</td>
</tr>
<tr>
<td>Long Name</td>
<td>Assign a 20-character name to the point for the Print utility and screen displays.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to the output point for generating the CS Model DDL file.</td>
</tr>
<tr>
<td>Attribute List</td>
<td>Lists attributes for the component (AO or BO). If the attribute is not configurable, ****** displays. If the attribute is configurable, the value displays. The Attribute Modify dialog box will be one of the following two types of screens. Figure 8-19 is an example of a Multistate type, which displays a drop-down list of allowed values. Figure 8-20 is an example of all other non-Boolean types, which displays an edit field for the value.</td>
</tr>
<tr>
<td>Delete Button</td>
<td>Select the Delete button to remove a user-defined point from the Outputs list.</td>
</tr>
</tbody>
</table>
Modifying VMA Additional Outputs

To modify VMA additional output attributes:

1. Double-click on the item in the attribute list you want to change. The Component Modify dialog box displays for the attribute you have selected (Figure 8-21). You can modify the value of each point.

Note: The Override/Release box displays when you are in Commission mode.
Figure 8-21: Modifying VMA Additional Outputs Window

Notes: Additional outputs do not have a point number. Depending on its type, an additional output may use one or more hardware BOs. If an additional output uses any BOs, it will include one or more slot attributes in its attribute list. You can change the assigned hardware point locations by modifying the slot attribute on the point attribute list. The value of a slot attribute defines which BO is used by the additional output. BOs that are used by additional outputs are listed as Reserved in the Outputs list box.

A list of all hardware BOs used by an additional output displays below additional output in the Outputs list box during Configuration mode. This information is hidden during Commission mode.

2. Modify the entries in the dialog box using the information in Table 8-12 as a guide.
### Table 8-12: Modifying VMA Additional Outputs Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Output Type** | Output type describes the type of output. Examples of Additional Output types are as follows:  
  - Stepper Motor (SMO)  
  - Electric Heat Sequencer (EHS)  
  - Duration Adjust (DAO)  
  - Position Adjust (PAO)  
  - Start-Stop (SSO) |
| **Original Name** | HVAC PRO software assigns the original name to the output point during the Question/Answer session.                                    |
| **Long Name** | You can assign a 20-character name to the point. HVAC PRO software uses the long name for the Print utility and screen displays.            |
| **Short Name** | You can assign an 8-character name to the output point. HVAC PRO software uses the short name when generating the CS Model DDL file. Therefore, you want to label the short name when you intend to use CS Model DDL code for a Metasys job. |
| **Attribute List** | Attributes for the output point are listed here. If the attribute is not configurable, ****** displays. If the attribute is configurable, the value displays. If the attribute is an array of values, <ARRAY> displays. To see the various array elements, double-click on the item.  
  Outputs listed as additional outputs for VMA applications may use multiple hardware slots. For these point types, you can change the assigned hardware point location by modifying the Slot attributes in the point's attribute list.  
  The Attribute Modify dialog box will be one of the following types of screens:  
  - Figure 8-22 is an example of a Multistate type, which displays a drop-down list of allowed values.  
  - Figure 8-23 is an example of all other non-Boolean types, which displays an edit field for the value.  
  - Figure 8-24 is an example of a non-configurable Boolean attribute.  
  - Figure 8-25 is an example of an array. |
| **Delete Button** | The Delete button is always disabled for additional outputs.                                                                                           |
Figure 8-22: Multistate Attribute Modify Dialog Box

Figure 8-23: Single State Attribute Modify Dialog Box

Figure 8-24: Non-configurable Boolean Attribute Modify Dialog Box
Modifying VMA Outputs in Commission Mode

Refer to the *Commissioning a Controller* chapter of this guide for information about entering and exiting Commission mode.

To view and modify VMA outputs in Commission mode:

1. Double-click on the point you want to change. The Commissioning Override/Release dialog box displays for the output’s Present Value attribute.

The attribute value is displayed and modified differently based on its data type. Figure 8-26, Figure 8-27, and Figure 8-28 show the Commissioning Override/Release dialog boxes for an AO, BO, and additional output point.

Notes: VMA attributes that can have multiple values at different controlling priorities are called prioritized attributes. When you modify a prioritized attribute during commissioning, its value is written using the Operator Override priority.

VMA attributes that do not support prioritized values are called nonprioritized attributes.
Figure 8-27: Binary Output Override/Release Dialog Box Value

Figure 8-28: Additional Output (SMO) Override/Release Dialog Box Value
2. Modify the entries in the dialog box using the information in Table 8-13 as a guide.

Table 8-13: VMA Output Override/Release Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Value       | This is the value for the output’s Present Value attribute. You can type in or select a new value for the displayed point.  
Note: If the output’s Present Value attribute is controlled by an Operator Override, an asterisk (*) appears next to the point on the commissioning screen. |
| Override    | Select Override to override the point with the new value you have entered.  
Note: Overrides are not allowed for attributes that are not writable. If an override is not allowed, the Override button is disabled and a message displays indicating that the point cannot be overridden. |
| Release     | Select Release to release the point override.  
Note: Only values at the Operator Override priority may be released. If an attribute is not prioritized, or its current controlling priority is not Operator Override, the Release button will be disabled. |
| Exit        | Select Exit to exit the Override box and return to the main commissioning screen. |
| Point Attributes | The Point Attributes button displays the Component Modify dialog box for the Output. Select Point Attributes . . . to view and modify the attributes of the output point. Figure 8-29 illustrates the Component Modify dialog box for a binary output.  
Note: Attributes that are controlled by an Operator Override are indicated by an asterisk (*) in the Attributes List. Unreliable attributes are indicated by a value of a series of question marks (? ? ? ?).  
Double-click on an attribute to modify it. |
| Point Status | Select the Point Status button to view the status for the attribute. Depending on the type of attribute, the following status indicators display:  
- Overridden (prioritized attributes)  
- Modified (non-prioritized attributes)  
- Controlling Priority (prioritized attributes)  
- Unreliable  
- Normal  
If multiple controlling priorities are allowed, the dialog box shows the current controlling priority. If an attribute’s reliability is associated with the output’s Reliability attribute, a message displays reminding you to see the associated attribute. Examples of the various Point Status dialog boxes you may see are shown in Figure 8-30, Figure 8-31, and Figure 8-32. |
Figure 8-29: Binary Output Point Attributes Dialog Box

Figure 8-30: Point Status for Prioritized Attribute Dialog Box
Commissioning Point Status

- Modified
- Normal

Silent

See Reliability Attribute

Figure 8-31: Point Status for Nonprioritized Attribute Dialog Box

Figure 8-32: Point Status for Attribute with Associated Reliability Dialog Box
**Troubleshooting**

The following are descriptions of known problems and their solutions.

### Table 8-14: Troubleshooting Viewing and Modifying Configuration Outputs

<table>
<thead>
<tr>
<th>Error/Condition</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Missing Binary Output (BO)               | When using HVAC PRO Release 7.02 for Application Specific Controllers (ASCs), the BO interstage delays between BOs are not available for editing. When you open a previously saved file with interstages, the interstage delay box is not shown when the BO is edited. If the configuration was saved with these missing interstage delays, the interstage links have been corrupted. | Workaround:  
1. Rebuild the application using the Q/A procedure in HVAC PRO software. Refer to the Creating, Saving, and Printing Configurations (LIT-63750403) chapter in this guide for details.  
2. Edit the interstage delays.  
3. Save and download before closing the application.  
Permanent Solution:  
Install HVAC PRO Release 7.03 or later.  
Note: If you previously opened a configuration file, attempted to edit the interstage delays, and saved the application using HVAC PRO Release 7.02, the interstage links have been corrupted. After installing HVAC PRO Release 7.03, rebuild the applications. |
Chapter 9

Viewing and Modifying Configuration Parameters

Introduction

The Parameters list box, accessed by clicking the Params button, provides the means to view and modify parameters currently used by the controller.

This chapter describes how to:

- expand and collapse parameter groups
- modify analog parameters for ASC and TC controllers
- modify binary parameters for ASC and TC controllers
- modify time parameters for ASC and TC controllers
- modify analog parameters for VMA devices
- modify binary parameters for VMA devices
- modify multistate parameters for VMA devices
- modify parameters in Commission mode for ASC and TC controllers
- modify parameters in Commission mode for VMA devices
Key Concepts

Parameters List Box

Select Params to view and adjust setpoints, prop bands, limits, etc., currently used by the controller.

Figure 9-1: Parameters List Box

HVAC PRO software groups the parameters in a logical sequence, and initially determines if a group is expanded or collapsed. You can expand or collapse the parameter groups.

Commission Mode Overrides

Overrides are writes to dynamic memory, and they do not survive a power failure. For example, if you override a control output, its override value is lost when power fails. Overrides are always indicated by an asterisk on the Commissioning screen.

Any configurable values you wish to make permanent, you must save to the controller before you exit Commission mode. Modifications to the controller’s EEPROM are permanent and survive a power failure. For example, if you change the cooling setpoint, the change is permanent.
Procedure Overview

Table 9-1: Viewing and Modifying Configuration Parameters

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand and Collapse Parameter Groups</td>
<td>Double-click on the group heading.</td>
</tr>
<tr>
<td>Modify Analog Parameters for ASC and TC Controllers</td>
<td>Double-click on the parameter you want to change. Modify entries in the Parameter Modify dialog box.</td>
</tr>
<tr>
<td>Modify Binary Parameters for ASC and TC Controllers</td>
<td>Double-click on the parameter you want to change. Modify entries in the Parameter Modify dialog box.</td>
</tr>
<tr>
<td>Modify Time Parameters for ASC and TC Controllers</td>
<td>Double-click on the parameter you want to change. Modify entries in the Parameter Modify dialog box.</td>
</tr>
<tr>
<td>Modify Analog Parameters for VMA Devices</td>
<td>Double-click on the parameter you want to change. Modify entries in the Parameter Modify dialog box.</td>
</tr>
<tr>
<td>Modify Binary Parameters for VMA Devices</td>
<td>Double-click on the parameter you want to change. Modify entries in the Parameter Modify dialog box.</td>
</tr>
<tr>
<td>Modify Multistate Parameters for VMA Devices</td>
<td>Double-click on the parameter you want to change. Modify entries in the Parameter Modify dialog box.</td>
</tr>
<tr>
<td>Modify Parameters in Commission Mode for ASC and TC Controllers</td>
<td>Double-click on the parameter you want to change. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
<tr>
<td>Modify Parameters in Commission Mode for VMA Devices</td>
<td>Double-click on the parameter you want to change. Modify entries in the Commissioning Override/Release dialog box.</td>
</tr>
</tbody>
</table>
**Detailed Procedures**

**Expanding and Collapsing Parameter Groups**

To expand and collapse parameter groups, double-click on the group heading.

**Modifying Analog Parameters for ASC and TC Controllers**

To modify analog parameters for ASC and TC controllers:

1. Double-click on the parameter you want to change. HVAC PRO software displays a Parameter Modify dialog box for the parameter you have selected (Figure 9-2).

   ![Parameter Modify Dialog Box](image)

   **Figure 9-2: Modifying Float Parameters Dialog Box**

   2. Modify the entries in the dialog box using the information in Table 9-2 as a guide.
Table 9-2: Modifying Float Parameters Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Name</td>
<td>Assigned during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td>Parameter</td>
<td>A description of the parameter or its function.</td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Long Name</td>
<td>Change the parameter’s long name using up to 24 characters.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to a point for generating the CS Model DDL file.</td>
</tr>
<tr>
<td>HVAC PRO software assigns default short names to all parameters.</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>You can change the value of the parameter.</td>
</tr>
<tr>
<td>Decimal Precision</td>
<td>Select the number of digits to the right of the decimal point to display during commissioning. Select between 0 and 3 decimal places.</td>
</tr>
<tr>
<td>Units</td>
<td>Type or select a 6-character descriptive label that associated with the parameter or select one from the drop-down list.</td>
</tr>
</tbody>
</table>

Modifying Binary Parameters for ASC and TC Controllers

To modify binary parameters for ASC and TC controllers:

1. Double-click on the parameter you want to change.
   HVAC PRO software displays a Parameter Modify dialog box for the parameter you have selected (Figure 9-3).

Figure 9-3: Binary Parameter Modify Dialog Box

2. Modify the entries in the dialog box using the information in Table 9-3 as a guide.
Table 9-3: Binary Parameter Modify Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Name</td>
<td>Assigned during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td>Parameter Description</td>
<td>A one-line description of the parameter or its function is located directly below the parameter's original name.</td>
</tr>
<tr>
<td>Long Name</td>
<td>Change the parameter’s long name using up to 24 characters.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to a point for generating the CS Model DDL file. HVAC PRO software assigns default short names to all parameters.</td>
</tr>
<tr>
<td>Value</td>
<td>You can change the value of the parameter.</td>
</tr>
<tr>
<td>Units</td>
<td>Type or select a 6-character descriptive label that associates with the parameter for both State 0 and State 1. For example, type in units of On and Off, Enable and Disable, or whatever is appropriate for this value.</td>
</tr>
</tbody>
</table>

Modifying Time Parameters for ASC and TC Controllers

To modify time parameters for ASC and TC controllers:

1. Double-click on the parameter you want to change. HVAC PRO software displays a Parameter Modify dialog box for the parameter you have selected (Figure 9-4).

![Figure 9-4: Time Parameter Modify Dialog Box](image)

2. Modify the entries in the dialog box using the information in Table 9-4 as a guide.
Table 9-4: Time Parameter Modify Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Name</td>
<td>Assigned during the Question/Answer session. You cannot change the original name.</td>
</tr>
<tr>
<td>Parameter Description</td>
<td>A one line description of the parameter or its function.</td>
</tr>
<tr>
<td>Long Name</td>
<td>Change the parameter’s long name using up to 24 characters.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Assign an 8-character name to a point for generating the CS Model DDL file. HVAC PRO software assigns default short names to all parameters.</td>
</tr>
<tr>
<td>Value</td>
<td>You can change the value of the parameter.</td>
</tr>
<tr>
<td>Units</td>
<td>Type or select a 6-character descriptive label that associates with the parameter. For example, you can type in units of Hr:Mn, or whatever is appropriate for this value.</td>
</tr>
</tbody>
</table>

Modifying Analog Parameters for VMA Devices

To modify analog parameters for VMA devices:

1. Double-click on the parameter you want to change. HVAC PRO software displays an Attribute Modify dialog box for the parameter you have selected (Figure 9-5).

![Figure 9-5: Attribute Modify with Edit Field Dialog Box](ATTRMOD8)

2. Modify the entries in the dialog box using the information in Table 9-5 as a guide.

Table 9-5: Attribute Modify with Edit Field Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter Description</td>
<td>A one line description of the parameter or its function when available.</td>
</tr>
<tr>
<td>Name</td>
<td>Assigned during the Question/Answer session. You cannot change the name.</td>
</tr>
<tr>
<td>Value</td>
<td>You can change the value of the parameter if it is configurable. If it is not configurable, the value field displays ***** and is disabled.</td>
</tr>
</tbody>
</table>
Modifying Binary Parameters for VMA Devices

To modify binary parameters for VMA devices:

1. Double-click on the parameter you want to change. HVAC PRO software displays an Attribute Modify dialog box for the parameter you have selected (Figure 9-6).

2. Modify the entries in the dialog box using the information in Table 9-6 as a guide.

![Attribute Modify Dialog Box](ATTRMOD5)

**Figure 9-6: Boolean Attribute Modify Dialog Box**

**Table 9-6: Boolean Attribute Modify Dialog Box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>A one-line description of the parameter or its function is located directly above the parameter’s name, when available.</td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>HVAC PRO software assigns the name to the parameter point during the Question/Answer session. You cannot change the name.</td>
</tr>
<tr>
<td>Value</td>
<td>You can change the value of the parameter.</td>
</tr>
</tbody>
</table>
Modifying Multistate Parameters for VMA Devices

To modify multistate parameters for VMA devices:

1. Double-click on the parameter you want to change. HVAC PRO software displays an Attribute Modify dialog box for the parameter you have selected (Figure 9-7).

2. Modify the entries in the dialog box using the information in Table 9-7 as a guide.

Table 9-7: Multistate Attribute Modify Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter Description</td>
<td>A one-line description of the parameter or its function is located directly above the parameter's name, when available.</td>
</tr>
<tr>
<td>Name</td>
<td>Assigned during the Question/Answer session. You cannot change the name.</td>
</tr>
<tr>
<td>Value</td>
<td>You can change the value of the parameter.</td>
</tr>
</tbody>
</table>

Figure 9-7: Multistate Attribute Modify Dialog Box
Modifying Parameters in Commission Mode for
ASC and TC Controllers

Refer to the Commissioning a Controller (LIT-63750406) chapter of this guide for information on entering and exiting Commission mode.

To modify parameters in Commission mode for ASC and TC controllers:

1. Double-click on the parameter you want to change. The Override/Release box displays. For binary parameters, the dialog box resembles Figure 9-8, while for float parameters, the dialog box resembles Figure 9-9.

![Figure 9-8: Binary Parameter Override/Release Dialog Box](PAOVRIDE)

![Figure 9-9: Float Parameter Override/Release Dialog Box](PACOFLT)
2. Modify the entries in the dialog box using the information in Table 9-8 as a guide.

Table 9-8: Parameter Override/Release Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Depending on the parameter, you can type or select the new value for the displayed parameter. Note: TC-9100 overrides show asterisks on the main screen, but EEPROM changes do not.</td>
</tr>
<tr>
<td>Point Attributes</td>
<td>Select Point Attributes to view the Parameter Point Attributes window (see Figure 9-10, Figure 9-11, and Figure 9-12). You can view all the point attributes to verify your configuration. This window is similar to the Parameter Modify dialog box. However, in Commission mode, you may only change units or decimal precision. To change other attributes, you must exit Commission mode and use the Parameter Modify window.</td>
</tr>
<tr>
<td>Point Status</td>
<td>Select Point Status to view the status for both float and binary parameters. Figure 9-13 illustrates the Point Status window. Note: For TC-9100 controllers, if E2 was modified during the current commissioning session, Overridden is replaced by Modified, as shown in Figure 9-14. Only the status indicators that pertain to the current point appear dark and with a check mark. There may be more than one status indicator for any specific point. All other indicators appear dimmed.</td>
</tr>
<tr>
<td>Override</td>
<td>Select Override to override the point with the new value you have selected. Note: If a point is not eligible for overriding, the override button is unavailable and the message This Point Cannot be Overridden displays.</td>
</tr>
<tr>
<td>Release</td>
<td>Select Release to release the parameter override.</td>
</tr>
<tr>
<td>Exit</td>
<td>Select Exit to exit the Override box and return to the main commissioning screen.</td>
</tr>
</tbody>
</table>

Figure 9-10: Binary Parameter Point Attributes Window
Figure 9-11: Summer Compensation Window

Figure 9-12: Analog Parameter Point Attributes Window

Figure 9-13: ASC Commissioning Point Status Window
Modifying Parameters in Commission Mode for VMA Devices

Refer to the Commissioning a Controller (LIT-63750406) chapter of this guide for information on entering and exiting Commission mode.

To modify parameters in Commission mode for VMA devices:

1. Double-click on the parameter you want to change. The Commissioning Override/Release dialog box displays. The parameter value displays and is modified differently based on its data type. Figure 9-15, Figure 9-16, and Figure 9-17 show the Override/Release dialog boxes for Boolean, Multistate, and Single State parameters.
Figure 9-16: Multistate Parameter Override/Release Dialog Box

Figure 9-17: Single State Parameter Override/Release Dialog Box

Notes: VMA parameters that can have multiple values at different controlling priorities are called prioritized attributes. When you modify a prioritized attribute during commissioning, its value is written using the Operator Override priority. Any parameter that is controlled by an Operator Override is indicated by an asterisk on the commissioning screen.

VMA parameters that do not support prioritized values are called non-prioritized attributes. When you modify a non-prioritized attribute, its value will change, but no asterisk displays.
2. Modify the entries in the dialog box using the information in Table 9-9 as a guide.

Table 9-9: Parameter Override/Release Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Depending on the parameter, you can type or select the new value for the displayed parameter.</td>
</tr>
<tr>
<td></td>
<td>Note: Only prioritized attributes show an asterisk on the main screen.</td>
</tr>
<tr>
<td>Override</td>
<td>Select Override to override the point with the new value you have selected.</td>
</tr>
<tr>
<td></td>
<td>Note: Overrides are not allowed for parameters that are not writable. If an override is not allowed, the Override button is disabled, and a message displays indicating that the point cannot be overridden.</td>
</tr>
<tr>
<td>Release</td>
<td>Select Release to release the parameter override.</td>
</tr>
<tr>
<td></td>
<td>Note: Only values at the Operator Override priority may be released. If a parameter is not prioritized, or its current controlling priority is not Operator Override, the Release button will be disabled.</td>
</tr>
<tr>
<td>Exit</td>
<td>Select Exit to exit the Override box and return to the main commissioning screen.</td>
</tr>
<tr>
<td>Point Status</td>
<td>Select Point Status to view the status for the parameter. Depending on the type of parameter, the following status indicators will display:</td>
</tr>
<tr>
<td></td>
<td>● Overridden (prioritized attributes)</td>
</tr>
<tr>
<td></td>
<td>● Modified (non-prioritized attributes)</td>
</tr>
<tr>
<td></td>
<td>● Controlling Priority (prioritized attributes)</td>
</tr>
<tr>
<td></td>
<td>● Unreliable</td>
</tr>
<tr>
<td></td>
<td>● Normal</td>
</tr>
<tr>
<td></td>
<td>If multiple controlling priorities are allowed, the dialog box shows the current controlling priority. If a parameter’s reliability is associated with its parent object’s Reliability attribute, a message displays reminding you to see the associated attribute. Examples of the various Point Status dialog boxes you may see are shown in Figure 9-18, Figure 9-19, and Figure 9-20.</td>
</tr>
</tbody>
</table>
Figure 9-18: Point Status for Prioritized Attribute Dialog Box

Figure 9-19: Point Status for Nonprioritized Attribute Dialog Box

Figure 9-20: Point Status for Attribute with Associated Reliability Dialog Box
Chapter 10

Setting HVAC PRO Options

Introduction

A variety of options may be changed that affects how HVAC PRO software functions.

This chapter describes how to:

- set the FILES path
- set job information
- generate a DDL on Save
- generate a PRN on Save
- activate parameter prompting
- change window style
- change VMA screens
**Key Concepts**

**FILES Path**

The FILES path is the drive and directory where HVAC PRO software stores configuration files. Use the Set FILES Path command in the File menu to select the drive or directory.

**Job Information**

The Job information command in the Options menu allows you to assign an operator name, job name, and contract number to the configuration. It also allows you to change the default frequency and units of measurement. These names are stored in HVAC PRO software and used as defaults in subsequent configurations.

**Generate DDL on Save**

Select Generate DDL on Save from the Options menu to have HVAC PRO software automatically generate a CS Model DDL incremental source file for the CS Model when you save the configuration. This Data Definition Language (DDL) file is one of the places that uses the short name for parameters and I/O points. You may use the DDL file as a template file for commissioning a controller (does not apply to VMA). See the *Using a Template File for Commissioning (LIT-63750413)* chapter of this guide for details. A check mark appears next to Generate DDL on Save when selected.

**Generate PRN on Save**

Select Generate PRN on Save to have HVAC PRO software automatically generate a Print file when you save the configuration. This allows you to view a formatted version of your configuration file without actually sending the file to the printer. A check mark appears next to Generate PRN on Save when selected.

**Parameter Prompting**

Select Parameter Prompting to have HVAC PRO software prompt you to enter a value for certain parameters as they are loaded during the Question/Answer session. This selection is optional. A check mark appears next to Parameter Prompting when selected.
Window Style

You can change the default window style. This option does not affect the operation of the tool. It merely changes the appearance of the windows. When you select Window Style, the menu in Figure 10-1 displays.

A check mark appears next to the selected style. The style is stored in the HVAC PRO software initialization file, and is used as the default style in subsequent configurations. Select Standard or Chiseled according to your preference. Examples of both window styles are illustrated in Figure 10-2.

Figure 10-1: Window Style Menu
Figure 10-2: Window Style Examples
Viewing Available VMA Screens

Use the View menu to choose among available screen views for VMA1400 Series applications. The views determine the number of points displayed on the screen and how they are grouped. When you select View, a drop-down menu of the available views displays (such as Configuration, Commissioning, Test and Balance, Diagnostic). A check mark appears next to the current view.

Note: Refer to the Variable Air Volume Modular Assembly (VMA) 1400 Series Application Note (LIT-6375125), the Attributes and Parameters section, for a list of parameters in each view.

The View menu item is available only for applications that are supported by VMA1400 Series devices, and is enabled only during Configuration mode. The application view cannot be changed during Commission mode.
Procedure Overview

Table 10-1: Setting HVAC PRO Options

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the FILES Path</td>
<td>On the File menu, click Set FILES Path. Type in the drive and directory or use the list of directories to browse and select a location.</td>
</tr>
<tr>
<td>Set Job Information</td>
<td>On the Options menu, click Job Information. Click on the field you wish to change and make the desired changes.</td>
</tr>
<tr>
<td>Generate a DDL on Save</td>
<td>On the Options menu, verify that Generate DDL on Save is marked with a check mark. If no check mark appears, select Generate DDL on Save in order to activate this command.</td>
</tr>
<tr>
<td>Generate a PRN on Save</td>
<td>On the Options menu, verify that Generate PRN on Save is marked with a check mark. If no check mark appears, select Generate PRN on Save in order to activate this command.</td>
</tr>
<tr>
<td>Activate Parameter Prompting</td>
<td>On the Options menu, verify that Parameter Prompting is marked with a check mark. If no check mark appears, select Parameter Prompting in order to activate this command.</td>
</tr>
<tr>
<td>Change Window Style</td>
<td>On the Options menu, click Window Style. Select either Standard or Chiseled from the submenu.</td>
</tr>
<tr>
<td>Change VMA Screens</td>
<td>On the Options menu, click View. Select a view from the list of available views.</td>
</tr>
</tbody>
</table>
**Detailed Procedures**

**Setting the FILES Path**

To set the FILES path:

1. On the File menu, click Set FILES Path. The Set FILES Path dialog box appears (Figure 10-3).

![Set FILES Path Dialog Box](image)

**Figure 10-3: Set Files Path Dialog Box**

2. Type in the drive and directory or use the list of directories to browse and select a location.

Note: If the directory does not exist, HVAC PRO software asks you if you want to create the directory. HVAC PRO software only creates the highest level directory and generates an error if the lower level directories in a path do not exist or are invalid.
Setting Job Information

To set job information:

1. On the Options menu, click Job Information. The Job Information window appears (Figure 10-4).

![Figure 10-4: Job Information Window](JOBINFO)
2. Click on the field you wish to change. Make changes in accordance with the field descriptions in Table 10-2.

### Table 10-2: Job Information Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator Name</td>
<td>Type in your name. Use up to 24 characters and/or spaces. The operator name appears in printed files.</td>
</tr>
<tr>
<td>Job Name</td>
<td>Type in the job name. Use up to 24 characters and/or spaces. The job name appears in printed files.</td>
</tr>
<tr>
<td>Contract Number</td>
<td>Type in the contract number. Use up to 24 characters and/or spaces. The contract number appears in printed files.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Select electric power line frequency 50 Hz or 60 Hz.</td>
</tr>
<tr>
<td>Units</td>
<td>Select English (degrees F) or Metric (degrees C). Change units at any point during the configuration process for non-VMA applications. HVAC PRO software contains both English and Metric default values. The program automatically converts all current values when you change the units. For VMA1400 Series applications, set the default units before creating the configuration. The units cannot be changed for an existing VMA configuration (conversions between English and Metric are not supported).</td>
</tr>
<tr>
<td>Previous File</td>
<td>Up to 10 lines of history are stored with the configuration file. The oldest history is dropped when additional lines are entered. Delete a previous history entry by highlighting the entry and clicking the Remove button. The history entry is permanently removed from the configuration when you select OK to close the dialog box.</td>
</tr>
<tr>
<td>History</td>
<td>Add one line of information to be stored in the configuration file.</td>
</tr>
</tbody>
</table>

### Generating a DDL on Save

To generate a DDL on save:

On the Options menu, verify that Generate DDL on Save is marked with a check mark. If no check mark appears, select Generate DDL on Save in order to activate this command.

### Generating a PRN on Save

To generate a PRN on save:

On the Options menu, verify that Generate PRN on Save is marked with a check mark. If no check mark appears, select Generate PRN on Save in order to activate this command.

### Activating Parameter Prompting

To activate parameter prompting:

On the Options menu, verify that Parameter Prompting is marked with a check mark. If no check mark appears, select Parameter Prompting in order to activate this command.
Changing Window Style

To change window styles:
1. On the Options menu, click Window Style.
2. Select either Standard or Chiseled from the submenu.

Changing VMA Screens

To change VMA screens:
1. On the Options menu, click View.
2. Select a view from the list of available views.
Chapter 11

Using Sideloops

Introduction

The Sideloops list box, accessed by clicking the Sideloop button, provides the means to define new sideloops and view and modify existing sideloops.

This chapter describes how to:

• define a new sideloop
• select a predefined hardware point
• define an unused point or modify a predefined point
• define or modify multiple AIs
• change the sideloop name
• change sideloop inputs, outputs, or parameters
• change answers in the sideloop Question/Answer (Q/A) path
Key Concepts

Sideloop List Box

Note: User-defined sideloops are not supported in a TC-9100 controller or a VMA1400 Series device. See the Variable Air Volume Modular Assembly (VMA) 1400 Series Application Note (LIT-6375125) for a list of the application-defined sideloops (separate control loops) available for VMA devices through the application Question/Answer session.

Select Sideloop to define a new sideloop, or to view or modify an existing sideloop.

![Figure 11-1: Sideloop List Box](image-url)
Sideloop View and Modify Dialog Box

You can view and modify current sideloop paths, inputs and outputs, and parameters from the Sideloop View and Modify dialog box (Figure 11-2).

Figure 11-2: Sideloop View and Modify Dialog Box
Procedure Overview

Table 11-1: Using Sideloops

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define a New Sideloop</td>
<td>Display the Sideloop list box by selecting the Sideloop button. Double-click on an unused sideloop. Enter the name of the sideloop and click OK. Proceed through the Question/Answer session as you would for a new configuration.</td>
</tr>
<tr>
<td>Select a Predefined Hardware Point</td>
<td>Click on the point you want to select. Click OK.</td>
</tr>
<tr>
<td>Define an Unused Point or Modify a Predefined Point</td>
<td>Double-click on the point you want to define or modify. Enter information or make changes in the appropriate fields and click OK to return to the main definition screen. Click OK.</td>
</tr>
<tr>
<td>Define or Modify Multiple Al's</td>
<td>Double-click on the point you want to define or modify. Enter information or make changes in the appropriate fields and click OK to return to the main definition screen. Repeat this procedure for all the points you want to define or modify. Click once on each of the points you would like to use in the sideloop. When you finish selecting all the points you want to use, click OK.</td>
</tr>
<tr>
<td>Change the Sideloop Name</td>
<td>Click on the sideloop name. Type in a new name. Click OK.</td>
</tr>
<tr>
<td>Change Sideloop Inputs, Outputs, or Parameters</td>
<td>Use the display buttons to select the appropriate list box by clicking the display button. Double-click on the point you want to modify.</td>
</tr>
<tr>
<td>Change Answers in the Sideloop Question/Answer Path</td>
<td>Select the Q/A list box by clicking the display button. Double-click on the question you want to change. Re-answer all the rest of the questions.</td>
</tr>
</tbody>
</table>
**Detailed Procedures**

**Defining a New Sideloop**

Note: Prior to defining sideloops, a configuration path must be chosen. If this controller is used as a Point Multiplexer, then Generic Input/Output would be the path to use.

To define a new sideloop:
1. Click the Sideloop button. The Sideloop list box displays (Figure 11-1).
2. Double-click on an unused sideloop or move the focus to the unused sideloop using the arrow keys, then press Enter. The following screen displays (Figure 11-3).

3. Enter the name of the sideloop (up to 14 characters) and click OK or press Enter. HVAC PRO software will lead you into a Question/Answer session much like the one used for new configurations. The screens are similar to the one shown in Figure 11-4.

![Figure 11-3: Sideloop Name Dialog Box](image)

![Figure 11-4: Sideloop Question/Answer Dialog Box](image)
If you want to change an answer while still defining the sideloop, pressing the Esc key steps you back through the previously answered questions. However, you have to re-answer all questions from that point forward. See Appendix A: Sideloop Applications Application Note (LIT-6375160) for detailed information on the sideloop question answer path.

**Selecting a Predefined Hardware Point**

Some questions in the sideloop question answer paths require you to select or define one or more hardware points. After answering these questions, HVAC PRO software displays a dialog box like the one in Figure 11-5 to prompt you to select/define the points you want.

![Input AI Definition](image)

**Figure 11-5: Selecting/Defining Hardware Points Dialog Box**

To select a predefined hardware point:

1. Click on the point you want to select. If this point can be used in a sideloop, the OK button enables. Otherwise it appears dimmed.
2. Click the enabled OK button.
Defining an Unused Point or Modifying a Predefined Point

To define an unused point or modify a predefined point:

1. Double-click on the point you want to define or modify. The appropriate I/O modify box displays.
2. Enter information or make changes in the appropriate fields and click OK to return to the main definition screen.
3. If this point can be used in a sideloop, the OK button enables. Otherwise it is unavailable. Click the enabled OK button.

Defining or Modifying Multiple AIs

To define or modify multiple AIs:

1. Double-click on the point you want to define or modify, or click once and press Enter. The appropriate I/O modify box displays.
2. Enter information or make changes in the appropriate fields and click OK to return to the main definition screen.
3. Repeat this procedure for all the points you want to define or modify.
4. Click once on each of the points you would like to use in the sideloop. If all these points can be used in a sideloop, the OK button enables. Otherwise it appears dimmed.
5. When you finish selecting all the points you want to use, click the enabled OK button.

Note: Hardware points are usually defined individually, except for the following cases:

- **Momentary BOs** are always assigned in pairs. When you define the first BO, HVAC PRO software generates a second BO with the same attributes. The first BO has “ON” appended to its name; the second BO, “OFF.”

- **Incremental BOs** are assigned in the same way as momentary BOs, except that the first BO has “-1” appended to its name; the second BO, “-2.”

- **Staged BOs** are also assigned in the same way as momentary BOs. Depending on how many stages were selected in the Question/Answer session, there can be up to ten staged BOs. Each BO has “-x” appended to its name, where x = the stage number.

When you are finished with the Question/Answer session, the list box displays your defined sideloop name, along with another unused sideloop.
Changing the Sideloop Name

To change the sideloop name:
1. Double-click on the sideloop in the Sideloop list box. The Sideloop View and Modify dialog box appears (Figure 11-2).
2. Click on the sideloop name.
3. Type in a new name (up to 14 characters).
4. Click OK.

Changing Sideloop Inputs, Outputs, or Parameters

To modify a sideloop input, output, or parameter:
1. Use the display buttons to select the appropriate list box by clicking the display button.
2. Double-click on the point you want to modify. The point or parameter modification dialog box for that point appears.

Changing Answers in the Sideloop Question/Answer Path

To modify the sideloop Question/Answer path:
1. Select the Q/A list box by clicking the display button.
2. Double-click on the question you want to change.
3. The Question/Answer session begins again. Re-answer all the rest of the questions in order to make the change take effect.
Chapter 12

Using a Template File for Commissioning

Introduction

A template file performs a function similar to a configuration file, allowing the user to commission a controller.

This chapter describes how to:

• open a template file
• display the Template Point dialog box
• commission a controller using a template file
• use data graphing
Key Concepts

Template Files

A template file performs a function similar to an HVAC PRO configuration file. The template file determines which controller points and parameters are displayed in the HVAC PRO list boxes.

Note: In this section of this document, ASCs represent UNT, VAV, AHU, and PHX controllers. System 9100 controllers represent DX-9100 and TC-9100 controllers.

Template commissioning does not apply to VMAs.

You must use a template file to commission a DX-9100 controller; however, a template file can also be used to commission other controllers, such as the UNT, VAV, AHU, PHX, and TC-9100.

You cannot use a configuration file to commission a DX-9100 controller, even though configuration files are used to commission UNT, VAV, AHU, PHX, and TC-9100 controllers.

A template file has an extension of .ddl or .dmo, whereas a configuration file has an extension of .cfg.

VMA does not support template commissioning.

Similarities between Configuration and Template Files

Many of the same features available with a configuration file are also available with a template file. They include:

- commissioning a controller (except NDM)
- monitoring a control loop
- logging real-time control loop data to a file
- viewing and/or modifying AI offsets for ASC devices
- saving overrides to a controller for ASC devices
- overriding points
- changing decimal precision for displaying values during commissioning
Differences between Using a Configuration File and a Template File

Some features available with a configuration file are not available with a template file, or their functionality is slightly different. They include:

- A template file cannot be used for loop tuning.
- A template file cannot be created, modified, or saved using HVAC PRO software.
- Point attributes, such as the AI sensor type or BO Min-On/Min-Off times, cannot be changed or viewed with a template file.
- A template file cannot print from HVAC PRO software.
- Template files are not downloaded.

Template Point Information

You can display the Template Point dialog box for an item in the Inputs, Outputs, or Parameters list box. The Template Point dialog box shows the point’s item name (hardware reference), long name, short name, and display units. In addition, floating point values include the decimal precision used for displaying the point values. The decimal precision can be changed to a value of 0 to 3.

Controller Commissioning Using a Template

It is possible to commission a controller using a template file. For more information and details on specifying the communications parameters, refer to the Commissioning a Controller (LIT-63750406) chapter, the Commissioning a Controller Using the Current Configuration procedure.

Commissioning a controller allows you to override, adjust, and release points using HVAC PRO software. Gathering information about a device, and monitoring control loops or data points is also possible in Commission mode. The Device Type and Application listed at the bottom of the HVAC PRO screen will be updated to show the target device and application for the configuration in the controller.
Overriding, Adjusting, and Releasing Points

During Commission mode, use the Override/Release dialog box to:

- override or adjust hardware points, software points, and constants
- release hardware or software point overrides
- display point status information
- display template point information

Table 12-1: Override/Release Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override</td>
<td>Select Override to override the point with the new value you have selected.</td>
</tr>
<tr>
<td></td>
<td>Note: If a point is not eligible for overriding, the override button appears dimmed and the message This Point Cannot be Overridden displays.</td>
</tr>
<tr>
<td>Release</td>
<td>Select Release to release the parameter override.</td>
</tr>
<tr>
<td>ASC Controllers (AHU, UNT, VAV, PHX)</td>
<td>With an ASC controller, you can override most hardware points, and all read/write parameters.</td>
</tr>
<tr>
<td></td>
<td>Note: When you exit Commission mode with an ASC controller, you are prompted to save parameter overrides to the controller (written to EEPROM).</td>
</tr>
<tr>
<td>TC-9100 Controllers</td>
<td>You may override hardware outputs and change the operating mode of the controller.</td>
</tr>
<tr>
<td></td>
<td>Modifications to other parameters are permanent changes written directly to the controller’s EEPROM.</td>
</tr>
<tr>
<td></td>
<td>Overrides are indicated by an asterisk (*) next to the point name. Changes that are written to the EEPROM are not overrides and are not marked with an asterisk.</td>
</tr>
<tr>
<td></td>
<td>Note: When you exit Commission mode, all overrides (marked with an asterisk) are released.</td>
</tr>
<tr>
<td>DX-9100 Controllers</td>
<td>You may override hardware outputs (AOn, DOn) and Programmable Module analog and logical outputs (PMnOUn, PMnDOOn).</td>
</tr>
<tr>
<td></td>
<td>Modifications to analog constants (ACOn), digital input (DI) pulse counts (CNTn), logic constants (DCOn), and Programmable Module accumulators (PMnACn) are permanent changes written directly to the controller’s Random Access Memory (RAM) memory.</td>
</tr>
<tr>
<td></td>
<td>Modifications to Programmable Module constants (such as PM1K1) are permanent changes written directly to the controller’s EEPROM memory.</td>
</tr>
<tr>
<td></td>
<td>Overrides are indicated by an asterisk (*) next to the point name. Permanent changes are not marked with an asterisk.</td>
</tr>
<tr>
<td></td>
<td>Note: When you exit Commission mode, all overrides (marked with an asterisk) are released.</td>
</tr>
</tbody>
</table>
Decimal Precision and Updating Point Values

During Commission mode, values on the screen are updated when they have been changed by the selected precision. If the screen seems to be updating too frequently, you may have the decimal precision too high for some of the displayed values. Base the precision for displaying a value on the precision with which the value can be read or calculated, and on the speed at which the value changes. For instance, you will probably want to display airflow with a precision of 0, temperatures with a precision of 1.

Monitoring and Graphing Controller Data Using a Template File

HVAC PRO software provides a feature for monitoring a set of data points during Commission mode. The data is displayed on a set of real-time graphs, and may be saved in a log file for import into a spreadsheet program for later analysis or printing.

This Data Graphing feature is available when you are in Commission mode with a template file and is initiated by selecting Data Graphing from the Commission menu. Data Graphing allows you to graph up to three analog values in real-time mode. This feature is not associated with loop tuning.

The Point Selection dialog box lists all available analog points that can be selected for either of the graphing screen’s two data graphs. You may select up to two points for the first graph and one point for the second graph.

You can log the graphing data collected during the monitoring process to a file. The default file name is the template file name with the extension.dat. You may specify a different file name using up to eight characters plus an extension. If the file already exists, you will be warned and given an opportunity to enter a new name. If you leave the file name field blank, the data will not be logged to a file.

Note: When this feature creates a log file, the file size increases at a rate of approximately 2 KB/min.

As a set of data points is being monitored, HVAC PRO software retains the data gathered from the controller. The file includes the loop name, point names, tuning parameters, and elapsed time. The data is tab-delimited and suitable for importing into a spreadsheet for further analysis of the system or printing.
The Data Graphing screen is displayed after you have selected the data points to monitor on the Data Graphing - Point Selection dialog box. The graphing screen includes two real-time graphs for displaying up to three analog points. The screen also includes a button for exiting the graphing screen.

The upper graph on the graphing screen shows the real-time data for the first and second points while the lower graph shows the real-time data for the third point. The names and current values for the points are displayed in the legends at the top of the graphs. As the data reaches the rightmost limit of a graph, the graph scrolls to keep the most current data in view.

Attributes of the X- and Y-axes on the graphing screen can be modified. See the Using Loop Tuning for ASC Devices (LIT-63750414) chapter in this document for more details.
Creating and Customizing a Template File

Template files specify the points to be displayed in the Inputs, Outputs, and Parameters list boxes on the main HVAC PRO screen. A template file can be used to commission any controller of the type specified in the template file (e.g., DX9100).

Template files may have the extension .DMO or .DDL and must use CS Model DDL syntax. Template files may be created manually or automatically with a software tool such as the GX-9100 (creates .dmo files for DX-9100). Template files may be customized by removing unneeded points, adding display units or point long names (24 characters), and by grouping points to be displayed in the Parameters list box.

Any CS Model DDL file can be used as a template file. If you wish to create a new template file or modify an existing file, you must use the Template File syntax specified in the Template File Syntax, Layout, and Examples section. Information is also available in the Help file.

The information includes an abbreviated listing of DDL syntax and special template rules sufficient for constructing a template file.

Note: Although the minimum template file syntax is sufficient for creating a template file, certain elements required by the DDL compiler will be missing, and thus the file may not be usable as a CS Model in a Metasys system.

Unneeded Points

You can remove an unneeded point from a template file either by deleting it from the file or by preceding its code line with two asterisks (**).

Display Units

You can add or modify the display units for points using up to six characters. Analog points have a single entry for display units while binary/digital points have two entries: open units and closed units.

24-Character Display Name

The Template Program will use the 8-character point descriptor as the display name for a point unless you specify a 24-character name using the LONGNAME keyword.
Grouping Points in the Parameters List Box

Points are grouped in the Parameters list box by parameter group name. The CS model name is used as the default group name for each set of parameters. However, you can change group names, rearrange parameter grouping, or add new groups using the PARMGROUP keyword. Note that AIs and AOs may be displayed in the parameters group simply by replacing the CSAI or CSAO keyword with the CSAD or CSSP keyword.
**Procedure Overview**

**Table 12-2: Using a Template File for Commissioning**

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open a Template File</strong></td>
<td>On the File menu, click Open. In the File Open dialog box, drop down the list box titled List Files of Type and select the second choice, Templates (*.ddl, *.dmo). Select the file from the displayed list of files and directories. Double-click on the desired file.</td>
</tr>
<tr>
<td><strong>Display the Template Point Dialog Box</strong></td>
<td>Double-click on a point in its list box.</td>
</tr>
<tr>
<td><strong>Commission a Controller Using a Template File</strong></td>
<td>Open a template file. Select Current Configuration from the Commission menu. Double-click on an item in the Inputs, Outputs, or Parameters list box, or highlight an item and press Enter.</td>
</tr>
<tr>
<td><strong>Use Data Graphing</strong></td>
<td>On the Commission menu, click Data Graphing. To add points to the Graph 1 or Graph 2 point list, click on a point in the Points To Graph list. Click on the Add button for the graph’s point list. To log data to a file, enter a file name in the edit field labeled Log Data to. Click OK. Click Exit to exit the graphing feature.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Opening a Template File

To open a template file:

1. On the File menu, click Open. If you are not currently creating a configuration, the File Open dialog box displays (Figure 12-2).

2. In the File Open dialog box, drop down the list box titled List Files of Type and select the second choice, Templates (*.dmo, *.ddl).

3. Select the file from the displayed list of files and directories.


Note: Pressing Alt + the underlined character in the list box title moves the focus to the appropriate list box. For example, pressing Alt + D moves the focus to the Directories list box.

When you open a template file, HVAC PRO software builds the point lists for the Inputs, Outputs, and Parameter list boxes. Template files must use the syntax outlined in the Template File Syntax, Layout, and Examples section, and all points must have unique hardware reference names and display names. Any errors that are found when the file is opened are logged to an error file named FILENAME.ERR in the current directory for file access.

When HVAC PRO software has finished processing the template file, you will be prompted to view the error log if any errors were found.
Displaying the Template Point Dialog Box

To display the Template Point dialog box:

1. Double-click on a point in its list box. In Standard mode, the Template Point dialog box displays (Figure 12-3).

Note: In Commission mode, the Override dialog box displays. Select Point Attributes to display the Template Point dialog box.

![Template Point Dialog Box](image)

**Figure 12-3: Template Point Dialog Box**

2. Click on the arrow to the right of the precision field to open the list and click on the desired value to change the decimal precision.

Commissioning a Controller Using a Template File

To commission a controller using a template file:

1. Open a template file as described in the procedure *Opening a Template File*.

2. Select Current Configuration from the Commission menu. This initiates Commission mode. A dialog box similar to the one in Figure 12-4 appears.
Figure 12-4: Commission Mode Window

3. Double-click on an item in the Inputs, Outputs, or Parameters list box, or highlight an item and press Enter. The Commissioning Override/Release dialog box will appear with the focus set on the item’s current value (Figure 12-5).

Figure 12-5: Override/Release Dialog Box
4. Click the Point Status button to view status information for the current point, for instance whether the point is overridden, normal, or unreliable.

5. Click the Point Attributes button to bring up the Template Point dialog box, as described in the Template Point Information topic in the Key Concepts section of this chapter.

Using Data Graphing

To use data graphing:

1. On the Commission menu, click Data Graphing. The Point Selection dialog box displays (Figure 12-6).

2. Click on a point in the Points To Graph list to add points to the Graph 1 or Graph 2 point list.

3. Click on the Add button for the graph’s point list.

4. Enter a file name in the box labeled Log Data to.

Figure 12-6: Data Graphing - Point Selection Dialog Box
The default file name is the template file name with the extension .DAT. You may specify a different file name using up to eight characters plus an extension. If the file already exists, you will be warned and given an opportunity to enter a new name.

Note: If you leave the file name field blank, the data will not be logged to a file.

5. Click OK to begin graphing.

Note: You can view, override, or release points on the main commission window while the graphing screen is displayed. Simply minimize the graphing window and click on the commission window to make it active.

6. Click on the Exit button to exit the Graphing feature.
Template File Syntax, Layout, and Examples

Template File Syntax

HVAC PRO software recognizes files with the extension .dmo or .ddl as template files. In general, template files must follow CS Model DDL syntax rules. However, only a subset of the CS Model DDL syntax is actually validated by HVAC PRO software. In addition, template files may use special template file keywords within comment lines to specify certain information not available to a DDL Compiler.

If a template file follows all CS Model DDL semantic rules, it may be used as a part of the CS Model DDL for a Metasys system (not applicable for Companion/Facilitator systems). If you wish to use a template file for this purpose, see your DDL Programmer’s Manual for a complete listing of CS Model DDL syntax.

Syntax Rules

The template file is governed by explicit language syntax. This section discusses the general rules, usage, and format of the language.

Table 12-3: Syntax Rules

<table>
<thead>
<tr>
<th>Syntax Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment Lines</td>
<td>A comment line is designated by an asterisk (*) as the first non-blank character of the line.</td>
</tr>
<tr>
<td>Blank Lines</td>
<td>A blank line is a line in the source file with no characters other than blanks. HVAC PRO software ignores all blank lines.</td>
</tr>
<tr>
<td>Keywords</td>
<td>HVAC PRO software recognizes three types of keywords within a template file: the CSMODEL keyword, hardware reference keywords, and special template keywords. The CSMODEL keyword and the hardware reference keywords are also recognized by the DDL Compiler. Special template keywords must be embedded in comment lines so that they are ignored by the DDL Compiler.</td>
</tr>
<tr>
<td>Keyword Parameters</td>
<td>The keyword parameter data is the information actually stored; the information it accepts is configured by its type (for example, Boolean or character string). Valid keyword parameters appear after a keyword and are separated from the keyword by one or more spaces. Commas separate the keyword parameter fields. Each keyword parameter has a specific data type. The parameter types are:</td>
</tr>
<tr>
<td>Boolean</td>
<td>Y/N (Y = Yes, N = No)</td>
</tr>
<tr>
<td></td>
<td>Example: N</td>
</tr>
<tr>
<td>chars(n)</td>
<td>A character string that can contain up to “n” characters. Enclose all character strings in double quotation marks (“”), but do not use double quotation marks as part of the character string.</td>
</tr>
<tr>
<td></td>
<td>Example: “RoomTemp”</td>
</tr>
<tr>
<td>byte</td>
<td>A numerical value of 0-255</td>
</tr>
<tr>
<td></td>
<td>Example: 1</td>
</tr>
</tbody>
</table>
Description of Keywords

The three types of keywords used by a template file are:

- CSMODEL keyword
- hardware reference keywords
- special template keywords

Each type of keyword, including syntax and examples, is described in the following sections.

CSMODEL Keyword

The CSMODEL keyword is used to indicate the start of a new model definition. The parameters of the CSMODEL keyword are the model name and the hardware type. A template file must contain at least one CSMODEL keyword before any hardware reference or special template keywords are listed. Multiple CSMODEL keyword lines are allowed.

The model name must be unique and is used as the parameter group name for all CSAD, CSSP, and CSBD points listed below it until another CSMODEL keyword is encountered or the group name is changed using the PARMGROUP keyword (see Special Template Keywords in this section).

The hardware type (for example, “DX9100” or “VAV”) must exist as a hardware model in the hardware model database.

If a CSMODEL keyword is preceded by a single asterisk, all comment lines are ignored until another uncommented CSMODEL keyword is encountered. This includes lines containing hardware reference keywords and special template keywords. All non-commented lines are processed as usual and associated with the last non-commented CSMODEL keyword. This feature is useful for temporarily removing a CS model from a template.

The syntax for a CSMODEL keyword line is shown in Table 12-4:

Table 12-4: CSMODEL Keyword Line

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>CSMODEL</td>
</tr>
<tr>
<td>Model Name</td>
<td>char(8)</td>
</tr>
<tr>
<td>Hardware Type</td>
<td>char(8)</td>
</tr>
</tbody>
</table>
CSMODEL Example:

CSMODEL "HTG PID","DX9100"

Keyword:         CSMODEL
Model Name:      "HTG PID"
Hardware Type:   "DX9100"

Hardware Reference Keywords

HVAC PRO software recognizes the following hardware reference
keywords: CSAI, CSAO, CSBI, CSBO, CSAD, CSBD, CSSP, and
CSMS. The parameters for a hardware reference keyword are the
hardware reference, override flag, adjust flag, point descriptor, and
units.

The hardware reference must be valid for the hardware model and
must be of the controller point type specified in Table 12-5.

Table 12-5: Hardware Reference Keywords and Controller
Point Types

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Allowed Controller Point Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAI</td>
<td>Analog Input (AI)</td>
</tr>
<tr>
<td>CSAO</td>
<td>Analog Output (AO)</td>
</tr>
<tr>
<td>CSBI</td>
<td>Binary/Digital Input (BI, DI)</td>
</tr>
<tr>
<td>CSBO</td>
<td>Binary/Digital Output (BO, DO)</td>
</tr>
<tr>
<td>CSAD</td>
<td>Any floating point or integer parameter (including constants and accumulators) or any analog hardware point (AI, AO)</td>
</tr>
<tr>
<td>CSBD</td>
<td>Any byte parameter (including constants and status flags) or binary/digital hardware point (BI, BO, DI, DO)</td>
</tr>
<tr>
<td>CSSP</td>
<td>Same as CSAD</td>
</tr>
<tr>
<td>CSMS</td>
<td>Multistate byte parameters</td>
</tr>
</tbody>
</table>

The hardware reference is used to extract point information from the
hardware model’s database file. The override and adjust flags are
ignored by HVAC PRO software, which uses the database
information. The point descriptor is used as the short name for the
point, and is also used as the long name if an alternate name was not
specified using the LONGNAME keyword (see Special Template
Keywords). The long name is used for displaying the point on the
HVAC PRO screen. The units are used for displaying the point value
on the HVAC PRO screen. Binary points have units for open and
closed.
HVAC PRO software has no restrictions on the number of hardware reference keywords in a template file; however, only 225 parameters (CSAD, CSBD, CSSP, and CSMS) may be displayed in the Parameters list box. Additional parameters will be ignored.

Hardware reference keywords that are preceded by a single asterisk will be processed by HVAC PRO software as if the asterisk did not exist. This allows a template file to compile under the DDL Compiler without restricting the number of allowed hardware reference keywords.

Note: To comment out a line that contains a hardware reference keyword, precede the keyword with two asterisks (**).

Hardware points can be displayed in the HVAC PRO software Parameters list box by using a keyword of CSAD, CSBD, CSSP, or CSMS for the point’s hardware reference keyword. Note the restrictions on point type listed in Table 12-5. Also duplicate points are not allowed, so a hardware reference cannot be listed multiple times in a template file.

**CSAI**

The syntax for each CSAI keyword is shown in Table 12-6:

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>CSAI</td>
</tr>
<tr>
<td>Hardware Reference</td>
<td>char(8)</td>
</tr>
<tr>
<td>Override Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Adjust Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Descriptor</td>
<td>char(8)</td>
</tr>
<tr>
<td>Units</td>
<td>char(6)</td>
</tr>
</tbody>
</table>

**CSAI Example**

```
CSAI "AI1",N,N,"RmTemp","Deg C"
```

Keyword: CSAI
Hardware Reference: "AI1"
Override Flag: N
Adjust Flag: N
AI Descriptor: "RmTemp"
AI Units: "Deg C"
**CSAO**

The syntax for each CSAO keyword is shown in Table 12-7:

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>CSAO</td>
</tr>
<tr>
<td>Hardware Reference</td>
<td>char(8)</td>
</tr>
<tr>
<td>Override Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Adjust Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Descriptor</td>
<td>char(8)</td>
</tr>
<tr>
<td>Units</td>
<td>char(6)</td>
</tr>
</tbody>
</table>

**CSAO Example**

CSAO "OUT1",N,N,"HeatCmd","%"

- **Keyword**: CSAO
- **Hardware Reference**: "OUT1"
- **Override Flag**: N
- **Adjust Flag**: N
- **AO Descriptor**: "HeatCmd"
- **AO Units**: "%"

**CSBI**

The syntax for each CSBI keyword is shown in Table 12-8:

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>CSBI</td>
</tr>
<tr>
<td>Hardware Reference</td>
<td>char(8)</td>
</tr>
<tr>
<td>Override Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Adjust Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Descriptor</td>
<td>char(8)</td>
</tr>
<tr>
<td>Units (Open)</td>
<td>char(6)</td>
</tr>
<tr>
<td>Units (Closed)</td>
<td>char(6)</td>
</tr>
</tbody>
</table>
CSBI Example

CSBI "DI1",N,N,"Airflow","OFF","ON"

Keyword: CSBI
Hardware Reference: "DI1"
Override Flag: N
Adjust Flag: N
BI Descriptor: "Airflow"
BI Units - Open: "OFF"
BI Units - Closed: "ON"

CSBO

The syntax for each CSBO keyword is shown in Table 12-9:

Table 12-9: CSBO Keyword

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>CSBO</td>
</tr>
<tr>
<td>Hardware Reference</td>
<td>char(8)</td>
</tr>
<tr>
<td>Override Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Adjust Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Descriptor</td>
<td>char(8)</td>
</tr>
<tr>
<td>Units (Open)</td>
<td>char(6)</td>
</tr>
<tr>
<td>Units (Closed)</td>
<td>char(6)</td>
</tr>
</tbody>
</table>

CSBO Example

CSBO "DO3",N,N,"Fan","OFF","ON"

Keyword: CSBO
Hardware Reference: "DO3"
Override Flag: N
Adjust Flag: N
BO Descriptor: "Fan"
BO Units - Open: "OFF"
BO Units - Closed: "ON"
**CSAD**

The syntax for each CSAD keyword is shown in Table 12-10:

**Table 12-10: CSAD Keyword**

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>CSAD</td>
</tr>
<tr>
<td>Hardware Reference</td>
<td>char(8)</td>
</tr>
<tr>
<td>Override Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Adjust Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Descriptor</td>
<td>char(8)</td>
</tr>
<tr>
<td>Units</td>
<td>char(6)</td>
</tr>
</tbody>
</table>

**CSAD Example**

CSAD "PM1K2",N,N,"ClgPB","Deg C"

Keyword: CSAD

Hardware Reference: "PM1K2"

Override Flag: N

Adjust Flag: N

AD Descriptor: "ClgPB"

AD Units: "Deg C"

**CSBD**

The syntax for each CSBD keyword is shown in Table 12-11:

**Table 12-11: CSBD Keyword**

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>CSBD</td>
</tr>
<tr>
<td>Hardware Reference</td>
<td>char(8)</td>
</tr>
<tr>
<td>Override Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Adjust Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Descriptor</td>
<td>char(8)</td>
</tr>
<tr>
<td>Units (Open)</td>
<td>char(6)</td>
</tr>
<tr>
<td>Units (Closed)</td>
<td>char(6)</td>
</tr>
</tbody>
</table>
**CSBD Example**

CSBD "DCO1",N,N,"DCONST1","OFF","ON"

Keyword: CSBD
Hardware Reference: "DCO1"
Override Flag: N
Adjust Flag: N
BD Descriptor: "DCONST1"
BD Units - Open: "OFF"
BD Units - Closed: "ON"

**CSSP**

The syntax for each CSSP keyword is shown in Table 12-12:

**Table 12-12: CSSP Keyword**

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>CSSP</td>
</tr>
<tr>
<td>Hardware Reference</td>
<td>char(8)</td>
</tr>
<tr>
<td>Override Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Adjust Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Descriptor</td>
<td>char(8)</td>
</tr>
<tr>
<td>Units</td>
<td>char(6)</td>
</tr>
</tbody>
</table>

**CSSP Example**

CSSP "PM1K1",N,N,"LocalSP","Deg C"

Keyword: CSSP
Hardware Reference: "PM1K1"
Override Flag: N
Adjust Flag: N
SP Descriptor: "LocalSP"
SP Units: "Deg C"
**CSMS**

The syntax for each CSMS keyword is shown in Table 12-13:

**Table 12-13: CSMS Keyword**

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>CSMS</td>
</tr>
<tr>
<td>Hardware Reference</td>
<td>char(8)</td>
</tr>
<tr>
<td>Override Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>Adjust Flag</td>
<td>Boolean</td>
</tr>
<tr>
<td>MS Descriptor</td>
<td>char(8)</td>
</tr>
<tr>
<td>MS State 1 Text</td>
<td>char(6)</td>
</tr>
<tr>
<td>MS State 1 Value</td>
<td>byte (0-255)</td>
</tr>
<tr>
<td>MS State 2 Text</td>
<td>char(6)</td>
</tr>
<tr>
<td>MS State 2 Value</td>
<td>byte (0-255)</td>
</tr>
<tr>
<td>MS State 3 Text</td>
<td>char(6)</td>
</tr>
<tr>
<td>MS State 3 Value</td>
<td>byte (0-255)</td>
</tr>
<tr>
<td>MS State 4 Text</td>
<td>char(6)</td>
</tr>
<tr>
<td>MS State 4 Value</td>
<td>byte (0-255)</td>
</tr>
</tbody>
</table>

**CSMS Example**

CSMS
"MODC",Y,Y,“SupvReq”,“Night”,0,“Stndby”,1,“Cmfort”,2,“Off”,3

Keyword: CSMS
Hardware Reference: "MODC"
Override Flag: Y
Adjust Flag: Y
MS Descriptor: SupvReq
MS State 1 Text: “Night”
MS State 1 Value: 0
MS State 2 Text: “Stnby”
MS State 2 Value: 1
MS State 3 Text: “Cmfort”
MS State 3 Value: 2
MS State 4 Text: “Off”
MS State 4 Value: 3
Special Template Keywords

The special template keywords LONGNAME and PARMGROUP are used to provide information that is not available using standard CS Model DDL syntax. Special template keywords must be preceded by a single asterisk to be processed by HVAC PRO software. The single parameter for the LONGNAME keyword is the point long name. The single parameter for the PARMGROUP is the parameter group name.

Note: To comment out a line that contains a special template keyword, precede the keyword with two asterisks (**).

LONGNAME

The LONGNAME keyword is used immediately preceding a hardware reference line to specify the long name for a hardware point or parameter. The long name is used to display the point in the Inputs, Outputs, or Parameters list box on the main HVAC PRO software.

The syntax for the LONGNAME special template keyword is shown in Table 12-14:

Table 12-14: LONGNAME Keyword

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asterisk</td>
<td>*</td>
</tr>
<tr>
<td>Keyword</td>
<td>LONGNAME</td>
</tr>
<tr>
<td>Point Long Name</td>
<td>char(24)</td>
</tr>
</tbody>
</table>

LONGNAME Example

* LONGNAME "Zone Temperature"

    Asterisk: *
    Keyword: LONGNAME
    Point Long Name: "Zone Temperature"

PARMGROUP

The PARMGROUP keyword may be placed anywhere in the template file after a CSMODEL keyword has been listed. The group name specified using the PARMGROUP keyword is used as the parameter group name for all CSAD, CSSP, and CSBD points listed below it until a new CSMODEL keyword is encountered or the group name is changed using another PARMGROUP keyword. Group names are used as headings for points in the Parameters list box on the main HVAC PRO software.
The syntax for the PARMGROUP special template keyword is shown in Table 12-15:

**Table 12-15: PARMGROUP Keyword**

<table>
<thead>
<tr>
<th>Element</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asterisk</td>
<td>*</td>
</tr>
<tr>
<td>Keyword</td>
<td>PARMGROUP</td>
</tr>
<tr>
<td>Parameter Group</td>
<td>char(24)</td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
</tbody>
</table>

**PARMGROUP Example**

* PARMGROUP "Heating Setpoints"

  Asterisk: *  
  Keyword: PARMGROUP  
  Parameter Group Name: "Heating Setpoints"
Template File Layout

The following rules govern the layout of the source lines that HVAC PRO software will accept:

- You may use any ASCII text editor, such as Windows Notepad, to create or modify source files.
- You may use .ddl or .dmo as the extension of the file name.
- A line is limited to 132 characters and is ended by a carriage return and/or line feed.
- The source input is line oriented, with each keyword beginning on a new line.
- Avoid all control characters, which are characters formed by simultaneously holding down the Control key and another key.
- The keyword must be the first non-blank item or the first item after an asterisk (*) on a line.
- The keyword must be separated from the first keyword parameter by at least one space.
- Keyword parameters are separated by commas.
- HVAC PRO software recognizes only ASCII characters. It allows no control characters.
- Blank lines and comment lines may occur anywhere in the source file.
- An asterisk (*) must begin a comment line as the first non-blank character of the line.
- Blanks are allowed anywhere on a line except within the characters of a single keyword or keyword parameter, unless the blank occurs in a string inside double quotation marks.
- Alphabetic characters are case insensitive (i.e., you can use either upper or lower case).
- Unrecognized keywords or text are ignored by HVAC PRO software.
- Do not use a double quotation mark (") as part of a character string.
Template Files for DDL Users

For users familiar with CS Model DDL syntax, the following lists the specific cases of template file syntax that differ from the syntax required by the DDL Compiler.

**Table 12-16: Differences in Syntax from DDL Compiler**

<table>
<thead>
<tr>
<th>Syntax Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Comment Lines</strong></td>
<td>The DDL Compiler ignores all comment lines. HVAC PRO software processes comment lines that start with a single asterisk followed by one of the following keywords: CSAI, CSAO, CSBI, CSBO, CSAD, CSSP, CSMS, CSBD, LONGNAME, and PARMGROUP. An exception is made if a CSMODEL keyword is preceded by a single asterisk. In this case, HVAC PRO software will ignore all comment lines until it finds an uncommented CSMODEL keyword.</td>
</tr>
<tr>
<td><strong>Keywords</strong> (General)</td>
<td>The DDL Compiler limits the hardware reference keywords per CSMODEL keyword as follows: 16 each of CSAI, CSAO, CSBI, and CSBO; 32 each of CSAD, CSSP, and CSBD; 2 of CSMS. HVAC PRO software has no restrictions on the number of hardware reference keywords in a template file; however, only 225 parameters (CSAD, CSBD, CSSP, and CSMS) may be displayed in the Parameters list box. Additional parameters will be ignored. The following CS Model keywords are used by the DDL compiler but are ignored by HVAC PRO software (no template errors will be generated if the keywords are not found): @MODEL, AITITLE, AOTITLE, ADTITLE, BITITLE, BOTITLE, SPTITLE, BDTITLE, MSTITLE.</td>
</tr>
<tr>
<td><strong>Hardware Reference Keywords</strong></td>
<td>The DDL Compiler processes override and adjust flags. HVAC PRO software ignores these flags (points are set to commandable based on database information). HVAC PRO software is more restrictive than the DDL Compiler on the controller point types allowed for each hardware reference keyword.</td>
</tr>
<tr>
<td><strong>Other Notes</strong></td>
<td>The DDL Compiler will generate an error if it finds a line with an unrecognized keyword. HVAC PRO software ignores all such lines. Continuation characters are supported by the DDL Compiler but are not supported by HVAC PRO software.</td>
</tr>
</tbody>
</table>
Template File Examples

Create a template file using any ASCII text editor, or use the CS model DDL file generated by HVAC PRO software (*.ddl, for AHU, UNT, TC-9100, VAV, and PHX controllers) or GX-9100 (*.dmo, for DX-9100 controllers). You are not required to make any modifications to a CS Model DDL file generated by a software program before the file is used as an HVAC PRO point template. However, editing a template file is simple, and adding point long names, parameter group names, and rearranging points will make the point display on the main HVAC PRO software easier to view and use during Commission mode.

The following listings show examples of template files for a DX-9100 controller and a VAV controller. The first example is a template file for a simple fan coil application in a DX-9100 controller. The template file was generated by the GX-9100 program and then customized by changing the units for several points, adding the PARMGROUP “Room Control,” and adding the CSAD “PM1OU4” to the listing.

The second listing is a template file for a simple Single Duct VAV application. The template file was originally generated by HVAC PRO software and then modified to include long names for several points, and to group points under various parameter headings. Also note that the hardware reference keywords for the pseudo AOs (VAV controllers only have two hardware AOs), AO8 Supply Setpoint (SpSetpt), and AO4 (Dmp Cmd) were changed from CSAO to CSAD. This will result in the points displayed in the Parameters list box on the main HVAC PRO software.

Figure 12-10, which follows the example template file listings, shows what the main HVAC PRO software would look like after you open the VAV template file.
**DX-9100 Template File Example**

Figure 12-7 shows an example of a DX-9100 template file.

* GX9100 Version 5.04 Model DDL Source File for
  C:\WGX9100\FANCOIL.DXS

```plaintext
@MODEL+
CSMODEL "DX9100", "DX9100"

******************** GROUP TITLES ********************
AITITLE "Analog Inputs"
AOTITLE "Analog Outputs"
ADTITLE "Analog Data"
BITITLE "Binary Inputs"
BOTITLE "Binary Outputs"
BDTITLE "Binary Data"

******************** INPUTS ********************
* LONGNAME "Room Temperature"
  CSAI "AI1",N,N,"RM-T","Deg C"
* LONGNAME "Remote Setpoint"
  CSAI "AI2",N,N,"RS","Deg C"
* LONGNAME "Occupied"
  CSBI "DI1",N,N,"OCC","UNOCC","OCC"

******************** OUTPUTS ********************
* LONGNAME "Heating Valve"
  CSAO "OUT1",N,N,"HTG-V","%"
* LONGNAME "Fan Control"
  CSBO "DO3",N,N,"FAN-C","OFF","ON"

********************** PROGRAMMABLE MODULES **********************

* MODULE PID 1
  CSMODEL "RM-C","DX9100"
  * PARMGROUP "ROOM CONTROL"
  ADTITLE "Analog Data"
  BDTITLE "Binary Data"
```
** NOTE PM1OU4 WAS ADDED FROM APPENDIX 3 OF DX-9100 CONFIGURATION GUIDE
** (NOT INCLUDED IN THE STANDARD GX-9100 DMO FILE GENERATION)
CSAD "PM1OU4",N,N,"ACT-PV","Deg C"
CSAD "PM1OU2",N,N,"PM1WSP","Deg C"
CSAD "PM1OU1",N,N,"HTG-C","%"
CSBD "PM1S11",N,N,"PM1EF","OCC","UNOCC"
CSBD "PM1S1",N,N,"PM1CML","OFF","ON"
CSAD "PM1K2",N,N,"PM1PB","Deg C"
CSAD "PM1K3",N,N,"PM1TI","Sec"

Figure 12-7: DX-9100 Template File Example
**VAV Template File Example**

Figure 12-8 and Figure 12-9 show an example of a VAV template file.

* HVAC PRO (Version 7.02) DDL Source file for c:\WINPRO\FILES\vav101.cfg

```c
@MODEL+
CSMODEL "vav101","VAV"

******** GROUP TITLES ********************************
AITITLE "Analog Inputs"
AOTITLE "Analog Outputs"
ADTITLE "Analog Data"
BITITLE "Binary Inputs"
BOTITLE "Binary Outputs"
BDTITLE "Binary Data"
SPTITLE "Setpoints"

******** ANALOG INPUTS ********************************
* LONGNAME "Zone Temperature"
CSAI "AI1",Y,N,"ZN-T","Deg F"
* LONGNAME "Supply Delta P"
CSAI "AI4",Y,N,"SUPLY-DP","In wg"

******** BINARY INPUTS ********************************
* LONGNAME "Occupied"
CSBI "BI1",Y,N,"OCC-UNOC","Unocc","Occ"

******** BINARY OUTPUTS

******** PARAMETERS

* PARMGROUP "Modes"
CSBD "BD16",N,N,"StarvBox","No","Yes"
CSBD "BD225",Y,Y,"Wrm Cmd","Off","On"
CSBD "BD22",Y,N,"Occ Stat","Unocc","Occpd"
```
CSBD "BD228",Y,Y,"Stby Cmd","Off","On"
CSBD "BD23",N,N,"ShutStat","Off","On"
CSBD "BD230",Y,Y,"Box Clse","Off","On"
CSBD "BD229",Y,Y,"Box Open","Off","On"
*
* PARMGROUP "Zone Cooling Setpoints"
CSSP "ADF21",N,N,"ActClgSP","Deg F"
CSSP "ADF132",Y,Y,"Clg PB","Deg F"
CSSP "ADF133",Y,Y,"Clg IT",""
CSSP "ADF129",Y,Y,"Occ Clg","Deg F"
*
* PARMGROUP "Zone Heating Setpoints"
CSSP "ADF20",N,N,"ActHtgSP","Deg F"
CSSP "ADF138",Y,Y,"Bx Ht PB","Deg F"
CSSP "ADF139",Y,Y,"Htg IT",""
CSSP "ADF134",Y,Y,"Occ Htg","Deg F"

Figure 12-8: VAV Template File Example, Part One
* * PARMGROUP "Occ Damper Setpoints"
CSSP "ADF144",Y,Y,"Occ CMax","CFM"
CSSP "ADF143",Y,Y,"Occ CMin","CFM"
* * PARMGROUP "Supply Damper Control"
CSSP "ADF15",N,N,"Sup Flow","CFM"
* LONGNAME "Supply Preset"
CSSP "ADF236",Y,Y,"SpPreset","CFM"
* LONGNAME "Supply Setpoint"
CSAD "AO8",Y,N,"SpSetpt","CFM"
CSSP "ADF180",Y,Y,"Sup PB","CFM"
CSSP "ADF142",Y,Y,"Sup DB","CFM"
CSSP "ADF182",Y,Y,"Sup Int",""
* LONGNAME "Supply Override"
CSBD "BD236",Y,Y,"SpFlowOv","Disabl","Enable"
* LONGNAME "Damper Command"
CSAD "AO4",Y,N,"Dmp Cmd","%"
*
* PARMGROUP "Supply Box Config"
CSSP "ADF141",Y,Y,"Dmp Tm","Minute"
CSSP "ADF158",Y,Y,"SBx Area","Sq Ft"
CSSP "ADF159",Y,Y,"SBx Mult",""
* 
* PARMGROUP "Auto Zero"
* LONGNAME "Auto Zero Enable"
CSBD "BD232",Y,Y,"AZEnable","Disabl","Enable"
* LONGNAME "Auto Zero Command"
CSBD "BD226",Y,Y,"AutoZero","Off","On"
* LONGNAME "Auto Zero Status"
CSBD "BD18",N,N,"AZ Stat","Off","On"

Figure 12-9: VAV Template File Example, Part Two
Figure 12-10: Main HVAC PRO Screen after Opening Example VAV Template File
Chapter 13

Using Loop Tuning for ASC Devices

Introduction

Use Loop Tuning to monitor and/or tune Proportional plus Integral (PI) process control loops for ASC devices.

This chapter describes how to:

• access the Loop Tuning feature
• override the PI setpoint
• modify the vertical axis
• modify the time axis
• start Pattern Recognition Adaptive Control (PRAC)
• verify process performance
• tune a sample loop with PRAC
• adjust loop tune parameters
**Key Concepts**

**Loop Tuning**

Loop Tuning is only available through the Commission menu of HVAC PRO software for ASC devices. If you are not in Commission mode, Loop Tuning appears dimmed. If you are commissioning a device other than an ASC device, Loop Tuning appears dimmed.

Use Loop Tuning to monitor and/or tune Proportional plus Integral (PI) process control loops. HVAC PRO software incorporates an automated tuning feature called Pattern Recognition Adaptive Control (PRAC). A step by step example of how to tune a loop is included in the **Detailed Procedures** section.

Since PRAC runs in a VMA1400 Series controller as part of its application, HVAC PRO Loop Tuning feature does not apply to the VMA. See the *Variable Air Volume Modular Assembly (VMA) 1400 Series Application Note (LIT-6375125)* for more information.

**Considerations Before Loop Tuning**

Refer to the following considerations before you begin the Loop Tuning process:

- PRAC will not fix mechanical problems.
- Currently, PRAC in HVAC PRO software is intended to tune loops in AHU, UNT, and VAV controllers.
- Ensure that all peripheral devices, such as pilot positioners and pneumatic transducers, are properly ranged for the actual spring range of the controlled device. Do this by overriding each AO to 0%, 25%, 50%, 75%, and 100% open (except fan control). Ensure full stroke of the actuator is accomplished when you issue the 0% and 100% commands. If this does not occur, you must recalibrate the AO and/or pilot positioner.
- PRAC requires that the configuration be read from a file. You must do one of the following:
  - Open the file and commission the current configuration.
  - Commission the configuration in the controller and, when HVAC PRO software prompts you to use a file for commissioning, select Yes.

A file can be generated by an upload, save, and download.
**WARNING:** As overrides are performed, care must be taken not to cause mechanical damage (i.e., burst duct due to static pressure too high).

- Graphing of the selected loop is provided to display loop performance before, during, and after PRAC has tuned the loop.
- Data collection during Loop Tuning can, optionally, be written to a separate file in tab-delimited format for importing into a spreadsheet for later graphing and printing. This feature provides a permanent record that the loop was tuned.
- Tune the fastest loop first to minimize tuning difficulties due to loop interaction. For example, a stable duct static pressure ensures consistent airflow across heating and cooling coils. The following table shows the recommended order of Loop Tuning.

**Table 13-1: Order of Tuning Loops**

<table>
<thead>
<tr>
<th>Order</th>
<th>Type of Loop</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Static Pressure</td>
</tr>
<tr>
<td>2</td>
<td>Volume Matching</td>
</tr>
<tr>
<td>3</td>
<td>Steam Heat</td>
</tr>
<tr>
<td>4</td>
<td>Economizer</td>
</tr>
<tr>
<td>5</td>
<td>Chilled Water/Hot Water</td>
</tr>
</tbody>
</table>

- Override other loops that may affect the loop being tuned. For example, disable mechanical cooling and override outdoor air dampers to minimum position before tuning a heating loop.
- If the PI Loop is using a calculated setpoint, it cannot be overridden directly via HVAC PRO software; however, the calculated setpoint can be set to a fixed value by overriding the AI used to calculate the setpoint.
- Due to controller design, PRAC cannot tune a loop unless the loop output is a real or pseudo analog output. PRAC can only tune the last subordinate of cascaded loops. For example, PRAC cannot tune the zone cooling loop, but can tune the flow loop in a single duct pressure independent VAV box.
- Override the deadband to zero for the loop being tuned.
Monitoring a Loop or Data Points

Monitoring a loop or data points does not perform any loop tuning. It simply displays a graphical representation of the data values. You can use Monitoring to determine whether the loop requires tuning or to manually tune the loop. To manually tune the PI loop, you can perform overrides to the loop’s Prop Band and Integration Time parameters from the Commission screen and visually watch their effect on the loop response in the graphing window.

Tuning a Loop Using PRAC

Figure 13-1 shows a block diagram on how PRAC works. When activated, PRAC collects data from the actual control loop and executes a patented adaptive control pattern recognition algorithm on the collected data. As the data is collected over time, PRAC adjusts the proportional band and integration times in the controller. As the changes are made, more computations for the tuning parameters are made until optimal control is achieved. The length of time required varies depending upon the type of loop and the amount of tuning required. Static pressure loops tune the fastest, while chilled/hot water loops take longer time for PRAC to tune.

Figure 13-1: PRAC Control Logic Block Diagram

PRAC studies the closed loop operation to characterize the HVAC process, and uses the closed loop operating response to calculate the PI control parameters.

Advantages of PRAC include:

- Does not interrupt normal operation of the HVAC process.
- System load disturbances will not affect PRAC performance.
- Can tune an unstable or sluggish loop.
PRAC Misapplications

Tune PI control of temperature or humidity in clean room or laboratory applications; however, we do not recommend tuning PI control of temperature or humidity in office space or return air applications, due to the long tuning time required.

- Do not attempt to use PRAC to tune staged outputs, such as DX cooling.
- Do not attempt to use PRAC to tune proportional-only control.
- Due to the controller design, PRAC does not tune the manager loop of cascaded loops.

Time Required for PRAC Tuning

The time PRAC needs to tune a loop depends on:

1. response time of the process (slower loops take more time)
2. how out of tune the loop is initially (how unstable AO appears)

Graphing Data File Format

HVAC PRO software automatically stores real-time data to a file when a file name has been specified. These files are not necessary unless you require a historical record. Import files into the spreadsheet program of your choice. A sample output from the data file is shown in Figure 13-2.

Note: When this feature creates a log file, the file size increases at a rate of approximately 2 KB/min.
HVAC PRO User's Guide

---

**PRAC PI LOOP TUNING**

**Jobname:** Univ Hosp Bed Tower

**Operator:** Tim Burgess

**Config:** C:\WINPRO\FILES\LAB215.CFG

**Date:** 11/27/94

**Time:** 11:16:10 AM

---

**Point Information**

**Loop Name:** SAR-ZONE Disch Air Clg

**AI Name:** Disch Air Temp

**SP Name:** Actual Disch Setpt

**AO Name:** Cooling Valve

**PB Name:** Disch Clg PBand

**IT Name:** Disch Clg Int Tm

---

**Loop Tuning Parameters**

**Sample Rate:** 5

**Full Scale Value:** 35.0

---

****** MONITOR MODE ******

<table>
<thead>
<tr>
<th>Time</th>
<th>SetPt</th>
<th>AI</th>
<th>AO</th>
<th>PB</th>
<th>IntTm</th>
</tr>
</thead>
<tbody>
<tr>
<td>11:16:19</td>
<td>64.645</td>
<td>59.405</td>
<td>0.000</td>
<td>20.000</td>
<td>60.000</td>
</tr>
<tr>
<td>11:16:21</td>
<td>64.645</td>
<td>60.719</td>
<td>0.000</td>
<td>20.000</td>
<td>60.000</td>
</tr>
<tr>
<td>11:16:22</td>
<td>64.645</td>
<td>62.076</td>
<td>0.000</td>
<td>20.000</td>
<td>60.000</td>
</tr>
<tr>
<td>11:16:24</td>
<td>64.642</td>
<td>63.369</td>
<td>0.000</td>
<td>20.000</td>
<td>60.000</td>
</tr>
<tr>
<td>11:16:25</td>
<td>64.789</td>
<td>64.626</td>
<td>0.000</td>
<td>20.000</td>
<td>60.000</td>
</tr>
<tr>
<td>11:16:27</td>
<td>64.789</td>
<td>65.872</td>
<td>3.917</td>
<td>20.000</td>
<td>60.000</td>
</tr>
<tr>
<td>11:16:28</td>
<td>64.645</td>
<td>67.087</td>
<td>10.773</td>
<td>20.000</td>
<td>60.000</td>
</tr>
<tr>
<td>11:16:30</td>
<td>64.645</td>
<td>68.265</td>
<td>16.840</td>
<td>20.000</td>
<td>60.000</td>
</tr>
<tr>
<td>11:16:32</td>
<td>64.645</td>
<td>69.458</td>
<td>23.085</td>
<td>20.000</td>
<td>60.000</td>
</tr>
</tbody>
</table>

---

**Figure 13-2: Graphing File Data Format**
## Procedure Overview

### Table 13-2: Using Loop Tuning for ASC Devices

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Access the Loop Tuning Feature</strong></td>
<td>On the Commission menu, click Loop Tuning.</td>
</tr>
<tr>
<td><strong>Override the PI Setpoint</strong></td>
<td>In the graphing screen, click the Override Setpoint button. Enter a new setpoint value, then click the Override button.</td>
</tr>
<tr>
<td><strong>Modify the Vertical Axis</strong></td>
<td>In the graphing screen, double-click on the vertical axis. Modify the entries in the dialog box and click OK.</td>
</tr>
<tr>
<td><strong>Modify the Time Axis</strong></td>
<td>In the graphing screen, double-click on the time (horizontal) axis. Modify the entries in the dialog box and click OK.</td>
</tr>
<tr>
<td><strong>Start Pattern Recognition Adaptive Control (PRAC)</strong></td>
<td>On the Monitor screen, click the Tune button.</td>
</tr>
<tr>
<td><strong>Verify Process Performance</strong></td>
<td>Introduce a setpoint change by clicking the Override Setpoint button. Enter the value according to Table 13-9 and verify the system response.</td>
</tr>
<tr>
<td><strong>Tune a Sample Loop with PRAC</strong></td>
<td>See Detailed Procedures.</td>
</tr>
<tr>
<td><strong>Adjust Loop Tune Parameters</strong></td>
<td>Use the graphing screen to monitor the desired loop. Be sure that all interacting loops have been overridden to limit their effect on the loop. Override the AO to 0% and wait until the AI value does not change (i.e., becomes stable). Record the stable AI value. Override the AO to 100%. Record the time the override took place and label it T-start. Wait until the AI value does not change (becomes stable). Record the stable time and label it T-end. Record the stable AI value. Subtract T-start from T-end and label the result T-change (in seconds). Divide T-change by 50 and enter the result in the PI Loop Tuning - PRAC dialog box as the Relative speed of the loop response. Round values up to the nearest integer. Calculate the change in Change in AI value = absolute value of AI (100%) - AI (0%). Enter the calculated value into the PI Loop Tuning - PRAC dialog box as the Change in the AI value when the AO goes from 0 to 100%. Resume PRAC tuning by selecting the Tune button.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Accessing the Loop Tuning Feature

To access Loop Tuning:

1. On the Commission menu, click Loop Tuning. The PI Loop/Points Selection dialog box appears (Figure 13-3).

![PI Loop / Point(s) Selection Dialog Box]

Figure 13-3: PI Loop/Point(s) Selection Dialog Box
2. Modify the entries in the dialog box using the information in Table 14-3 as a guide.

### Table 13-3: PI Loop/Point(s) Selection Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Available Loops and Data Points</strong></td>
<td>Contains a list of the PI loops available for tuning. If the actual setpoint name or AI name is unknown, it is listed using the generic name Setpoint Value. Likewise, when the actual AI name is unknown, it is listed as AI Value. The value of the point is displayed next to the generic name. After you select a loop from the Available Loops list, you may change the data point selections. In general, use the default data points for the AI, setpoint, AO, Prop Band, and Integration Time; however, if the setpoint or AI is unknown, you may want to select the actual name from its point list. The Available Loop list is empty for an uploaded configuration that has not been saved (Upload or Commission—Configuration in Controller). The loop information needed to create the list is generated when a configuration is saved, but not stored in the controller. If the Available Loops are desired, save the uploaded configuration prior to entering Commissioning. Otherwise, loop tuning can proceed, but you must select the specific AI, setpoint, AO, Prop Band, and Integration Time individually in order to tune.</td>
</tr>
<tr>
<td><strong>Proportional and Integral Parameters</strong></td>
<td>Displays the current values of the prop band and integration parameters for the selected loop.</td>
</tr>
<tr>
<td><strong>Logging Graphing Data to a File</strong></td>
<td>Allows you to save the data collected while graphing to the specified file. If this field is left blank when you click OK, the data will <strong>not</strong> be saved. If the data file entered already exists, the warning message shown in Figure 13-4 appears. If you do not continue (select No), you are returned to the PI Loop/Point(s) Selection dialog box where you can enter a different file name in the Log Data To field (Figure 13-3).</td>
</tr>
</tbody>
</table>
| **Loop Tuning Method** | **Monitor PI Loop/Point(s) only**  
Does not perform any loop tuning. Displays a graphical representation of the data values. When you select this method and click OK, the Monitor Only graphing screen appears (see Figure 13-8).  
**PRAC (Adaptive, Closed Loop) PI Tuning**  
Uses a Pattern Recognition Adaptive Control (PRAC) algorithm to tune the control loop. When you select this method and click OK, one of the Loop Tuning Parameters dialog boxes shown in Figure 13-5 and Figure 13-6 appears. HVAC PRO software has included default parameters for the value fields shown in the figures. These values may be changed, if necessary. |

![Figure 13-4: Warning Message](LOOPTH2)
Figure 13-5: Loop Tuning Parameters Dialog Box

Table 13-4: Loop Tuning Parameters Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative speed of the loop response?</td>
<td>Represents how fast the process feedback (AI) responds to a change in the process output (AO). Note: Use a smaller number on faster loops, such as static pressure.</td>
</tr>
<tr>
<td>Change in AI value when AO goes from 0 to 100?</td>
<td>Represents the process feedback (AI) change when the process output (AO) changes from 0 to 100%. Table 13-5 lists the possible available loops, their default parameter values and typical tuning times. Tuning is not recommended for humidity or zone temperature control loops, which require multiple hours of tuning to obtain meaningful results.</td>
</tr>
</tbody>
</table>

Figure 13-6: Loop Tuning Parameters - Pressure Independent VAVs with Incremental Control Dialog Box
Table 13-5: Loop Tuning Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative speed of the loop response?</td>
<td>Represents how the process feedback (AI) responds to a change in the process output (AO).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Loop Name</th>
<th>Relative Speed of Loop Response</th>
<th>Typical Change in AI Value</th>
<th>Typical Time to Tune (minutes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static Pressure</td>
<td>1</td>
<td>3 in. W.C.</td>
<td>3</td>
</tr>
<tr>
<td>Volume Matching</td>
<td>2</td>
<td>10,000 cfm</td>
<td>6</td>
</tr>
<tr>
<td>Discharge Temp-Steam</td>
<td>5</td>
<td>75°F</td>
<td>20</td>
</tr>
<tr>
<td>Discharge Temp-Economizer</td>
<td>10</td>
<td>35°F</td>
<td>45</td>
</tr>
<tr>
<td>Discharge Temp-Hot Water</td>
<td>10</td>
<td>75°F</td>
<td>45</td>
</tr>
<tr>
<td>Discharge Temp-Chilled Water</td>
<td>10</td>
<td>35°F</td>
<td>45</td>
</tr>
<tr>
<td>Sideloop</td>
<td>3</td>
<td>35</td>
<td>10</td>
</tr>
<tr>
<td>VAV Box Flow</td>
<td>1</td>
<td>3,000 cfm</td>
<td>6</td>
</tr>
</tbody>
</table>

Maximum CFM when damper is 100% open?

Maximum airflow reading when the damper is 100% open for static pressure and airflow control loops in VAV applications.

Damper travel time, full open to full closed (in mins)?

Value in minutes it takes the damper to travel from fully open to fully closed. This value should be as accurate as possible. The diagram in Figure 13-7 illustrates the input and outputs of the PRAC tuning algorithm.

![Figure 13-7: PRAC Inputs and Outputs](image)

3. Click the OK button on the PI Loop Tuning--PRAC dialog box after entering the tuning parameters to begin the graphing session.
If the loop tuning method selected was Monitor Only, the Monitor Only graphing screen shown in Figure 13-8 appears after you click OK on the PI Loop/Point(s) Selection dialog box. If the loop tuning method selected was PRAC Tuning Method, the PRAC Tuning graphing screen shown in Figure 13-9 is displayed after you specify the values for the loop tuning parameters. Descriptions of the items on the Monitor Only and PRAC Tuning graphing screens are provided in Table 13-6.

**Figure 13-8: Data Point(s)/PI Loop - Monitor Only Screen**
Figure 13-9: Data Point(s)/PI Loop - PRAC Tuning Screen
Table 13-6: Graphing Screen Elements

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Realtime Graphs</strong></td>
<td>Shows the real-time data for the PI input and setpoint on the upper graph while the lower graph shows the real-time data for the PI output. The names and current values for the points are displayed in the legends at the top of the graphs.</td>
</tr>
<tr>
<td><strong>Scroll Bars</strong></td>
<td>Displays a history of data after the data has been plotted for more than 15 minutes (900 seconds). View up to eight hours of data.</td>
</tr>
<tr>
<td><strong>Proportional Band and Integration Time (PRAC)</strong></td>
<td>Changes the proportional and integral parameter values by running the PRAC Tuning algorithm.</td>
</tr>
<tr>
<td><strong>Edit Parameters Button (PRAC)</strong></td>
<td>Changes the Tuning parameters (Figure 13-5 and Figure 13-6). This button is disabled while PRAC tuning is in progress. To enable the button, click the Monitor button on the PRAC Tuning graphing screen to stop tuning and return to Monitor mode.</td>
</tr>
<tr>
<td><strong>Tune/Monitor Button (PRAC)</strong></td>
<td>Toggles between Tune and Monitor mode. When the graphing screen is initially displayed, the screen is in Monitor mode. Data is collected from the controller and displayed on the real-time graphs, but the PRAC tuning algorithm is not running. To start PRAC tuning, click the Tune button.</td>
</tr>
<tr>
<td><strong>Exit Button</strong></td>
<td>Closes the graphing screen and returns to the main window. If PRAC tuning is in progress, click the Monitor button to stop tuning and return to Monitor mode. This enables the Exit button.</td>
</tr>
<tr>
<td><strong>Override Setpoint Button</strong></td>
<td>Overrides or releases the PI setpoint while tuning or monitoring data. This allows you to perform an override to the PI Loop’s setpoint parameter without returning to the Commission window. When you tune a loop, you may override the setpoint to test the performance of the selected loop. When the AI value responds quickly (relative to the speed of the loop) to match a setpoint value change without excessive overshoot, it shows that the loop has been adequately tuned. See Overriding the PI Setpoint in this section.</td>
</tr>
<tr>
<td><strong>Changing Graph Attributes</strong></td>
<td>Modify the X- or Y-axes attributes by double-clicking on the axis line (not the numeric labels). This displays Figure 13-11 for the Y-axis or Figure 13-12 for the X-axis. The range of the Y-axis may be changed, but the range of the X-axis is fixed at 900 seconds (15 minutes). See Modifying the Vertical Axis and Modifying the Time Axis in this chapter. Note: The modifications to the attributes of an axis are not retained, they are only in effect for this graphing session.</td>
</tr>
</tbody>
</table>
Overriding the PI Setpoint

To override the PI setpoint:

1. In the graphing screen, click the Override Setpoint button. The Override PI Loop Setpoint dialog box appears (Figure 13-10).

![Figure 13-10: Override PI Loop Setpoint Dialog Box](image)

If the PI Setpoint is known, it appears in the point name field along with its current value. Otherwise, select the actual setpoint to override from the drop-down list of available points. Scrolling the list of parameters may be required to find the desired setpoint.

2. Enter a new setpoint value, then click the Override button. To release the overridden value, simply click the Release button.

Modifying the Vertical Axis

To modify the vertical axis:

1. In the graphing screen, double-click on the vertical axis. The Vertical Axis dialog box appears (Figure 13-11).

![Figure 13-11: Vertical Axis Dialog Box](image)
2. Modify the entries in the dialog box using the information in Table 13-7 as a guide and click OK.

Note: The modifications to the attributes of an axis are not retained; they are only in effect for this graphing session.

**Table 13-7: Vertical Axis Dialog Box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From/To</td>
<td>Enter the minimum and maximum values (in physical units) to correspond to the beginning and end of the axis. Below are some suggested ranges for the Y-axis ranges based upon the type of loops being graphed:</td>
</tr>
<tr>
<td><strong>Process</strong></td>
<td><strong>From</strong></td>
</tr>
<tr>
<td>Static Pressure</td>
<td>0</td>
</tr>
<tr>
<td>Volume Matching</td>
<td>0</td>
</tr>
<tr>
<td>Temperature</td>
<td>45</td>
</tr>
<tr>
<td>X Intercept</td>
<td>Enter the X-axis intercept value. This is the value on the X-axis where the X- and Y-axes intersect.</td>
</tr>
<tr>
<td>Line Attributes</td>
<td>Click the Line Attributes button to define the axis line thickness, color, and style.</td>
</tr>
<tr>
<td>Ticks</td>
<td>Enter tick mark parameters:</td>
</tr>
<tr>
<td>Step</td>
<td>Select the distance between adjacent major tick marks.</td>
</tr>
<tr>
<td>Minor Ticks</td>
<td>Select the number of minor tick marks between two major tick marks.</td>
</tr>
<tr>
<td>Position</td>
<td>Select the position of the tick marks in relation to the axis.</td>
</tr>
<tr>
<td>Grids</td>
<td>Turn major and minor grid lines on and off and modify the grid line parameters.</td>
</tr>
<tr>
<td>Logarithmic Scale</td>
<td>When enabled, this feature scales the axis and all the plots based upon it logarithmically.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>An x appears in the box next to Logarithmic Scale when this feature is enabled.</td>
</tr>
</tbody>
</table>
Modifying the Time Axis

To modify the time axis:

1. In the graphing screen, double-click on the time (horizontal) axis. The Time Axis dialog box appears (Figure 13-12).

   ![Figure 13-12: Time Axis Window](image)

   **Figure 13-12: Time Axis Window**

2. Modify the entries in the dialog box using the information in Table 13-8 as a guide and click OK.

   Note: The modifications to the attributes of an axis are not retained; they are only in effect for this graphing session.

**Table 13-8: Time Axis Window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Does not apply for the Time Axis (unavailable).</td>
</tr>
<tr>
<td>Y Intercept</td>
<td>Enter the Y-axis intercept value. This is the value on the Y-axis where the X- and Y-axes intersect.</td>
</tr>
<tr>
<td>Line Attributes</td>
<td>Click the Line Attributes button to define the axis line thickness, color, and style.</td>
</tr>
<tr>
<td>Ticks</td>
<td>Enter tick mark parameters. See Table 13-7.</td>
</tr>
<tr>
<td>Grids</td>
<td>Turn major and minor grid lines on and off, and modify the grid line parameters.</td>
</tr>
</tbody>
</table>
Starting Pattern Recognition Adaptive Control (PRAC)

When the graphing screen first appears, you are placed in a Monitor mode (tuning is \textbf{not} occurring at this time) as shown in Figure 13-9. You may want to remain in the Monitor mode several minutes before starting PRAC.

To start PRAC:

1. Click the Tune button to begin the PRAC tuning process.

Figure 13-13 shows a typical PRAC graph screen after the Tune button has been selected.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{p1loopPR.png}
\caption{Data Point(s)/PI Loop - PRAC Tuning Screen}
\end{figure}
When you start the tuning process, the PRAC algorithm begins to characterize the control process and after a short period of time begins to make adjustments to the prop band and integration time. As the control loop stabilizes around the setpoint, you may want to override the setpoint value within the expected operating range. This allows PRAC to adjust the prop band and integration parameters for a typical range. For a sample tuning exercise, refer to the step by step tuning example at the end of this section.

2. Click the Monitor button to stop the tuning process when PRAC stops changing the prop band and integration time and you are satisfied with the response of the loop.

3. Continue to monitor the loop response and make setpoint changes to verify loop stability, or click Exit to end the graphing session. Stop PRAC at any time by selecting the Monitor button shown in Figure 13-13.

The new tuning parameters calculated by PRAC appear as overrides on the Commission screen. When you exit Commission mode, HVAC PRO software prompts you to save the values to the controller (refer to the Commissioning a Controller (LIT-63750406) chapter in this guide).

Verifying Process Performance

To verify process performance:

1. Introduce a setpoint change by clicking the Override Setpoint button after PRAC appears to have tuned the loop.

2. Enter the value according to Figure 13-9 and verify the system response.

Table 13-9: Recommended Range of Setpoint Changes

<table>
<thead>
<tr>
<th>Application</th>
<th>Minimum Change</th>
<th>Maximum Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static Pressure</td>
<td>0.1 in. of W.C.</td>
<td>0.25 in. of W.C.</td>
</tr>
<tr>
<td>Volume Matching</td>
<td>500 cfm</td>
<td>2000 cfm</td>
</tr>
<tr>
<td>Temperature</td>
<td>1.0 Degrees F</td>
<td>5.0 Degrees F</td>
</tr>
</tbody>
</table>
Tuning a Sample Loop with PRAC

The following steps are a sample tuning exercise.

Note: Remember to tune the fastest loop first.

**System Setup**

1. Open or upload the configuration for the controller that contains the desired loop to tune (save uploaded configuration if you wish to display available loops).
2. Enter the Commission mode for the desired controller.
3. Override all loops that may affect the desired loop to be tuned.
4. Override the selected loop’s deadband to zero.
5. Set any calculated setpoints coming from a reset schedule to a fixed value by overriding the AI used to calculate the setpoint.
6. Select Loop Tuning from the Commission menu.
7. Select loop name or data points to be tuned from the PI Loop Point(s) Selection dialog box.
8. Make sure current AI, AO, setpoints, prop bands, and integration values match those of the loop to be tuned.
9. Enter file name if PRAC data is to be saved; otherwise clear any data in the field labeled Log Data to.
10. Click the PRAC button.
11. Click OK.
12. Use relative speed and Change in AI to AO default values.

**Monitor Process**

13. Monitor the process for at least five minutes.
14. Perform a setpoint step change on the loop and wait 5 minutes according to the values in Table 13-9.
15. Exit loop tuning if the graphical output appears to be acceptable. Otherwise, continue to the next step.

**Tuning Process**

16. Click the Tune button.
17. Observe the AI, AO, prop band, and integration values. If the AO value is cycling, continue to allow PRAC to tune.
**Verification Process**

18. Perform a setpoint step change on the loop when the AO value stabilizes and wait 5 minutes according to the values in Table 13-10:

**Table 13-10: Sample Verification Process Values**

<table>
<thead>
<tr>
<th>Item</th>
<th>Minimum Value</th>
<th>Maximum Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static Pressure</td>
<td>0.1 in. of W.C.</td>
<td>0.25 in. of W.C.</td>
</tr>
<tr>
<td>Volume Matching</td>
<td>500 cfm</td>
<td>2000 cfm</td>
</tr>
<tr>
<td>Temperature</td>
<td>1.0 degree</td>
<td>5 degrees</td>
</tr>
</tbody>
</table>

19. Continue to observe the AI and AO values and perform additional setpoint changes until the results display proper control.

20. Click the Monitor button to stop PRAC.

21. Click Exit to close the graphing window.

**Notes:** When exiting Commission mode, the option is displayed to save overrides to the controller, including the new tuned proportional band and integration term.

You can remove other overrides (for example, deadbands); however, after tuning, it might be possible to apply smaller deadband values.

Optional: the collected PRAC data will be found in the user-specified data file (if any). This data can be imported and graphed in a spreadsheet.

**Adjusting Loop Tune Parameters**

Adjustments to the loop tuning parameters are rarely needed. However, if the tuning process does not appear to be functioning properly with the default values shown in Figure 13-5 or Figure 13-6, or a sideloop is being tuned, perform the following steps.

⚠️ **CAUTION:** The following steps require overrides to the loop’s AO. For a fan system, use caution in performing overrides as to not cause mechanical damage to the ductwork.

1. Use the graphing screen to monitor the desired loop. Be sure that all interacting loops have been overridden to limit their effect on the loop.

2. Override the AO to 0% and wait until the AI value does not change (i.e., becomes stable).
3. Record the stable AI value.

4. Override the AO to 100%. Record the time the override took place and label it T-start. Wait until the AI value does not change (i.e., becomes stable). Record the stable time and label it T-end.

5. Record the stable AI value.

6. Subtract T-start from T-end and label the result T-change (in seconds).

7. Divide T-change by 50 and enter the result in the PI Loop Tuning - PRAC dialog box as the Relative speed of the loop response. Round values up to the nearest integer.

8. Calculate the change in AI value = absolute value of AI (100%) - AI (0%).

9. Enter the calculated value from Step 8 into the PI Loop Tuning - PRAC dialog box as the Change in the AI value when the AO goes from 0 to 100%.

10. Resume PRAC tuning by selecting the Tune button.

The following figure illustrates the relationship between the values used to calculate a new Change in AI Value (as described in the preceding steps).

![Figure 13-14: Calculating the Change in AI Value](image-url)
**Troubleshooting**

The following are descriptions of known problems and their solutions.

**Table 13-11: Troubleshooting Using Loop Tuning for ASC Devices**

<table>
<thead>
<tr>
<th>Error/Condition</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop Tuning Does Not Respond to</td>
<td>During the course of tuning, the loop tuning does not respond to the</td>
<td>1. Click the Monitor button (Figure 13-13) to stop tuning.</td>
</tr>
<tr>
<td>Default Parameters</td>
<td>default parameters (set on the Loop Tuning Parameters dialog box, Figure</td>
<td>2. Click the Edit Parameters button (Figure 13-9) to display the Loop Tuning Parameters dialog box shown in Figure 13-5 or Figure 13-6.</td>
</tr>
<tr>
<td></td>
<td>13-5 or Figure 13-6).</td>
<td>3. Adjust the tuning parameters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Click OK, and restart the tuning process using the Tune button.</td>
</tr>
<tr>
<td>Data Graphing or Loop Tuning</td>
<td>When trying to perform loop tuning or data graphing in HVAC PRO Release</td>
<td>Add IBM® Proprinter III as a printer destination. If the problem still exists, try uninstalling all versions of HVAC PRO software and reinstalling the most recent version of HVAC PRO software. There is no software solution currently available that addresses this specific problem. Alternately, try performing the loop tuning or data graphing using a different PC.</td>
</tr>
<tr>
<td>GPFs</td>
<td>7.02, a General Protection Fault (GPF) occurs on some PCs. The error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>message indicates the following .dll is affected: QCBASEF.dll.</td>
<td></td>
</tr>
<tr>
<td>PRAC Loop Tuning command</td>
<td>When attempting to perform loop tuning, the Loop Tuning command is</td>
<td>Ensure that a configuration file is open. Commission using this file, either by commissioning the configuration in the controller and selecting Yes when prompted to use the configuration file, or by commissioning the current configuration.</td>
</tr>
<tr>
<td>is unavailable</td>
<td>unavailable in the Commission menu.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 14

Using Data Graphing

Introduction

The Data Graphing feature, available in the Commission menu, allows you to graph up to three analog values in real-time mode.

This chapter describes how to:

- create a graph
- modify the vertical axis
- modify the time axis
**Key Concepts**

**Data Graphing**

The Data Graphing feature is under the Commission menu. Data Graphing allows you to graph up to three analog values in real-time mode. This feature is not associated with loop tuning. When you select Data Graphing, the Point Selection dialog box displays as shown in Figure 14-1.

![Data Graphing Point Selection](image_url)

**Figure 14-1: Data Graphing - Point Selection Dialog Box**

The Point Selection dialog box lists all available analog points that can be selected for either of the graphing screen’s two data graphs. You may select up to two points for the first graph and one point for the second graph.
Procedure Overview

Table 14-1: Using Data Graphing

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Graph</td>
<td>On the Commission menu, click Data Graphing. To add points to the Graph 1 or Graph 2 point list, click on a point in the Points To Graph list. Click on the Add button for the graph’s point list. To remove points from the Graph 1 or Graph 2 point list, click on the point to remove. Click on the graph’s Remove button. After you finish selecting points to graph, click OK.</td>
</tr>
<tr>
<td>Modify the Vertical Axis</td>
<td>Double-click on the axis line. Modify entries in the Vertical Axis dialog box and click OK.</td>
</tr>
<tr>
<td>Modify the Time Axis</td>
<td>Double-click on the axis line. Modify entries in the Time Axis dialog box and click OK.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Creating a Graph

To create a graph:

1. On the Commission menu, click Data Graphing.
2. Click on a point in the Points To Graph list to add points to the Graph 1 or Graph 2 point list.
3. Click on the Add button for the graph’s point list.
4. Click on the point to remove points from the Graph 1 or Graph 2 point list.
5. Click on the graph’s Remove button.

Note: When selecting points to graph, the Add button for a graph is enabled only when the highlighted item in the Points To Graph can be added to the graph’s point list. The Add button is disabled if a point group heading is highlighted, or if the graph’s point list is full.

6. Select OK after you finish selecting points to graph. Figure 14-2 appears. Table 14-2 provides explanations of the different screen elements.

Note: You can view, override, or release points on the main commission window while the graphing screen is displayed. Simply minimize the graphing window and click on the commission window to make it active.
Figure 14-2: Data Graphing Screen

Table 14-2: Data Graphing Screen Elements

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Realtime Graphs</td>
<td>Displays the three analog points. The names and current values for the points are displayed in the legends at the top of the graphs.</td>
</tr>
<tr>
<td>Scroll Bars</td>
<td>Use to view a history of data after the data has been plotted for more than 15 minutes (900 seconds). Up to 8 hours of data can be viewed using the scroll bars.</td>
</tr>
<tr>
<td>Exit Button</td>
<td>Closes the graphing screen and returns to the main HVAC PRO window.</td>
</tr>
</tbody>
</table>
Modifying the Vertical Axis

To modify the vertical axis:

1. Double-click on the axis line (not the numeric labels). This displays the Vertical Axis dialog box (Figure 14-3).

   Note: The modifications to the attributes of an axis are not retained; they are only in effect for this graphing session.

   ![Vertical Axis Dialog Box](image)

   **Figure 14-3: Vertical Axis Dialog Box**

   2. Modify the entries in the dialog box using the information in Table 14-3 as a guide and click OK.

   **Table 14-3: Vertical Axis Window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From/To</td>
<td>Enter the minimum and maximum values (in physical units) to correspond to the beginning and end of the axis.</td>
</tr>
<tr>
<td>X Intercept</td>
<td>Enter the X-axis intercept value. This is the value on the X-axis where the X- and Y-axes intersect.</td>
</tr>
<tr>
<td>Line Attributes</td>
<td>Select the Line Attributes button to define the axis line thickness, color, and style.</td>
</tr>
<tr>
<td>Ticks</td>
<td>Enter tick mark parameters (Table 14-4).</td>
</tr>
<tr>
<td>Grids</td>
<td>Turn major and minor grid lines on and off, and modify the grid line parameters.</td>
</tr>
<tr>
<td>Logarithmic Scale</td>
<td>When enabled, this feature logarithmically scales the vertical axis and all the plots.</td>
</tr>
<tr>
<td></td>
<td>Note: An X appears in the box next to Logarithmic Scale when this feature is enabled (Figure 14-3).</td>
</tr>
</tbody>
</table>
Table 14-4: Tick Mark Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>Select the distance between adjacent major tick marks.</td>
</tr>
<tr>
<td>Minor Ticks</td>
<td>Select the number of minor tick marks between two major tick marks.</td>
</tr>
<tr>
<td>Position</td>
<td>Select the position of the tick marks in relation to the axis.</td>
</tr>
</tbody>
</table>

Modifying the Time Axis

To modify the time (horizontal) axis:

1. Double-click on the axis line (not the numeric labels). This displays the Time Axis dialog box (Figure 14-4). The range of the X-axis is fixed at 15 minutes (900 seconds).

Note: The modifications to the axis attributes are **not** retained; they are only in effect for the current graphing session.

![Time Axis Dialog Box](image)

Figure 14-4: Time Axis Dialog Box

2. Modify the entries in the dialog box using the information in Table 14-5 as a guide and click OK.

Table 14-5: Time Axis Window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>This field does not apply for the Time Axis and is always unavailable.</td>
</tr>
<tr>
<td>Y Intercept</td>
<td>Enter the Y-axis intercept value. This is the value on the Y-axis where the X- and Y-axes intersect.</td>
</tr>
<tr>
<td>Line Attributes</td>
<td>Select the Line Attributes button to define the axis line thickness, color, and style.</td>
</tr>
<tr>
<td>Ticks</td>
<td>Enter tick mark parameters (Table 14-4).</td>
</tr>
<tr>
<td>Grids</td>
<td>Turn major and minor grid lines on and off, and modify the grid line parameters.</td>
</tr>
</tbody>
</table>
Troubleshooting

The following are descriptions of known problems and their solutions.

Table 14-6: Troubleshooting Using Data Graphing

<table>
<thead>
<tr>
<th>Error/Condition</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid File name</td>
<td>When creating a graph, the file name for the graphing file is defaulted to the current configuration file name with a .DAT extension. If the configuration name is unknown (uploaded TC-9100 configurations), you must specify the data file name. An invalid file name causes the error message in Figure 14-5 to display.</td>
<td>Enter any legal DOS file name.</td>
</tr>
<tr>
<td>Error Message</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Graphing or Loop Tuning GPFs</td>
<td>When trying to perform loop tuning or data graphing in HVAC PRO Release 7.02, a General Protection Fault (GPF) occurs on some PCs. The error message indicates the following .dll is affected: QCBASEF.dll.</td>
<td>Add IBM Proprinter III™ printer as a printer destination. If the problem still exists, try uninstalling all versions of HVAC PRO software and reinstalling the most recent version of HVAC PRO software. There is no software solution currently available that addresses this specific problem. Alternately, try performing the loop tuning or data graphing using a different PC.</td>
</tr>
</tbody>
</table>

Figure 14-5: Invalid File Name Error Dialog Box
Testing and Receiving Data from Controllers

Introduction

Items included in the Action menu allow you to collect various kinds of information from supported controllers.

This chapter describes how to:

• receive controller information on a single device
• receive controller information on all devices on the N2 Bus
• set VMA controller N2 software addresses
• test a single VAV box
• test multiple VAV boxes
• remove controllers before starting the VAV Box Flow Test
• toggle the start command manually during the VAV Box Flow Test
• collect VAV diagnostics
• use the VMA Balancer Tool
• set the VAV Flow Deadband
• recalculate Flow Tuning parameters
• import AHU DOS configurations
• reset controllers
**Key Concepts**

**Action Menu**

Use the Action menu to test or retrieve information from a controller. Select Action to display its pull-down menu (Figure 15-1).

![Action Menu](PROACT)

**Figure 15-1: Action Menu**

Action menu items allow you to collect various kinds of information from supported controllers.

*Note:* Additional action menu items are displayed when an N2 Dial application is opened or created. These action items allow the user to define Modem Setup Strings and Phone Number Configurations. Refer to the *N2 Dial Application Application Note (LIT-6375150).*

**Controller Information**

Use Controller Information to obtain a detailed analysis of a controller or trunk of controllers. Use Controller Information as a quick checkout tool to verify controller hardware and configuration. HVAC PRO software writes a log of information pertaining to the controllers.
**VAV Box Flow Test**

Use the VAV Box Flow Test to test the flow through a box and obtain a more detailed analysis of the flow characteristics of that particular box. Use the VAV Box Flow Test as a quick checkout tool to verify correct damper operation. HVAC PRO software commands the damper to different positions and reads the flow at each point. It writes a log of the values and runs an analysis on the data to flag VAV boxes that are not operating correctly.

**Notes:** This test is for single duct pressure independent non-supply exhaust VAV boxes only. This menu item is not available if you are currently commissioning a different application.

When you are not in Commission mode, you can run the flow test for all single duct VAV boxes on the entire N2 Bus with a single command.

**VAV Diagnostics**

Select Collect VAV Diagnostics to view and collect diagnostic values for all VMA1400 Series devices and for all VAV controllers that can be configured with diagnostics (Pressure Independent Single Duct VAVs with BOs, Pressure Independent Dual Duct VAVs with BOs, and Constant Volume Dual Duct VAVs with separate dampers and BOs).

**VMA Balancer Tool**

Select VMA Balancer Tool to determine if the total airflow from all the diffusers is equal to the airflow calculated by the associated VMA1400 Series device.

**Note:** The VMA Balancer Tool is available only for single duct non-supply exhaust applications.

**VAV Flow Deadband**

Select the VAV Flow Deadband item in the Action menu to set the default deadband type used for VAV flow control loops. When you select VAV Flow Deadband, a submenu pops up with the following deadband types: Wide, Medium, and Narrow. A check mark indicates the current default as shown in Figure 15-2. The current default is initially set to Wide.
The default deadband type affects the calculated value of the VAV flow deadband. During the following procedures, the flow deadband is automatically calculated, along with the other VAV flow tuning parameters:

- during VAV controller upgrades if the option Update VAV Tuning Parameters is selected
- when you select Recalculate Flow Tuning Parameters from the Action menu
- during the File > Save process if changes to the Box Area, Actuator Stroke time, or Target Device affect the tuning parameters

Note: Simply changing the default deadband type will not cause an automatic recalculation of the VAV flow deadband.

For more information on VAV flow tuning parameters, see the VAV Terminal Control Applications Application Note (LIT-6375120).

Note: This VAV Flow Deadband section does not apply to VMA devices.

Recalculate Flow Tuning Parameters

The Recalculate Flow Tuning Parameters command automatically calculates the flow tuning parameters (Prop Band, Integration Time, and Deadband) for VAV applications. This menu item is enabled only for certain VAV control strategies and only if you have selected a target device for the configuration.

Note: The Recalculate Flow Tuning Parameters section for single duct and dual duct applications does not apply to VMA applications, because the VMA1400 Series includes its own internal calculations.
**Single Duct Applications**

The VAV control strategy for single duct applications is pressure independent with incremental damper output (BOs) including user-defined flow strategy.

**Dual Duct Applications**

The applicable VAV control strategies for dual duct applications are:

- pressure independent with incremental outputs (BOs) including discharge reset and user-defined flow strategies
- constant volume with separate dampers and incremental outputs (BOs) including discharge reset and user-defined flow strategies
- independent cold deck with incremental outputs (BOs)
- single duct conversion with incremental outputs (BOs)
- constant volume with linked dampers and incremental outputs (BOs)

**Import AHU DOS Config**

Upload and upgrade features are available for AHU applications after you convert an AHU path to the new HVAC PRO software format. Due to the complexity and size of AHU applications, there is not an automatic upgrade feature available for AHU controllers downloaded with a DOS version of HVAC PRO software.

**Reset Controllers**

The Reset Controller feature allows you to reset a single ASC or VMA1400 Series device without entering the Commission mode. TC-9100 controllers do not process the reset command.

**ASC Zone Bus Communication**

Most controllers come back online to the N2 Bus after a 10 minute delay following Zone Bus communications. However, the controllers listed below do not have this feature and require a controller reset after Zone Bus communications to enable N2 Bus communications. If you do not reset these controllers, they will not come back online to the N2 Bus. HVAC PRO software displays a reminder with an option to reset the controller after it communicates over the Zone Bus with any of the following:

- AHU: Firmware Version B01
- UNT: Firmware Version A01
- VAV: Firmware Version A01
Refer to the *Receiving Controller Information on a Single Device* procedure in the *Detailed Procedures* section for information on obtaining the controller type and its firmware revision.

**VMA Controller Software Addressing**

Notes: Use either the Controller Information or VMA Balancer Tool commands in HVAC PRO software to set the N2 software addresses of a VMA1400 Series device.

For more information on VMA software addressing, see *Mounting and Wiring Variable Air Volume Modular Assembly (VMA) 1400 Series Controllers Technical Bulletin (LIT-6363125).*

Specify the N2 address of a VMA1400 Series (B12 or later) controller through the hardware (DIP switches) or software (HVAC PRO Release 7.02 or later). For VMAs, the hardware setting has the priority. The N2 address of the device is the value of the hardware switches unless the switches are set to 0 or 255. When the hardware is set to 0 or 255, the N2 address is adjustable through the Zone Bus using HVAC PRO software. Since users need to go to each box to perform balancing, this feature provides a convenient means to accomplish both operations from a single screen.

The factory specifies an initial software address of 13 and sets the hardware switches to 0 or 255 for VMAs.

Notes: VMA1400 Series controller software addressing is only available through the Zone Bus with VMA code B12 or later and HVAC PRO Release 7.02 or later.

Since the hardware switches take priority over software settings, the decision between software and hardware addressing must be made before installation. If the hardware switches are set incorrectly, software addressing cannot make any corrections until the hardware switches are adjusted to 0 or 255.
**Procedure Overview**

Table 15-1: Testing and Receiving Data from Controllers

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Receive Controller Information on a Single Device</strong></td>
<td>On the Action menu, click Controller Information. Select Single Device and click OK. Enter the port, bus type, and N2 address, and click OK.</td>
</tr>
<tr>
<td><strong>Receive Controller Information on All Devices on the N2 Bus</strong></td>
<td>On the Action menu, click Controller Information. Select All Devices on the N2 Bus and click OK. Enter the port and the starting address. For information about every device type, choose Process All Device Types. For information on only certain types of devices, choose Process Selected Device Types, then pick the types from the list displayed. Select the Process Selected Device Types, and scroll through the list of device types to display additional supported controllers.</td>
</tr>
<tr>
<td><strong>Set VMA Controller N2 Software Addresses</strong></td>
<td>Install all the VMAs and set the hardware address to 0 or 255. Supply the units with power. Program each address through the Zone Bus using a laptop, CablePRO or CVTPRO, and HVAC PRO Release 8.01 or later. In HVAC PRO software, use either the Controller Information dialog box or the VAV Balancer Tool dialog box to set the address. Enter an N2 Address. Click Set Address. Wait for the new address to appear in the N2 Address field of the Controller Information screen or Balancer Tool screen.</td>
</tr>
<tr>
<td><strong>Test a Single VAV Box</strong></td>
<td>On the Action menu, click VAV Box Flow Test. Select Single VAV Box. Set the Flow Test Parameters. Click OK. Verify the communication parameters for the controller. Click OK.</td>
</tr>
<tr>
<td><strong>Test Multiple VAV Boxes</strong></td>
<td>On the Action menu, click VAV Box Flow Test. Verify Multiple VAV Boxes are selected. Select the flow test parameters. Click OK. Enter the port and the starting address. For information about both device types, choose Process All Device Types. For information on only one type of device, choose Process Selected Device Types, then pick the type from the list displayed. Verify the communication port and starting N2 address. Click OK.</td>
</tr>
<tr>
<td><strong>Remove Controllers Before Starting the VAV Box Flow Test</strong></td>
<td>Click on the controller. Click the Remove Controller button.</td>
</tr>
</tbody>
</table>

Continued on next page . . .
<table>
<thead>
<tr>
<th><strong>To Do This (Cont.)</strong></th>
<th><strong>Follow These Steps:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Toggle the Start Command Manually During the VAV Box Flow Test</strong></td>
<td>Click on the controller. Click the Toggle Start Command button.</td>
</tr>
<tr>
<td><strong>Collect VAV Diagnostics</strong></td>
<td>On the Action menu, click Collect VAV Diagnostics. Enter the port and the starting address. For information about both device types, choose Process All Device Types. For information on only one type of device, choose Process Selected Device Types, then pick the type from the list displayed. Verify the Communication Port selection and starting address. Click OK.</td>
</tr>
<tr>
<td><strong>Use VMA Balancer Tool</strong></td>
<td>On the Action menu, click VMA Balancer Tool. Verify the communications settings and click OK.</td>
</tr>
<tr>
<td><strong>Set the VAV Flow Deadband</strong></td>
<td>On the Action menu, select VAV Flow Deadband. Choose one of the options in the submenu that appears.</td>
</tr>
<tr>
<td><strong>Recalculate Flow Tuning Parameters</strong></td>
<td>On the Action menu, click Recalculate Flow Tuning Parameters. Click Yes to replace the current configuration values with the new, calculated values.</td>
</tr>
<tr>
<td><strong>Import AHU DOS Configurations</strong></td>
<td>Obtain a printout (filename.prn) of the DOS AHU configuration that you intend to convert. Start HVAC PRO software and perform File &gt; New. Select the matching AHU application. Use the printout of the DOS AHU configuration to re-answer the questions in the Question/Answer session. Select Import AHU DOS Config. Highlight the desired DOS AHU configuration file (*.ahc) within the displayed list of files and directories. Click OK.</td>
</tr>
<tr>
<td><strong>Reset Controllers</strong></td>
<td>On the Action menu, click Reset Controller. Select the proper communication settings for the controller to be reset. Click OK.</td>
</tr>
</tbody>
</table>
**Detailed Procedures**

**Receiving Controller Information on a Single Device**

To receive controller information on a single device:

1. On the Action menu, click Controller Information. The Controller Information dialog box appears (Figure 15-3).

![Figure 15-3: Action - Controller Information Dialog Box](image)

2. Select Single Device and click OK. A dialog box similar to Figure 15-4 appears.

![Figure 15-4: Communication Parameter Verification Dialog Box](image)

3. Enter the port, bus type, and N2 address, and click OK or press Enter to display the Controller Information dialog box.

The information listed in the dialog box is dependent on the connected device type. Figure 15-5 shows a typical Controller Information dialog box for a VMA1400 Series controller.
Figure 15-5: Controller Information Window Example - VMA

Note: An Advanced button appears for VMA devices. Click the Advanced button to display the dialog box in Figure 15-6.

Figure 15-6: Advanced Controller Information Dialog Box
Receiving Controller Information on All Devices on the N2 Bus

To receive controller information on all devices on the N2 Bus:

1. On the Action menu, click Controller Information. The Controller Information dialog box appears (Figure 15-3).

2. Select All Devices on the N2 Bus and click OK. A dialog box similar to Figure 15-7 appears.

3. Enter the port and the starting address.

4. Choose Process All Device Types for information about every device type. For information on only certain types of devices, choose Process Selected Device Types, then pick the types from the list displayed.

5. Select the Process Selected Device Types, and scroll through the list of device types to display additional supported controllers (Figure 15-8).

![Figure 15-7: Controller Information Dialog Box – All Devices on the N2 Bus](image-url)
Figure 15-8: Controller Information Dialog Box – Additional Device Types

6. Click OK. The dialog box in Figure 15-9 appears while HVAC PRO software scans the N2 Bus for devices. This scan may be halted at any time by selecting Cancel or pressing the spacebar.

HVAC PRO software displays the message in Figure 15-10 when it completes the N2 Bus scan.

Figure 15-9: N2 Device Scan Dialog Box
Figure 15-10: View Information Dialog Window

7. View the controller information now or at a later time. The controller information is stored in the file called devices.log. Click Yes to view the file now.

HVAC PRO software displays the devices.log. Figure 15-11 illustrates an example of the devices.log file.

Figure 15-11: Devices.log Example

Note: Each time HVAC PRO software collects controller information for multiple devices, it renames the existing devices.log file to devices.nnn, where nnn is a number from 0 to 999.
Setting VMA Controller N2 Software Addresses

To set VMA controller N2 software addresses:

1. Install all the VMAs and set the hardware address to 0 or 255.
2. Supply the units with power.
3. Program each address through the Zone Bus using a laptop, CablePRO or CVTPRO, and HVAC PRO Release 8.01 or later. In HVAC PRO software, set the address using either the Controller Information dialog box (Figure 15-5) or the Balancer Tool dialog box (Figure 15-22).
4. Enter an N2 Address.
5. Click Set Address.
6. Wait for the new address to appear in the N2 Address field of the Controller Information screen or Balancer Tool screen.

Testing a Single VAV Box

Note: This test is for single duct pressure independent non-supply exhaust VAV boxes only. This menu item is not available if you are currently commissioning a different application.

To test a single VAV box:

1. On the Action menu, click VAV Box Flow Test. The VAV Box Flow Test dialog box appears (Figure 15-12).

   ![VAV Box Flow Test Dialog Box](image)

   **Figure 15-12: VAV Box Flow Test Dialog Box**

2. Select Single VAV Box.
3. Set the Flow Test Parameters using the information in Table 15-2.
Table 15-2: Flow Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step Amount</strong></td>
<td>The step amount is the value the test uses to adjust to the damper command (DmpCmd) going from 0 to 100% open, then back to 0, or the other way if the start command is 100. This percentage determines the number of steps the test uses. For example, if you enter 25 for the step amount percentage, the test takes four steps to go from 0 to 100. Select from several values for the step amount. Use smaller values for a detailed test or large values (for example, 50 or 100) for a quick checkout. The smaller the step amount, the longer the test takes.</td>
</tr>
<tr>
<td><strong>Settle Time</strong></td>
<td>The settle time is the estimated time required for the airflow to reach a steady state after the damper stops moving. The test waits the proper percentage of the stroke time plus the settle time you stipulate. The larger the settle time, the longer the test takes. For accurate test results, allow the VAV system to settle at each step (for example, 30 to 60 seconds is adequate).</td>
</tr>
<tr>
<td><strong>Stroke Time</strong></td>
<td>Use the following equation to determine the stroke time when there is an actuator that does not have the same stroke time in the open and close direction: Take the larger of the following two values: Stroke Time = (Longest Stroke Time + Shortest Stroke Time)/2 Stroke Time = Longest Stroke Time/1.5</td>
</tr>
</tbody>
</table>

4. Click OK. HVAC PRO software displays a window in which you can verify the communication parameters (Figure 15-13).

![Figure 15-13: Communication Parameter Verification Window](image)

5. Verify the communication parameters for the controller. Click OK.

Notes: If you are already in Commission mode, the Communication dialog box does not display since HVAC PRO software is already communicating with the controller.
After selecting the flow test parameters and verifying the communication port, the VAV Box Flow Test dialog box appears (Figure 15-14).

![VAV Box Flow Test Dialog Box]

**Figure 15-14: VAV Box Flow Test Dialog Box**

The VAV Box Flow Test dialog box displays Start Command, Damper Command, Supply CFM, and Supply Delta P. The values of all these parameters except the start command update as the test progresses. The Toggle Start Command toggles the start command from 0 to 100 or 100 to 0.

6. Click OK. HVAC PRO software commands the damper to the start command, waits the full stroke time plus the settle time, then reads the flow. It then adds or subtracts the step amount from the command, commands the damper to the next point, waits the correct percentage of the stroke time plus the settle time, and reads the flow. This continues from 0 to 100% open and back to 0, or the other way if the start command was 100.

HVAC PRO software logs all the data values in a file named vavcfm.log and stores it in the current directory. It is a tab-delimited file that is appended with each test that is run. Once the test is complete, HVAC PRO software checks the flow at both 0 and 100% open. If the difference of these values is less than 10% of the Occupied cfm maximum, an error indicating a flat response is generated. If the flow at 100% open is not at least 90% of the Occupied cfm maximum, an error indicating starved box is generated.
Testing Multiple VAV Boxes

Note: This test is for single duct pressure independent non-supply exhaust VAV boxes only. This menu item is not available if you are currently commissioning a different application.

To test multiple VAV boxes:

1. On the Action menu, click VAV Box Flow Test. The VAV Box Flow Test dialog box appears (Figure 15-15).

2. Verify Multiple VAV Boxes are selected.

3. Select the flow test parameters (see Figure 15-2), then click OK. A dialog box similar to Figure 15-16 appears.

Figure 15-15: VAV Box Flow Test Dialog Box

Figure 15-16: VAV Box Flow Test Dialog Box - Communications
4. Enter the port and the starting address. For information about both device types, choose Process All Device Types. For information on only one type of device, choose Process Selected Device Types, then pick the type from the list displayed.

**Note:** You cannot do flow tests for multiple VAV boxes when in Commission mode.

5. Verify the communication port and starting N2 address, then click OK. HVAC PRO software searches the N2 Bus and displays a list of all single duct pressure independent VAV boxes connected to the N2 Bus (Figure 15-17).

![VAV Box Flow Test - N2 Device List](image)

**Figure 15-17: Multiple VAV Box Flow Tests - N2 Device List Window**

**Removing Controllers before Starting the Test**

To remove controllers from the list before starting the test:

1. Click on the controller.
2. Click the Remove the Controller from List button.
**Toggling the Start Command Manually**

As the controllers are listed, HVAC PRO software alternates the start commands. The first controller starts at 0%, the second at 100%, the third at 0%, and so on. This prevents overloading the fan system.

To toggle the start command manually:

1. Click on the controller.
2. Click the Toggle Start Command button.

When you click OK to start the VAV Box Flow Tests, HVAC PRO software commands each damper to the start position, waits the maximum stroke time plus the settle time, and reads the flow for each VAV box. It then adds or subtracts the step amount from each start command, commands each damper to the next point, waits the correct percentage of the maximum stroke time plus the settle time, and reads the flows.

Based on each controller’s starting command, HVAC PRO software repeats this process from 0 to 100% and then back to 0%, or from 100 to 0% and then back to 100%. HVAC PRO software logs the flow readings in a file named vavcfm.log in the current directory. If the file already exists (from a previous test), the data is appended to the end of the file.

HVAC PRO software also creates the status log, flowtest.log, when it completes the VAV box flow test. HVAC PRO software checks the flow for each VAV box at both 0 and 100%. If the difference in these values is less than 10% of the Occupied cfm maximum, HVAC PRO software assumes the box is not operating properly and logs a flat response status, in the flowtest.log file. If the flow at 100% is not at least 90% of the Occupied cfm maximum, HVAC PRO software logs a starved box status in the flowtest.log file.

After the flow tests are completed, the message box in Figure 15-18 displays, prompting you to view the status log file.

![Figure 15-18: View Flow Test Message Box](image)
Collecting VAV Diagnostics

To collect VAV diagnostics:

1. On the Action menu, click Collect VAV Diagnostics. The Collect VAV Diagnostics dialog box appears (Figure 15-19).

![Figure 15-19: Collect VAV Diagnostics Dialog Box](vavmult2)

2. Enter the port and the starting address. For information about both device types, choose Process All Device Types. For information on only one type of device, choose Process Selected Device Types, then pick the type from the list displayed.

3. Verify the Communication Port selection and starting address.

4. Click OK.

The dialog box in Figure 15-20 appears while HVAC PRO software scans the N2 Bus for all VMA1400 Series devices and VAV controllers with diagnostics.
Figure 15-20: Collect VAV Diagnostics Scan Dialog Box

Note that the device address is logged in the form n-XX, where n is the N2 address and XX is either Single Duct or Dual Duct. Headings with CD and HD in them refer to cold deck and hot deck (for Dual Duct VAVs only). Single duct diagnostic values are listed under the CD heading. Use the scroll bar to view items that do not appear on the screen.

For VMA1400 Series applications, the designation USD is used for single duct applications and UDD is used for dual duct applications. HVAC PRO software logs the diagnostic values in a file named vavdiag.log in the current directory. It appends this file each time you run a test. This is a tab-delimited file, suitable for importing into spreadsheets.

Using the VMA Balancer Tool

Note: The VMA Balancer Tool is available only for single duct non-supply exhaust applications.

To use the VMA Balancer Tool:

1. On the Action menu, select VMA Balancer Tool.
   HVAC PRO software displays a prompt to verify communications settings as shown in Figure 15-21. (If you are in the Commission mode, the communication dialog box is not shown.)
Figure 15-21: Balancer Communications Settings

2. Verify the communications settings and click OK. HVAC PRO software displays the Balancer Tool dialog box as shown in Figure 15-22.

![Balancer Tool Dialog Box]

Figure 15-22: Balancer Tool Dialog Box
The current minimum and maximum airflow values for the box display, along with the pickup gain, box area, and current flow through the box. The current flow value is dynamic and will update during the tests described below and as the damper position changes.

**Flow Tests**

The Balancer Tool assists you in determining the correct pickup gain for a particular VAV box. It positions the damper to its minimum and/or maximum flow settings, then calculates the pickup gain based on the current controller values and the actual flow measurement (flow hood reading). The Balancer Tool can calculate the correct pickup gain for the minimum flow, maximum flow, and the average of the two flow readings.

**Table 15-3: Balancer Tool Flow Tests**

<table>
<thead>
<tr>
<th>Flow Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Flow Test</td>
<td>To test the minimum flow through the VAV box, click the Drive Min button. The test will wait for the box to reach the minimum flow or for the flow to stop changing. A prompt displays requesting that you enter the actual flow reading. Enter the flow value, and the new pickup gain value is calculated. The Save Min button is enabled.</td>
</tr>
<tr>
<td>Maximum Flow Test</td>
<td>To test the maximum flow through the VAV box, click the Drive Max button. The test will wait for the box to reach the maximum flow or for the flow to stop changing. A prompt displays requesting that you enter the actual flow reading. Enter the flow value, and the new pickup gain value is calculated. The Save Max button is enabled.</td>
</tr>
</tbody>
</table>

To determine the pickup gain for the average of the minimum and maximum flow, perform both the minimum and maximum flow tests as described above. When both tests are complete, the Balancer Tool calculates and displays the average pickup gain, and the Save Ave button is enabled as shown in Figure 15-22.

When you click one of the Save buttons, the new pickup gain value is written to the controller. If the Balancer Tool is in Commission mode, the new values appear as overrides and can be saved when you exit Commissioning. If you are not in the Commission mode, the values are saved to the controller when you click the Save button and exit the dialog box.
Setting the VAV Flow Deadband

To set the VAV Flow Deadband:
2. Choose one of the options in the submenu that appears. A check mark will appear next to the selected option.

Recalculating Flow Tuning Parameters

To recalculate flow tuning parameters:

1. On the Action menu, click Recalculate Flow Tuning Parameters. The Flow Tuning Parameters dialog box displays as shown in Figure 15-23.

![Flow Tuning Parameters Dialog Box](image)

**Figure 15-23: Flow Tuning Parameters Dialog Box**

This dialog box shows the current value of the flow tuning parameters and the calculated tuning parameter values. Two sets of tuning parameters are displayed for dual duct applications. If the values do not match, you are prompted to use the calculated values.

2. Click Yes to replace the current configuration values with the new, calculated values. Click No to retain the current values. The decision as to which box tuning parameters to use is critical prior to box download.
Note: The Flow Tuning Parameters dialog box also displays during the File > Save process if changes made to the actuator stroke time, box area, or target device affect the tuning parameters.

**Importing AHU DOS Configurations**

To import AHU DOS configurations:

1. Obtain a printout (filename.prn) of the DOS AHU configuration that you intend to convert.
2. Start HVAC PRO software and perform File > New.
3. Select the matching AHU application. The Question/Answer session begins.
4. Use the printout of the DOS AHU configuration to re-answer the questions. Pay special attention to questions that may have been added.

Note: All added questions to the AHU applications have default answers that will create a configuration equivalent to the DOS AHU application that did not ask the question. For more information on the application changes, refer to the AHU Applications Application Note (LIT-6375080).

5. Select Import AHU DOS Config. HVAC PRO software displays the dialog box shown in Figure 15-24.

![Figure 15-24: Import AHU DOS Configuration Dialog Box](FILEOPN3)

6. Use the mouse and/or keyboard to highlight the desired DOS AHU configuration file (*.ahc) within the displayed list of files and directories.
7. Click OK to import the selected file or Cancel to abort the process.

HVAC PRO software transfers parameter values from the DOS AHU configuration into the new HVAC PRO software AHU configuration. It also adds all hardware attributes and user-defined Input/Output (I/O) points to match the AHU DOS configuration.

Note: If sideloops have been defined, you must redefine each sideloop and set its parameter values using the print out as a guide.

⚠️ CAUTION: Sideloop parameters addresses will change from the DOS version. Changes may be necessary for Metasys or Companion/Facilitator systems.

8. When you complete the import process and verify the configuration by matching the printout, perform a File > Save. Download the configuration to complete the AHU controller conversion.

**Resetting Controllers**

To reset a controller:

1. On the Action menu, click Reset Controller. The Reset Controller dialog box displays (Figure 15-25).

![Figure 15-25: Reset Controller Dialog Box](rsetcont)

2. Select the proper communication settings for the controller to be reset.

3. Click OK to reset the controller or Cancel to abort the operation.
Chapter 16

Using HVAC PRO Software from the OWS

Introduction

Once installed, HVAC PRO software can be run from an OWS (Operator Workstation).

This chapter describes how to:

- download the current configuration
- upload the configuration in the controller
- upgrade a single controller
- upgrade multiple controllers
- commission the current configuration
- commission the configuration in the controller
- view controller information for a single device
- view controller information for all devices on the selected Network Controller (NC)
- test a single VAV Box
- test multiple VAV Boxes
- collect VAV diagnostics
Key Concepts

Installation

To install HVAC PRO software on your OWS, follow the installation procedure in the *M-Tool Overview and Installation Technical Bulletin (LIT-693100)*. Then add it to the Operator Workstation Custom Application menu, if desired. Refer to the instructions in the *Defining Custom Applications (LIT-120163)* chapter in the *Advanced User’s Guide* section of the *Operator Workstation User’s Manual*.

Update for Metasys Release 10.0

Metasys Release 10.0 and later supports multiple Ethernet networks. Some key data structures were modified as a result, which affect the operations of HVAC PRO Release 7.02 (and later). Refer to Table 16-1 for your particular Metasys installation.

<table>
<thead>
<tr>
<th>Metasys Release</th>
<th>Functions with HVAC PRO Release?</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.01</td>
<td></td>
</tr>
<tr>
<td>9.01 A, B, C, and earlier</td>
<td>Yes if single network</td>
</tr>
<tr>
<td>10.0</td>
<td></td>
</tr>
</tbody>
</table>

Options for Accessing HVAC PRO Software from the OWS

Once you’ve added HVAC PRO software to the Custom Applications menu, you can access it directly from the Network Map using the procedure outlined in *Starting a Custom Application*, in the *Defining Custom Applications* section of the *Operator Workstation User’s Manual*.

Or, if you didn’t add HVAC PRO software to the Custom Applications menu, access it by switching to the Program Manager (leaving the Building Automation System [BAS] running), then double-clicking on the HVAC PRO software icon.
Differences when Using HVAC PRO Software from the OWS

After starting HVAC PRO software, you can use any of the features that are available in normal operation except the VMA Balancing Tool (VBT).

**IMPORTANT:** It is not recommended that the PI Loop Tuning (i.e., PRAC) be used on fast loops over the OWS. PRAC requires precise timing that is affected by the running OWS.

When you run HVAC PRO software on the OWS, it recognizes all N2 devices.

There are some differences between using HVAC PRO software as a standalone program and using it from an OWS:

- Download
- Upload
- Upgrade
- Commission
- Controller Information
- VAV Box Flow Test
- Collect VAV Diagnostics
- Reset Controller

These differences are described in the next sections.
The main HVAC PRO screen while running on the OWS will look like the screen in Figure 16-1.

![Figure 16-1: OWS - Main Screen](image)

**VMA Download**

Unlike the VMA1400 Series application download using a direct N2 connection, HVAC PRO software running on the OWS does not allow additional time for the archive process following a download. This will not be a concern unless power is removed from the devices immediately following a download. This internal archive typically takes 30 seconds. If immediate removal is desired, perform controller information to verify the device status is operational. This applies to upgrades running on the OWS as well.

**Download VMA Code**

HVAC PRO software can download VMA code only when a direct N2 connection is used. Therefore, when HVAC PRO software is running on the OWS, this menu item is unavailable.

To update the firmware code in one or more VMA1400 Series devices on an NC, you must disconnect the N2 from the NC. Run HVAC PRO software on a PC (not an OWS) and connect the PC to the N2. Proceed as described in the *Downloading Configurations and VMA Code (LIT-63750404)* chapter of this guide.
Commissioning

When you use HVAC PRO software to commission a controller from the OWS, the hardware object you select is placed in Comm Disabled mode. Any objects that map to this hardware object are also issued a Comm Disable command. The group summary for an object that is being commissioned from the OWS would look like Figure 16-2:

![Figure 16-2: Group Summary - Object Being Commissioned]

Although the object is not communicating with the OWS, it remains online. This allows HVAC PRO software to communicate with the controller without OWS interference.

Note: If the Metasys system has overridden a controller point, the point will appear with an asterisk (*) in HVAC PRO software when you enter Commission mode.

When you exit Commission mode, the hardware object resumes communication with the OWS and all objects mapped to the hardware object are issued a Comm. Enable command.
**Procedure Overview**

**Table 16-2: Using HVAC PRO from the OWS**

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download the Current Configuration</td>
<td>On the Download menu, click Current Configuration. Select an Network Control Unit (NCU) from the drop-down list box. Select one or more objects to which to download the configuration. Click OK.</td>
</tr>
<tr>
<td>Upload the Configuration in the Controller</td>
<td>On the Upload menu, click Configuration in Controller. Select an NCU from the drop-down list box. Click on the device to upload or highlight it using the arrow keys. Click OK.</td>
</tr>
<tr>
<td>Upgrade a Single Controller</td>
<td>On the Upload menu, click Upgrade Controllers. Choose Single Controller in the Upgrade Controllers dialog box. Select or deselect the Single Controller Options. Click OK. Choose an NCU from the drop-down list box. Click OK.</td>
</tr>
<tr>
<td>Upgrade Multiple Controllers</td>
<td>On the Upload menu, click Upgrade Controllers. Select Multiple Controllers in the Upgrade Controllers dialog box. Select or deselect the Multiple Controller Options. Click OK. Select the NCU. Choose whether you want to upgrade all device types or selected device types. Click OK.</td>
</tr>
<tr>
<td>Commission the Current Configuration</td>
<td>On the Commission menu, click Current Configuration. Select an NCU from the drop-down list box. Select an object to commission. Click OK.</td>
</tr>
<tr>
<td>Commission the Configuration in the Controller</td>
<td>On the Commission menu, click Configuration in Controller. Select an NCU from the drop-down list box. Click on the device to upload and commission or highlight it using the arrow keys. Click OK.</td>
</tr>
<tr>
<td>View Controller Information for a Single Device</td>
<td>On the Action menu, click Controller Information. Select Single Device in the Controller Information dialog box. Select an NCU from the drop-down list box. Select an object from which to read controller information. Click OK.</td>
</tr>
<tr>
<td>View Controller Information for All Devices on the Selected Network Controller (NC)</td>
<td>On the Action menu, click Controller Information. Select All Devices on the Select NC in the Controller Information dialog box. Select the NCU or select All NCs from the NC Name list. Choose whether you want information on all device types or selected device types. Click OK.</td>
</tr>
</tbody>
</table>

Continued on next page . . .
### To Do This (Cont.)

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test a Single VAV Box</td>
<td>On the Action menu, click VAV Box Flow Test. Verify that the Single VAV Box option is selected. Verify the Flow Test Parameter values and click OK. Select an NCU from the drop-down list box. Select an object on which to perform the box flow test. Click OK.</td>
</tr>
<tr>
<td>Test Multiple VAV Boxes</td>
<td>On the Action menu, click VAV Box Flow Test. Verify that the Multiple VAV Boxes option is selected. Select the Flow Test Parameters. Click OK. Select an NCU. Click OK or press Enter. To remove controllers from the list before starting the flow test, click on the controller you want to remove and click the Remove Controller from List button. To toggle the start command manually, click on the controller you want to change and click the Toggle Start Command button. Click OK to start the tests.</td>
</tr>
<tr>
<td>Collect VAV Diagnostics</td>
<td>On the Action menu, click VAV Diagnostics. Select an NCU or select All NCs from the NC Name list. Click OK.</td>
</tr>
</tbody>
</table>
**Detailed Procedures**

**Downloading the Current Configuration**

To download the current configuration:

1. On the Download menu, click Current Configuration. HVAC PRO software builds a list of all Network Controller Units (NCUs) on the active network. The Download Controller dialog box displays (Figure 16-3).

![Download Controller dialog box](image)

   **Figure 16-3: OWS - Download Dialog Box**

2. Click on the arrow next to the drop-down list box and click on the desired NCU. The Device list box will display all recognized hardware objects of types that match the file to be downloaded for the currently selected NCU.

3. Click on each object to which you want to select one or more objects to download the configuration.

4. Click OK or press Enter when you are ready to begin downloading. The download proceeds as if you were locally connected to the controller.
Uploading the Configuration in the Controller

To upload the configuration in the controller:

1. On the Upload menu, click Configuration in Controller. The Upload Controller dialog box displays (Figure 16-4).

   ![Figure 16-4: OWS - Upload Configuration Dialog Box]

2. Click on the arrow next to the drop-down list box and click on the desired NCU. A list of supported devices displays in the Device list box. You may select one device to upload.

3. Click on the device to upload or highlight it using the arrow keys and select OK. The upload will proceed as if you were locally connected to the controller.

Note: There is no multiple controller upload option. You must upload controllers one at a time.
Upgrading a Single Controller

To upgrade a single controller:
1. On the Upload menu, click Upgrade Controllers.
2. Choose Single Controller in the dialog box that appears as shown in Figure 16-5.

3. Select or deselect the Single Controller Options.

Figure 16-5: Upgrade Controllers Dialog Box
4. Click OK or press Enter. The Upgrade Controller dialog box displays (Figure 16-6).

![Upgrade Controller dialog box]

**Figure 16-6: OWS - Upgrade Single Controller Dialog Box**

5. Choose an NCU from the drop-down list box, select the device you would like to upgrade, then click OK. The Upgrade process proceeds as if you were locally connected to the controller.
Upgrading Multiple Controllers

To upgrade multiple controllers:

1. On the Upload menu, click Upgrade Controllers.
2. Select Multiple Controllers as shown in Figure 16-7.

3. Select or deselect the Multiple Controller Options.
4. Click OK or press Enter to display the dialog box in Figure 16-8.

---

**Figure 16-7: Upgrade Multiple Controllers Dialog Box**

3. Select or deselect the Multiple Controller Options.
4. Click OK or press Enter to display the dialog box in Figure 16-8.

---

**Figure 16-8: OWS - Upgrade Multiple Controllers Dialog Box**
5. Select the NCU.

6. Choose whether you want to upgrade all device types or selected device types. If you choose Process Selected Device Types, then select the device types that you would like to upgrade. Only one NCU can be upgraded at a time.

7. Click OK when you are ready to begin upgrading. The dialog box in Figure 16-9 appears.

![Upgrade Controllers - N2 Device List](image)

**Figure 16-9: OWS - N2 Device List Dialog Box**

From this point, this feature functions identically to the standard upgrade feature.
Commissioning the Current Configuration

To commission the current configuration:

1. On the Commission menu, click Current Configuration. HVAC PRO software builds a list of all NCUs on the active network. The Commission Controller dialog box displays (Figure 16-10).

   2. Click on the arrow next to the drop-down list box and click on the desired NCU. The device list box displays all hardware objects of types that match the current configuration.

   3. Click on the object you want to select to commission using the current configuration.

   4. Click OK or press Enter when you are ready to continue. The commissioning process proceeds as if you were locally connected to the controller.
Commissioning the Configuration in the Controller

To commission the configuration in the controller:

1. On the Commission menu, click Configuration in Controller. The Upload/Commission Controller dialog box displays (Figure 16-11).

2. Select an NCU from the drop-down list box. A list of supported devices displays in the Device list box. You may select one device to upload and commission.

3. Click on the device to upload and commission or highlight it using the arrow keys and select OK. Then proceed with commissioning as if you were locally connected to the controller.
Viewing Controller Information for a Single Device

To view information on a single device:

1. On the Action menu, click Controller Information. The Controller Information dialog box appears (Figure 16-12).

2. Select Single Device. HVAC PRO software builds a list of all NCUs on the active network. The dialog box in Figure 16-13 displays.

---

**Figure 16-12: Action - Controller Information Dialog Box**

**Figure 16-13: OWS - Controller Information Dialog Box**
3. Click on the arrow next to the drop-down list box and click on the desired NCU. The Device list box displays a list of hardware objects.

4. Click on the object from which you want to read controller information.

5. Click OK or press Enter when you are ready to continue. The controller information process proceeds as if you were locally connected to the controller.

Viewing Controller Information for All Devices on the Selected Network Controller (NC)

To view information on all devices on the selected NC:

1. On the Action menu, click Controller Information.

2. Select All Devices on the Selected NC. The Controller Information dialog box displays (Figure 16-14).

3. Select the NCU or select All NCs from the NC Name list.

4. Choose whether you want information on all device types or selected device types. If you choose Process Selected Device Types, select the device types.
5. Click OK or press Enter. The dialog box in Figure 16-15 displays. HVAC PRO software displays the message in Figure 16-16 when it completes the scan of the selected NCU.

![Controller Information Dialog Box](owscin2)

**Figure 16-15: OWS - Controller Information Dialog Box**

<table>
<thead>
<tr>
<th>Addr</th>
<th>Device</th>
<th>System/Object</th>
<th>Rev</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>VAV</td>
<td>V1_9\VAV006</td>
<td>5.00</td>
<td>Single Duct</td>
</tr>
<tr>
<td>7</td>
<td>VAV</td>
<td>V1_9\VAV007</td>
<td>5.00</td>
<td>Single Duct</td>
</tr>
<tr>
<td>8</td>
<td>VAV</td>
<td>V1_9\VAV008</td>
<td>5.00</td>
<td>Single Duct</td>
</tr>
<tr>
<td>9</td>
<td>VMA</td>
<td>V1_9\VMA010</td>
<td>7.00</td>
<td>VMA Single Duct</td>
</tr>
</tbody>
</table>

![View Information Message Box](CONINFOS)

**Figure 16-16: View Information Message Box**

Note: You have the option of viewing the controller information now or at a later time. The controller information is stored in the file called devices.log.

6. Click Yes to view the file.
Testing a Single VAV Box

Note: This test is for single duct pressure independent non-supply exhaust VAV boxes only. This menu item is not available if you are currently commissioning a different application.

To conduct a VAV Box Flow test on a single controller:

1. On the Action menu, click VAV Box Flow Test. The VAV Box Flow Test dialog box appears (Figure 16-17).

2. Verify that the Single VAV Box option is selected.

3. Verify the Flow Test Parameter values and click OK. HVAC PRO software displays the dialog box shown in Figure 16-18.

Figure 16-17: OWS - VAV Box Flow Test Dialog Box
Figure 16-18: OWS - VAV Box Flow Test Dialog Box

4. Click on the arrow next to the drop-down list box and click on the desired NCU. The device list box displays VAV and VMA hardware objects.

5. Click on the object on which you want to perform a box flow test.

6. Click OK or press Enter when you are ready to continue. The VAV box flow test proceeds as if you were locally connected to the controller. For more information on testing a single VAV box, see the Testing a Single VAV Box procedure in the Testing and Receiving Data from Controllers (LIT-63750416) chapter of this guide.
Testing Multiple VAV Boxes

Note: This test is for single duct pressure independent non-supply exhaust VAV boxes only. This menu item is not available if you are currently commissioning a different application.

To flow test multiple VAV boxes:

1. On the Action menu, click VAV Box Flow Test. The VAV Box Flow Test dialog box appears (Figure 16-19).

![Figure 16-19: OWS - VAV Box Flow Test Dialog Box](image1)

2. Verify that Multiple VAV Boxes is selected.

3. Select the Flow Test Parameters, then click OK. The dialog box shown in Figure 16-20 appears.

![Figure 16-20: OWS - VAV Box Flow Test Dialog Box](image2)
4. Select an NCU, then click OK or press Enter. HVAC PRO software searches the NCU and displays a list of all single duct pressure independent VAV boxes found (Figure 16-21).

<table>
<thead>
<tr>
<th>Addr.</th>
<th>System\Object</th>
<th>Start Cmd</th>
<th>Damper Cmd</th>
<th>CFM</th>
<th>Delta P</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>PANEL_1\VAV_4</td>
<td>0</td>
<td>100</td>
<td>482</td>
<td>0.015</td>
</tr>
<tr>
<td>7</td>
<td>PANEL_1\VAV_7</td>
<td>100</td>
<td>18</td>
<td>96</td>
<td>0.654</td>
</tr>
<tr>
<td>8</td>
<td>PANEL_1\VAV_8</td>
<td>0</td>
<td>100</td>
<td>612</td>
<td>0.012</td>
</tr>
<tr>
<td>9</td>
<td>PANEL_1\VMA_9</td>
<td>100</td>
<td>60</td>
<td>502</td>
<td>0.200</td>
</tr>
</tbody>
</table>

Figure 16-21: OWS - Multiple VAV Box Flow Test - N2 Device List Dialog Box

5. Click on the controller you want to remove and click the Remove Controller from List button to remove controllers from the list before starting the flow test.

As the controllers are listed, HVAC PRO software alternates the start commands. The first controller starts at 0%, the second at 100%, the third at 0%, and so on. This prevents overloading the fan system.

6. Click on the controller you want to change and click the Toggle Start Command button to toggle the start command manually.

7. Click OK to start the VAV box flow tests. HVAC PRO software executes the flow tests as described under the VAV Box Flow Test topic in the Testing and Receiving Data from Controllers (LIT-63750416) chapter of this guide.
Collecting VAV Diagnostics

To collect VAV diagnostics:

1. On the Action menu, click Collect VAV Diagnostics. The VAV Diagnostics dialog box appears (Figure 16-22).

2. Select an NCU or select All NCs from the NC Name list.

Figure 16-22: Collect VAV Diagnostics Dialog Window
3. Click OK. The dialog box shown in Figure 16-23 appears while HVAC PRO software scans the NCU for all VMA1400 Series devices and all VAV controllers with diagnostics.

![Collect VAV Diagnostics](owsgodiag2)

**Figure 16-23: OWS - VAV Diagnostics Scan Dialog Box**

Notes: The N2 address is logged in the form n-XX, where n is the N2 address and XX is either Single Duct or Dual Duct. Headings with CD and HD in them refer to cold deck and hot deck (for Dual Duct VAVs only). Single duct values appear under the CD heading. Use the scroll bar to view items that do not appear on the screen.

HVAC PRO software logs the diagnostic values in a file named vavdiag.log in the current directory. It appends this file each time you run a test. This is a tab-delimited file, suitable for importing into spreadsheets.
## Troubleshooting

Table 16-3 lists known problems and their solutions.

### Table 16-3: Troubleshooting Using HVAC PRO from the OWS

<table>
<thead>
<tr>
<th>Error/Condition</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using HVAC PRO</td>
<td>When attempting to use HVAC PRO Release 7.02 in Pass Through mode with Metasys software Release 9.01 or earlier to perform Controller Information, Upload, or Download tasks, the following error appears: Communication Error: Checksum Error. The error appears because only the first network defined in the network definition .ddl file is compatible in Release 7.02. Note that the list in the Metasys software is in alphabetical order. Look at the .ddl file to determine the first defined network.</td>
<td>Workaround:&lt;br&gt;1. Edit the network definition .ddl file to list the desired network as the first definition in the file.&lt;br&gt;2. Recompile using the DDL command.&lt;br&gt;3. Restart Metasys software.&lt;br&gt;Permanent Solution: Install HVAC PRO Release 7.03 or later.</td>
</tr>
<tr>
<td>Release 7.02</td>
<td></td>
<td></td>
</tr>
<tr>
<td>from the OWS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>with Metasys</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Release 9.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Causes Error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Using HVAC PRO</td>
<td>Variable Air Volume Module Assembly (VMA) BIs and BOs are offline to Metasys software Release 10.0 or earlier after commissioning with HVAC PRO Release 7.02. This is not an HVAC PRO software problem; it is a Metasys OWS problem. The BIs and BOs, which are online to Metasys software prior to commissioning, go offline during commissioning but never return to online after commissioning is completed. Other points mapped into the controller return to online.</td>
<td>Workaround:&lt;br&gt;From Metasys software Release 9.01c or 10.0, override the points and release. This re-establishes communication and brings them online.&lt;br&gt;Permanent Solution: Install Metasys software Release 10.01 or later.</td>
</tr>
<tr>
<td>Release 7.02</td>
<td></td>
<td></td>
</tr>
<tr>
<td>from the OWS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>with Metasys</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Release 9.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMA Binary</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inputs (BIs)</td>
<td>Variable Air Volume Module Assembly (VMA) BIs and BOs are offline to Metasys software Release 10.0 or earlier after commissioning with HVAC PRO Release 7.02. This is not an HVAC PRO software problem; it is a Metasys OWS problem. The BIs and BOs, which are online to Metasys software prior to commissioning, go offline during commissioning but never return to online after commissioning is completed. Other points mapped into the controller return to online.</td>
<td>Workaround:&lt;br&gt;From Metasys software Release 9.01c or 10.0, override the points and release. This re-establishes communication and brings them online.&lt;br&gt;Permanent Solution: Install Metasys software Release 10.01 or later.</td>
</tr>
<tr>
<td>Binary Outputs</td>
<td>Variable Air Volume Module Assembly (VMA) BIs and BOs are offline to Metasys software Release 10.0 or earlier after commissioning with HVAC PRO Release 7.02. This is not an HVAC PRO software problem; it is a Metasys OWS problem. The BIs and BOs, which are online to Metasys software prior to commissioning, go offline during commissioning but never return to online after commissioning is completed. Other points mapped into the controller return to online.</td>
<td>Workaround:&lt;br&gt;From Metasys software Release 9.01c or 10.0, override the points and release. This re-establishes communication and brings them online.&lt;br&gt;Permanent Solution: Install Metasys software Release 10.01 or later.</td>
</tr>
<tr>
<td>(BOs) are Offline</td>
<td>Variable Air Volume Module Assembly (VMA) BIs and BOs are offline to Metasys software Release 10.0 or earlier after commissioning with HVAC PRO Release 7.02. This is not an HVAC PRO software problem; it is a Metasys OWS problem. The BIs and BOs, which are online to Metasys software prior to commissioning, go offline during commissioning but never return to online after commissioning is completed. Other points mapped into the controller return to online.</td>
<td>Workaround:&lt;br&gt;From Metasys software Release 9.01c or 10.0, override the points and release. This re-establishes communication and brings them online.&lt;br&gt;Permanent Solution: Install Metasys software Release 10.01 or later.</td>
</tr>
<tr>
<td>Intermittent VMA</td>
<td>Intermittent communication errors are experienced while running HVAC PRO software on a Metasys Operator Workstation (OWS). The errors seem restricted to Ethernet N1 installations during VMA1400 Series controller downloads. A possible cause is unusually high N1 Ethernet traffic.</td>
<td>Try to analyze source of N1 traffic. Try performing the operation (upload, download, and commission) during off-peak times of the day. There is no software solution currently available that addresses this specific problem.</td>
</tr>
</tbody>
</table>
Chapter 17

Using HVAC PRO Software in Pass Through Mode

Introduction

Once installed, HVAC PRO software can be run in Pass Through mode from Project Builder.

This chapter describes how to:

- start HVAC PRO software in Pass Through mode
- start HVAC PRO software in Standard mode
- download the current configuration
- upload the configuration in the controller
- upgrade a single controller
- upgrade multiple controllers
- commission the current configuration
- commission the configuration in the controller
- view controller information for a single device
- view controller information for all devices on the selected Supervisory Controller
- test a single VAV box
- test multiple VAV boxes
- collect VAV diagnostics
Key Concepts

HVAC PRO Software in Pass Through Mode

By running HVAC PRO software in Pass Through mode, you can take advantage of network connections to facilitate communication between HVAC PRO software and individual controllers. In Pass Through mode, you can use HVAC PRO software to download ASC configurations directly through an N30 Supervisory Controller.

In addition, Pass Through mode makes it easier to identify and manage controllers for common tasks. HVAC PRO software uses some of M-Tool’s database functions (see Site Book below) to generate lists of the controllers connected to a particular N30 Supervisory Controller. In order to perform a task on a given controller, you can simply select the controller from a list. For more information on features available in Project Builder, see Project Builder User’s Guide.

Site Book

Site Book is a program used to define and edit the set of physical or logical locations that can be connected in an N30 network. Each site within the database has parameters that are needed to establish the connection. The Site Book configures sites for N30 devices.

Site Book installs with either M-Tool or M3/M5 Workstations. For more information on Site Book, see the Site Book User’s Guide.

Pass Through vs. Standard Mode

Project Builder provides two options for using HVAC PRO software: Pass Through or Standard mode. Use Pass Through mode when connected to the N30 network. Attempting to use Pass Through mode without an active network connection will result in error messages.

Standard mode allows you to perform common HVAC PRO software tasks when not connected to the N30 network. Use this mode when creating or saving configuration files offline for later use.

Differences when Using Pass Through Mode

After starting HVAC PRO software in Pass Through mode, you can use any of the features available in normal operation except the VMA Balancing Tool (VBT).

IMPORTANT: It is not recommended that the PI Loop Tuning (i.e., PRAC) be used on fast loops over the N30 network. PRAC requires precise timing that can be affected by the network response or by running Site Book.
When you run HVAC PRO software in Pass Through mode, it recognizes all N2 devices.

Be aware of differences with the following commands:

- Download
- Upload
- Upgrade
- Commission
- Controller Information
- VAV Box Flow Test
- Collect VAV Diagnostics

These differences are described in the *Detailed Procedures* section.

Figure 17-1 is an example of the main HVAC PRO screen while running in Pass Through mode. The title bar indicates that you are running the software Through Supervisory Controller (Pass Through mode).
VMA Download

Unlike the VMA1400 Series application download using a direct N2 connection, HVAC PRO software running in Pass Through mode from Project Builder does not allow additional time for the archive process following a download. This will not be a concern unless power is removed from the devices immediately following a download. This internal archive typically takes 30 seconds. If immediate removal is desired, perform controller information to verify the device status is operational. This applies to upgrades running from Project Builder as well.

Download VMA Code

HVAC PRO software can download VMA1400 Series code only when a direct N2 connection is used. Therefore, when HVAC PRO software is running in Pass Through mode from Project Builder, this menu item is unavailable.

To update the firmware code in one or more VMA1400 Series devices on an N30 Supervisory Controller, you must disconnect the N2 from the N30 Supervisory Controller. Run HVAC PRO software on a PC (not in Pass Through mode) and connect the PC to the N2. Proceed as described in the Downloading Configurations and VMA Code (LIT-63750404) chapter of this guide.
## Procedure Overview

### Table 17-1: Using HVAC PRO Software from Project Builder

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start HVAC PRO Software in</strong></td>
<td>Do one of the following: launch Project Builder, and click Tools &gt; N2 Controller</td>
</tr>
<tr>
<td><strong>Pass Through Mode</strong></td>
<td>Editors &gt; HVAC PRO; or from the Start menu, click Programs &gt; Johnson Controls &gt; M-</td>
</tr>
<tr>
<td></td>
<td>Tool &gt; System Tools &gt; HVACPRO Through N30. Select the site from the list provided</td>
</tr>
<tr>
<td></td>
<td>and click Connect.</td>
</tr>
<tr>
<td><strong>Start HVAC PRO Software in</strong></td>
<td>Launch Project Builder, and select Tools &gt; N2 Controller Editors &gt; HVAC PRO.</td>
</tr>
<tr>
<td><strong>Standard Mode</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Download the Current</strong></td>
<td>On the Download menu, click Current Configuration. Select a Supervisory Controller</td>
</tr>
<tr>
<td><strong>Configuration</strong></td>
<td>from the drop-down list box. Select one or more objects to which to download the</td>
</tr>
<tr>
<td></td>
<td>configuration. Click OK.</td>
</tr>
<tr>
<td><strong>Upload the Configuration in</strong></td>
<td>On the Upload menu, click Configuration in Controller. Select a Supervisory Controller</td>
</tr>
<tr>
<td><strong>the Controller</strong></td>
<td>from the drop-down list box. Click on the device to upload or highlight it using the</td>
</tr>
<tr>
<td></td>
<td>arrow keys. Click OK.</td>
</tr>
<tr>
<td><strong>Upgrade a Single Controller</strong></td>
<td>On the Upload menu, click Upgrade Controllers. Choose Single Controller in the Upgrade</td>
</tr>
<tr>
<td></td>
<td>Controllers dialog box. Select or deselect the Single Controller Options. Click OK.</td>
</tr>
<tr>
<td></td>
<td>Choose a Supervisory Controller from the drop-down list box. Click OK.</td>
</tr>
<tr>
<td><strong>Upgrade Multiple Controllers</strong></td>
<td>On the Upload menu, click Upgrade Controllers. Select Multiple Controllers in the Upgrade</td>
</tr>
<tr>
<td></td>
<td>Controllers dialog box. Select or deselect the Multiple Controller Options. Click OK.</td>
</tr>
<tr>
<td></td>
<td>Select the Supervisory Controller. Choose whether you want to upgrade all device types</td>
</tr>
<tr>
<td></td>
<td>or selected device types. Click OK.</td>
</tr>
<tr>
<td><strong>Commission the Current</strong></td>
<td>On the Commission menu, click Current Configuration. Select a Supervisory Controller</td>
</tr>
<tr>
<td><strong>Configuration</strong></td>
<td>from the drop-down list box. Select an object to commission. Click OK.</td>
</tr>
<tr>
<td><strong>Commission the Configuration</strong></td>
<td>On the Commission menu, click Configuration in Controller. Select a Supervisory</td>
</tr>
<tr>
<td><strong>in the Controller</strong></td>
<td>Controller from the drop-down list box. Click on the device to upload and commission</td>
</tr>
<tr>
<td></td>
<td>or highlight it using the arrow keys. Click OK.</td>
</tr>
<tr>
<td><strong>View Controller Information for</strong></td>
<td>On the Action menu, click Controller Information. Select Single Device in the Control</td>
</tr>
<tr>
<td><strong>a Single Device</strong></td>
<td>lor Information dialog box. Select a Supervisory Controller from the drop-down list</td>
</tr>
<tr>
<td></td>
<td>box. Select an object from which to read controller information. Click OK.</td>
</tr>
</tbody>
</table>

*Continued on next page...*
<table>
<thead>
<tr>
<th>To Do This (Cont.)</th>
<th>Follow These Steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View Controller Information for All Devices on the Selected Supervisory Controller</strong></td>
<td>On the Action menu, click Controller Information. Select All Devices on selected Supervisory Controller in the Controller Information dialog box. Select the Supervisory Controller or select All Supervisory Controllers from the Supervisory Controller Name list. Choose whether you want information on all device types or selected device types. Click OK.</td>
</tr>
<tr>
<td><strong>Test a Single VAV Box</strong></td>
<td>On the Action menu, click VAV Box Flow Test. Verify that the Single VAV Box option is selected. Verify the Flow Test Parameter values and click OK. Select a Supervisory Controller from the drop-down list box. Select an object on which to perform the box flow test. Click OK.</td>
</tr>
<tr>
<td><strong>Test Multiple VAV Boxes</strong></td>
<td>On the Action menu, click VAV Box Flow Test. Verify that the Multiple VAV Boxes option is selected. Select the Flow Test Parameters. Click OK. Select a Supervisory Controller. Click OK or press Enter. To remove controllers from the list before starting the flow test, click on the controller you want to remove and click the Remove Controller from List button. To toggle the start command manually, click on the controller you want to change and click the Toggle Start Command button. Click OK to start the tests.</td>
</tr>
<tr>
<td><strong>Collect VAV Diagnostics</strong></td>
<td>On the Action menu, click VAV Diagnostics. Select a Supervisory Controller or select All Supervisory Controllers from the Supervisory Controller Name list. Click OK.</td>
</tr>
</tbody>
</table>
**Detailed Procedures**

**Starting HVAC PRO Software in Pass Through Mode**

To start HVAC PRO software in Pass Through mode:

1. Use either of these methods to begin:
   - From the Start menu, click Programs > Johnson Controls > M-Tool > System Tools > HVACPRO Through N30.

2. Select the site from the list provided in the Choose Site dialog box (Figure 17-2) and click Connect.

**Note:** Use HVAC PRO software in Pass Through mode only when the PC is connected to the N30 network. If the PC is not connected, use HVAC PRO software in Standard mode instead.

![Choose Site Dialog Box](image)

**Figure 17-2: Choose Site Dialog Box**

**Starting HVAC PRO Software in Standard Mode**

To start HVAC PRO software in Standard mode:

1. Launch Project Builder.

2. In Project Builder, click Tools > N2 Controller Editors > HVAC PRO.
Downloading the Current Configuration

To download the current configuration:

1. On the Download menu, click Current Configuration. HVAC PRO software builds a list of all Supervisory Controllers on the active network. The Download Controller dialog box appears (Figure 17-3).

![Download Controller Dialog Box](image)

2. Click on the arrow next to the Supervisory Controller list box and click on the desired Supervisory Controller. The Device list box lists all recognized hardware objects that match the file to be downloaded for the currently selected Supervisory Controller.

3. Select one or more objects to which to download the configuration.

4. Click OK or press Enter when you are ready to begin downloading. The download proceeds as if you were locally connected to the controller.
Uploading the Configuration in the Controller

To upload the configuration in the controller:

1. On the Upload menu, click Configuration in Controller. The Upload Controller dialog box appears (Figure 17-4).

![Upload Controller Dialog Box](image]

**Figure 17-4: Upload Controller Dialog Box**

2. Click on the arrow next to the Supervisory Controller list box and click on the desired Supervisory Controller. A list of supported devices appears in the Device list box.

3. Click on a device to upload or highlight it using the arrow keys and select OK. The upload proceeds as if you were locally connected to the controller.

**Note:** There is no multiple controller upload option. You must upload controllers one at a time.
Upgrading a Single Controller

To upgrade a single controller:

1. On the Upload menu, click Upgrade Controllers.
2. Choose Single Controller in the Upgrade Controllers dialog box (Figure 17-5).

![Figure 17-5: Upgrade Controllers Dialog Box](image)

3. Select or deselect the Single Controller Options.
4. Click OK or press Enter. The Upgrade Controller dialog box appears (Figure 17-6).
5. Choose a Supervisory Controller from the drop-down list box, select the device to upgrade, then click OK. The Upgrade process proceeds as if you were locally connected to the controller.
Upgrading Multiple Controllers

To upgrade multiple controllers:

1. On the Upload menu, click Upgrade Controllers. The Upgrade Controllers dialog box appears (Figure 17-7).

2. Select Multiple Controllers.

3. Select or deselect the Multiple Controller Options.

4. Click OK or press Enter. The Upgrade Controllers dialog box appears (Figure 17-8).
5. Select the Supervisory Controller.

6. Choose to upgrade all device types or selected device types. If you choose Process Selected Device Types, then select the device types. Only one NCU can be upgraded at a time.

7. Click OK. The Upgrade Controllers - N2 Device List dialog box appears (Figure 17-9).
Figure 17-9: N2 Device List Dialog Box

From this point, this feature functions identically to the standard upgrade feature.
Commissioning the Current Configuration

To commission the current configuration:

1. On the Commission menu, click Current Configuration. HVAC PRO software builds a list of all Supervisory Controllers on the active network. The Commission Controller dialog box appears (Figure 17-10).

![Commission Controller dialog box with Supervisory Controllers list]

2. Click on the arrow next to the Supervisory Controller list box and click on the desired Supervisory Controller. The device list box displays all hardware objects that match the current configuration.

3. Click on an object to commission using the current configuration.

4. Click OK or press Enter when you are ready to continue. The commissioning process proceeds as if you were locally connected to the controller.

Figure 17-10: Commission Current Controller Dialog Box

Select a Supervisory Controller and object name...
Commissioning the Configuration in the Controller

To commission the configuration in the controller:

1. On the Commission menu, click Configuration in Controller. The Upload/Commission Controller dialog box appears (Figure 17-11).

![Figure 17-11: Commission Configuration in Controller Dialog Box]

2. Select a Supervisory Controller from the drop-down list box. A list of supported devices displays in the Device list box. Select one device to upload and commission.

3. Click on the device to upload and commission or highlight it using the arrow keys and select OK. Then proceed with commissioning as if you were locally connected to the controller.
Viewing Controller Information for a Single Device

To view information on a single device:

1. On the Action menu, click Controller Information. The Controller Information dialog box appears (Figure 17-12).

   Figure 17-12: Action - Controller Information Dialog Box

2. Select Single Device. HVAC PRO software builds a list of all Supervisory Controllers on the active network. The Controller Information dialog box appears (Figure 17-13).

   Figure 17-13: Controller Information Dialog Box
3. Click on the arrow next to the Supervisory Controller list box and click on the desired Supervisory Controller. The Device list box displays a list of hardware objects.

4. Click on an object from which to read controller information.

5. Click OK or press Enter. The controller information process proceeds as if you were locally connected to the controller.

**Viewing Controller Information for All Devices on the Selected Supervisory Controller**

To view information on all devices on the selected Supervisory Controller:

1. On the Action menu, click Controller Information.

2. Select All Devices on selected Supervisory Controller. The Controller Information dialog box appears (Figure 17-14).

3. Select the Supervisory Controller or select All Supervisory Controllers from the Supervisory Controller Name list.

4. Choose whether you want information on all device types or selected device types. If you choose Process Selected Device Types, select the device types on which you want information.

**Figure 17-14: Controller Information Dialog Box**

3. Select the Supervisory Controller or select All Supervisory Controllers from the Supervisory Controller Name list.

4. Choose whether you want information on all device types or selected device types. If you choose Process Selected Device Types, select the device types on which you want information.
5. Click OK or press Enter. The dialog box in Figure 17-15 appears.

![Controller Information Dialog Box](image)

**Figure 17-15: Controller Information Dialog Box**

Note: When the scan of the Supervisory Controller is complete, the Controller Information – View Information dialog box appears (Figure 17-16). You can view the controller information now or at a later time. The controller information is in a file called devices.log.

![Controller Information - View Information Dialog Box](image)

**Figure 17-16: Controller Information - View Information Dialog Box**

6. Click Yes to view the file now.
Testing a Single VAV Box

Note: This test is for single duct pressure independent non-supply exhaust VAV boxes only. This menu item is not available if you are currently commissioning a different application.

To conduct a VAV Box Flow Test on a single controller:

1. On the Action menu, click VAV Box Flow Test. The VAV Box Flow Test dialog box appears (Figure 17-17).

Figure 17-17: VAV Box Flow Test Window

2. Verify that the Single VAV Box option is selected.

3. Verify the Flow Test Parameter values and click OK. HVAC PRO software displays the dialog box shown in Figure 17-18.
4. Click on the arrow next to the drop-down list box and click on the desired Supervisory Controller. The device list box displays VAV and VMA1400 Series hardware objects.

5. Click on the object on which you want to perform a box flow test.

6. Click OK or press Enter when you are ready to continue. The VAV Box Flow Test proceeds as if you were locally connected to the controller. For more information on testing a single VAV box, see the Testing a Single VAV Box procedure in the Testing and Receiving Data from Controllers (LIT-63750416) chapter of this guide.
Testing Multiple VAV Boxes

Note: This test is for single duct pressure independent non-supply exhaust VAV boxes only. This menu item is not available if you are currently commissioning a different application.

To flow test multiple VAV boxes:

1. On the Action menu, click VAV Box Flow Test. The VAV Box Flow Test dialog box appears (Figure 17-19).

![VAV Box Flow Test Window](image)

**Figure 17-19: VAV Box Flow Test Window**

2. Verify that Multiple VAV Boxes is selected.
3. Select the Flow Test Parameters, and then click OK. The dialog box shown in Figure 17-20 appears.

![VAV Box Flow Test Dialog Box](image)

Figure 17-20: VAV Box Flow Test Dialog Box
4. Select a Supervisory Controller, then click OK or press Enter. HVAC PRO software searches the Supervisory Controller and displays a list of all Single Duct pressure independent VAV boxes found (Figure 17-21).

![Figure 17-21: Multiple VAV Box Flow Test - N2 Device List Window](image)

These Pressure Independent VAVs were found.

<table>
<thead>
<tr>
<th>Addr. Object</th>
<th>Start Cmd D</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 FL01.N2.VHA{11}</td>
<td>0</td>
</tr>
<tr>
<td>12 FL01.N2.VHA{12}</td>
<td>100</td>
</tr>
<tr>
<td>15 FL01.N2.VAU{15}</td>
<td>0</td>
</tr>
<tr>
<td>16 FL01.N2.VAU{16}</td>
<td>100</td>
</tr>
<tr>
<td>17 FL01.N2.VAU{17}</td>
<td>0</td>
</tr>
<tr>
<td>18 FL01.N2.VAU{18}</td>
<td>OFFLINE</td>
</tr>
<tr>
<td>25 FL01.N2.VAU{25}</td>
<td>OFFLINE</td>
</tr>
<tr>
<td>26 FL01.N2.VAU{26}</td>
<td>OFFLINE</td>
</tr>
</tbody>
</table>

5. Click on the controller you want to remove from the list before starting the flow test, and click the Remove Controller from List button.

As the controllers are listed, HVAC PRO software alternates the start commands. The first controller starts at 0%, the second at 100%, the third at 0%, and so on. This prevents overloading the fan system.

6. Click on the controller you want to change and click the Toggle Start Command button to toggle the start command manually.

7. Click OK to start the VAV Box Flow Tests. HVAC PRO software executes the flow tests as described under the *VAV Box Flow Test* topic in the *Testing and Receiving Data from Controllers (LIT-63750416)* chapter of this guide.
Collecting VAV Diagnostics

To collect VAV diagnostics:

1. On the Action menu, click Collect VAV Diagnostics. The Collect VAV Diagnostics dialog box appears (Figure 17-22).

![Collect VAV Diagnostics Dialog Box](image)

2. Select a Supervisory Controller or select All Supervisory Controllers from the Supervisory Controller Name list.

Figure 17-22: Collect VAV Diagnostics Dialog Box

Select a Supervisory Controller or select All Supervisory Controllers from the Supervisory Controller Name list.
3. Click OK. The dialog box shown in Figure 17-23 appears while HVAC PRO software scans the NCU for all VMA1400 Series devices and all VAV controllers with diagnostics.

![Collect VAV Diagnostics](image)

The devices shown below were found on selected Supervisory Controller. Select Cancel or Press Spacebar to Stop the Scan.

<table>
<thead>
<tr>
<th>N2 Addr.</th>
<th>Object</th>
<th>Cnt</th>
</tr>
</thead>
<tbody>
<tr>
<td>11-USD</td>
<td>FL01.N2.VHA{11}</td>
<td>69%</td>
</tr>
<tr>
<td>12-USD</td>
<td>FL01.N2.VHA{12}</td>
<td>18%</td>
</tr>
<tr>
<td>15-SD</td>
<td>FL01.N2.VAV{15}</td>
<td>16%</td>
</tr>
<tr>
<td>16-SD</td>
<td>FL01.N2.VAV{16}</td>
<td>16%</td>
</tr>
<tr>
<td>17-SD</td>
<td>FL01.N2.VAV{17}</td>
<td>24%</td>
</tr>
<tr>
<td>18-SD</td>
<td>FL01.N2.VAV{18}</td>
<td>23%</td>
</tr>
</tbody>
</table>

![Scanning FL01 for Controllers......](image)

Figure 17-23: Collect VAV Diagnostics Scan Dialog Box

Note: The N2 address is logged in the form n-XX, where n is the N2 address and XX is either Single Duct or Dual Duct. Headings with CD and HD in them refer to cold deck and hot deck (for Dual Duct VAVs only). Single duct values appear under the CD heading. Use the scroll bar to view items that do not appear on the screen.

HVAC PRO software logs the diagnostic values in a file named vavdiag.log in the current directory. It appends this file each time you run a test. This is a tab-delimited file, suitable for importing into spreadsheets.
Chapter 18

Networking Controllers

Introduction

This chapter provides information on networking controllers.
Key Concepts

Monitor and control points created by HVAC PRO software on a controller using the Companion/Facilitator system or the Metasys Network. The first step for networking to a Metasys or Companion/Facilitator system is to identify the points you need from an assembled configuration file. Use the Print command in the File menu to get a hard copy of the configuration file.

For the Companion/Facilitator system, any point from the printout may be mapped to a unique location within a Companion/Facilitator database. For the Companion system, refer to the Database Generation Guide Technical Bulletin (LIT-6281270) for the steps required to integrate controller points into a Companion database. For the Facilitator system, refer to the Database Generation Guide Technical Bulletin (LIT-1628270) for the steps required to integrate controller points into a Facilitator database.

For the Metasys Network, there are three alternatives available for mapping points from the controller printout into a Network Controller database. These alternatives are:

- a single CS object for grouping a controller’s points into one group representation
- the definition of individual controller points as AI, BI, AO, BO, and ACM objects
- a combination of CS objects and individual point objects to represent the operation of the controller

⚠️ WARNING: Controller points must not be defined in the Metasys Network such that any controller point may be overridden or adjusted from more than one Metasys object.